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How to Use This Manual Printing This Manual
 MC-2984-V1.00
 Basic GuideDescribes the summary of
 this product.
 Advanced GuideDescribes the detailedfunction of this product.
 Troubleshooting
 Стр. 1 из 396 стр.iP4600 series On-screen Manual
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How to Use This ManualPrinting This ManualPrinting DVD CD Label
 MP-2357-V1.10Advanced Guide
 Contents
 Overview of the Printer
 Main Components
 Printing
 Printing Photos (Easy-PhotoPrint EX)
 Printing Documents (Windows)Printing Documents (Macintosh)
 Other Usages
 Printing Photos from a PictBridge CompliantDeviceSolution Menu and My Printer
 Loading Paper
 Loading Paper
 Routine Maintenance
 Replacing an Ink TankWhen Printing Becomes Faint or Colors AreIncorrect
 Cleaning the Paper Feed RollerCleaning the Pad in the CassetteOpening the Maintenance Screens
 Appendix
 Safety Precautions
 Legal Limitations on Use of Your Product andUse of ImagesTips on How to Use Your Printer
 Стр. 2 из 396 стр.iP4600 series Basic Guide
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Advanced Guide Troubleshooting
 Contents > Overview of the Printer
 Overview of the Printer This section shows the component names of the printer and describes their functions.
 Main ComponentsFront ViewRear ViewInside View
 Page top
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Advanced Guide Troubleshooting
 Contents > Overview of the Printer > Main Components
 Main Components
 Front View
 (1) Top CoverOpen it when replacing the ink tanks or removing jammed paper inside the printer.
 (2) Paper GuidesSlide to align with both sides of the paper stack.
 (3) Rear TrayLoad various sizes or types of paper which you can use on the printer. Two or more sheets of the samesize and type of paper can be loaded at the same time, and fed automatically one sheet at a time.
 See Loading Paper.
 (4) Paper SupportOpen to pull out fully to support paper loaded in the Rear Tray.
 (5) CassetteLoad A4, B5, A5, or Letter-sized plain paper and insert it into the printer. Two or more sheets of the samesize of paper can be loaded at the same time, and fed automatically one sheet at a time.
 See Loading Paper.
 (6) Direct Print PortConnect a PictBridge compliant device such as a digital camera when printing directly.
 See Printing Photos from a PictBridge Compliant Device.
 Warning Do not connect any equipment other than PictBridge compliant devices to the Direct PrintPort of the printer. This may cause fire, electric shock, or damage to the printer.
 Caution Do not touch the metal casing.
 (7) Paper Output TrayPrinted papers are ejected. Open it fully before printing.
 (8) Output Tray Extension
 Стр. 4 из 396 стр.Main Components
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Extend to open support the printouts.
 (9) Inner CoverClose it when printing on paper.
 (10) Power buttonTurns the power on or off.
 NoteAuto power on/off feature
 You can set the printer to turn on or off automatically.- Auto Power On: Automatically turns on the printer when print data is sent from the
 computer.- Auto Power Off: Automatically turns off the printer when no print data is sent for a
 certain interval.Specify this setting in the Maintenance sheet of the printer driver in Windows, or of the CanonIJ Printer Utility in Macintosh. For details on the settings, refer to the on-screen manual: Advanced Guide.
 ImportantDisconnecting the power plug
 When disconnecting the power plug after turning off the power, be sure to confirm thatthe Power lamp is not lit. If the power plug is disconnected from the wall outlet while the Power lamp is lit or flashing, the printer may become unable to print properly since thePrint Head is not protected.
 (11) Power lampLights green after flashing when the power is turned on.
 (12) RESUME/CANCEL buttonPress to cancel a print job in progress. You can press this button after resolving a printer error to dismissan error message and resume printing.
 (13) Alarm lampLights or flashes orange when an error, such as paper-out or ink-out, occurs.
 NotePower and Alarm lamps
 You can check the status of the printer by the Power and Alarm lamps.- Power lamp Off: The power is off.- Power lamp lit green: The printer is ready to print.- Power lamp flashing green: The printer is getting ready to print, or printing is in
 progress.- Alarm lamp flashing orange: An error has occurred and the printer is not ready to print.- For details, refer to the "Troubleshooting" in the on-screen manual: Advanced Guide.- Power lamp flashes green once and Alarm lamp flashes orange once alternately: An
 error that requires contacting your Canon service representative may have occurred.For details, refer to the "Troubleshooting" in the on-screen manual: Advanced Guide.
 Стр. 5 из 396 стр.Main Components

Page 6
                        

Rear View
 (14) USB PortPlug in the USB cable to connect the printer with a computer.
 Caution Do not touch the metal casing.
 Important Do not plug in or unplug the USB cable while the printer is printing from the computer.
 (15) Rear CoverDetach to remove jammed papers.
 (16) Power Cord ConnectorPlug in the supplied power cord.
 Inside View
 (17) Ink lampLights or flashes red to indicate the ink tank status.
 See Checking the Ink Status.
 (18) Print Head Lock LeverLocks the Print Head into place.
 Important Do not raise this lever after installing the Print Head.
 (19) Print Head HolderInstall the Print Head.
 Note For details on installing the Print Head and ink tanks, refer to the printed manual: GettingStarted .
 Стр. 6 из 396 стр.Main Components
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Advanced Guide Troubleshooting
 Contents > Printing
 Printing This section describes how to print documents or photos.You can easily print photos taken with your digital camera by using Easy-PhotoPrint EX supplied withyour printer.
 Printing Photos (Easy-PhotoPrint EX)Using Various Functions of Easy-PhotoPrint EX
 Printing Documents (Windows)
 Printing Documents (Macintosh)For Mac OS X v.10.5.xFor Mac OS X v.10.4.x or Mac OS X v.10.3.9
 Page top
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Advanced Guide Troubleshooting
 Contents > Printing > Printing Photos (Easy-PhotoPrint EX)
 Printing Photos (Easy-PhotoPrint EX) Print image data saved on your computer by using Easy-PhotoPrint EX supplied with your printer.This section describes the procedure, using print setting for borderless photo print on 4" x 6" / 10 x 15 cmphoto paper as a sample.For details on Easy-PhotoPrint EX, refer to the on-screen manual: Advanced Guide.
 Note The screens used in this section are for printing with Windows. The operations are also the samefor printing with Macintosh.
 Install Easy-PhotoPrint EX from the Setup CD-ROM when it has not been installed or has beenuninstalled. To install Easy-PhotoPrint EX, select Easy-PhotoPrint EX in Custom Install.
 1. Prepare for printing.
 (1) Make sure that the printer is turned on.See Front View.
 (2) Load paper.See Loading Paper.
 Here we load 4" x 6" / 10 x 15 cm photo paper in the Rear Tray.
 Note Load A4 or Letter-sized plain paper in the Cassette and other sizes or types of papersuch as photo paper in the Rear Tray.
 (3) Open the Paper Output Tray gently, and extend to open the Output TrayExtension.
 2. Start Easy-PhotoPrint EX, and select Photo Print.
 Стр. 9 из 396 стр.Printing Photos (Easy-PhotoPrint EX)
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(1) Start Easy-PhotoPrint EX.
 Double-click (Easy-PhotoPrint EX) on the desktop.
 Click Here: Easy-PhotoPrint EX
 Select the Go menu, Applications, Canon Utilities, Easy-PhotoPrint EX, then double-click Easy-PhotoPrint EX.
 Note
 To start Easy-PhotoPrint EX from Solution Menu, double-click (Solution Menu) on the
 desktop and click (Print photos or albums, etc.).See To Start Solution Menu.
 To start Easy-PhotoPrint EX from the Start menu, select All Programs (Programs inWindows 2000), Canon Utilities, Easy-PhotoPrint EX, then Easy-PhotoPrint EX.
 To start Easy-PhotoPrint EX from Solution Menu, click (Solution Menu) in the Dock and
 click (Print photos or albums, etc.).See To Start Solution Menu.
 (2) Click Photo Print.
 Note You can select Album, Calendar, Stickers, etc., besides Photo Print.See Using Various Functions of Easy-PhotoPrint EX .
 3. Select a photo to print.
 (1) Select the folder in which images are saved.
 (2) Click the image to print.The number of copies appears as "1", and the image you selected appears in the selected image area (A).You can select two or more images at the same time.
 Note
 Стр. 10 из 396 стр.Printing Photos (Easy-PhotoPrint EX)
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To print two or more copies, click (Up arrow) to change the number of copies. To cancel the selection, click the image to cancel in the selected image area and click (Delete Imported Image). You can also use (Down arrow) to change the number ofcopies to zero.
 You can also correct or enhance the selected image.See Using Various Functions of Easy-PhotoPrint EX .
 (3) Click Select Paper.
 4. Select the loaded paper.
 (1) Make sure that your printer's name is selected in Printer.
 (2) Make sure that Automatically Select is selected in Paper Source.
 Note For details on other paper feeding, refer to the on-screen manual: Advanced Guide.
 (3) Select the size and type of the paper to print in Paper Size and Media Type.Here we select 4"x6"/10x15cm in Paper Size and the type of the loaded photo paper in Media Type.
 Note If you select A4 or Letter-sized plain paper when Automatically Select is selected in PaperSource, the printer feeds the paper from the Cassette. If you select other sizes or typesof paper such as photo paper, the printer feeds the paper from the Rear Tray. If you select the wrong page size or media type, the printer may feed the paper from thewrong paper source or may not print with the proper print quality.
 (4) Click Layout/Print.
 5. Select a layout and start printing.
 (1) Select the layout of the photo.Here we select Borderless [full].
 The preview appears in the selected layout for confirmation of the required print result.
 Стр. 11 из 396 стр.Printing Photos (Easy-PhotoPrint EX)

Page 12
                        

Note You can change the direction of photo or crop a part of photo (trimming) to print.For details on the operation, refer to the on-screen manual: Advanced Guide.
 (2) Click Print.
 Note
 To cancel a print job in progress, press the RESUME/CANCEL button on the printer or clickCancel Printing on the printer status monitor. After canceling the print job, blank sheets ofpaper may be ejected.To display the printer status monitor, click Canon XXX (where "XXX" is your printer'sname) on the taskbar.
 Click the printer icon in the Dock to display the list of print jobs in progress. To cancel a print job in progress, select the desired job in the Name list and click Delete.After canceling the print job, blank sheets of paper may be ejected.
 Page top
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Advanced Guide Troubleshooting
 Contents > Printing > Printing Photos (Easy-PhotoPrint EX) > Using Various Functions of Easy-PhotoPrint EX
 Using Various Functions of Easy-PhotoPrint EX This section describes a few of the useful functions of Easy-PhotoPrint EX.For details on the operation, refer to the on-screen manual: Advanced Guide.
 Creating Your Own Prints You can create an album or calendar using your photos.
 Album Calendar
 Stickers Layout Print
 Correcting Images You can use Red-Eye Correction, Face Sharpener, Digital Face Smoothing, Brightness, Contrast, etc. toadjust, correct, or enhance images automatically or manually.
 Sample of the correction
 Brightness
 Page top
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Advanced Guide Troubleshooting
 Contents > Printing > Printing Documents (Windows)
 Printing Documents (Windows)
 Note Operations may vary depending on your software application. For details on the operation, refer tothe instruction manual of your application.
 The screens used in this section are for printing with Windows Vista operating system UltimateEdition (hereafter referred to as "Windows Vista").
 1. Make sure that the printer is turned on.See Front View.
 2. Load paper.See Loading Paper.
 Note Load A4, B5, A5, or Letter-sized plain paper in the Cassette and other sizes or types of papersuch as photo paper in the Rear Tray.
 3. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 4. Create (or open) a document to print using an appropriate software application.
 5. Open the printer properties dialog box.
 (1) Select Print on the File menu or the command bar in your software application.The Print dialog box appears.
 (2) Make sure that your printer's name is selected.
 Note If another printer's name is selected, click and select your printer's name.
 (3) Click Preferences (or Properties).
 6. Specify the required print settings.
 Стр. 14 из 396 стр.Printing Documents (Windows)
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(1) Select the media type of the paper to print in Media Type.
 Note If you select A4, B5, A5, or Letter-sized plain paper when Automatically Select is selectedin Paper Source, the printer feeds the paper from the Cassette. If you select other sizes ortypes of paper such as photo paper, the printer feeds the paper from the Rear Tray.If you select the wrong page size or media type, the printer may feed the paper from thewrong paper source or may not print with the proper print quality.
 (2) Make sure that Automatically Select is selected in Paper Source.
 Note For details on other paper feeding, refer to the on-screen manual: Advanced Guide.
 (3) Specify the print quality, etc. in Print Quality and Color/Intensity as required.
 Note For details on the print settings, refer to the on-screen manual: Advanced Guide.
 (4) Click OK.
 Note To confirm the page size, click the Page Setup tab. If the setting does not match thedocument's page size already set in the software application, you need to reset the page size,or otherwise use Scaled Printing or Fit-to-Page Printing.For details, refer to the on-screen manual: Advanced Guide.
 For details on the printer driver functions, click Help or Instructions to view the online help orthe on-screen manual: Advanced Guide. The Instructions button appears on the Main andMaintenance sheets if the on-screen manual is installed on your computer.
 To display the preview to confirm the print result, select the Preview before printing check boxon the Main sheet. Some software applications may not have a preview function.
 7. Start printing.Click Print (or OK) to start printing.
 Стр. 15 из 396 стр.Printing Documents (Windows)
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Note To cancel a print job in progress, press the RESUME/CANCEL button on the printer or clickCancel Printing on the printer status monitor. After canceling the print job, blank sheets ofpaper may be ejected.To display the printer status monitor, click Canon XXX (where "XXX" is your printer's name) onthe taskbar.
 If printed ruled lines are misaligned or print results are unsatisfactory, adjust the print headposition. See Aligning the Print Head.
 Page top
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Advanced Guide Troubleshooting
 Contents > Printing > Printing Documents (Macintosh)
 Printing Documents (Macintosh)
 Note Operations may vary depending on your software application. For details on the operation, refer tothe instruction manual of your application.
 For Mac OS X v.10.5.x
 1. Make sure that the printer is turned on.See Front View.
 2. Load paper.See Loading Paper.
 Note Load A4, B5, A5, or Letter-sized plain paper in the Cassette and other sizes or types of papersuch as photo paper in the Rear Tray.
 3. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 4. Create (or open) a document to print using an appropriate software application.
 5. Open the Print dialog box.Select Print on the File menu in your software application.The Print dialog box appears.
 Note
 If the dialog box below appears, click (Down arrow).
 6. Specify the required print settings.
 Стр. 17 из 396 стр.Printing Documents (Macintosh)
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(1) Make sure that your printer's name is selected in Printer.
 (2) Select the page size of the paper to print in Paper Size.
 (3) Select Quality & Media in the pop-up menu.
 (4) Select the media type of the paper to print in Media Type.
 Note If you select A4, B5, A5, or Letter-sized plain paper when Automatically Select is selectedin Paper Source, the printer feeds the paper from the Cassette. If you select other sizes ortypes of paper such as photo paper, the printer feeds the paper from the Rear Tray.If you select the wrong page size or media type, the printer may feed the paper from thewrong paper source or may not print with the proper print quality.
 (5) Make sure that Automatically Select is selected in Paper Source.
 Note For details on other paper feeding, refer to the on-screen manual: Advanced Guide.
 (6) Select the print quality in Print Quality.
 Note For details on the print quality, refer to the on-screen manual: Advanced Guide.
 Note
 For details on the printer driver functions, click (Question) on the Quality & Media, ColorOptions, Borderless Printing, or Duplex Printing & Margin screen to view the on-screen manual:Advanced Guide. If the on-screen manual is not installed, it does not appear even if (Question) is clicked.
 The preview appears on the left of the dialog box to confirm the print result. Some softwareapplications may not have a preview function.
 Стр. 18 из 396 стр.Printing Documents (Macintosh)
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7. Start printing.Click Print to start printing.
 Note Click the printer icon in the Dock to display the list of print jobs in progress. To cancel a print job in progress, select the desired job in the Name list and click Delete. Aftercanceling the print job, blank sheets of paper may be ejected.To temporarily stop a job in progress, click Hold. To temporarily stop all the jobs in the list, clickPause Printer.
 If printed ruled lines are misaligned or print results are unsatisfactory, adjust the print headposition. See Aligning the Print Head.
 For Mac OS X v.10.4.x or Mac OS X v.10.3.9
 Note The screens used in this section are for printing in Mac OS X v.10.4.x.
 1. Make sure that the printer is turned on.See Front View.
 2. Load paper.See Loading Paper.
 Note Load A4, B5, A5, or Letter-sized plain paper in the Cassette and other paper such as photopaper in the Rear Tray.
 3. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 4. Create (or open) a document to print using an appropriate software application.
 5. Specify the page size.
 (1) Select Page Setup on the File menu in your software application.The Page Setup dialog box appears.
 (2) Make sure that your printer's name is selected in Format for.
 (3) Select the page size of the paper to print in Paper Size.
 (4) Click OK.
 Стр. 19 из 396 стр.Printing Documents (Macintosh)

Page 20
                        

6. Specify the required print settings.
 (1) Select Print on the File menu in your software application.The Print dialog box appears.
 (2) Make sure that your printer's name is selected in Printer.
 (3) Select Quality & Media in the pop-up menu.
 (4) Select the media type of the paper to print in Media Type.
 Note If you select A4, B5, A5, or Letter-sized plain paper when Automatically Select is selectedin Paper Source, the printer feeds the paper from the Cassette. If you select other sizes ortypes of paper such as photo paper, the printer feeds the paper from the Rear Tray.If you select the wrong page size or media type, the printer may feed the paper from thewrong paper source or may not print with the proper print quality.
 (5) Make sure that Automatically Select is selected in Paper Source.
 Note For details on other paper feeding, refer to the on-screen manual: Advanced Guide.
 (6) Select the print quality in Print Quality.
 Note For details on the print quality, refer to the on-screen manual: Advanced Guide.
 Note
 For details on the printer driver functions, click (Question) on the Quality & Media, ColorOptions, Special Effects, Borderless Printing, or Duplex Printing & Margin screen to view theon-screen manual: Advanced Guide. If the on-screen manual is not installed, it does notappear even if (Question) is clicked.
 To display the preview to confirm the print result, click Preview. Some software applicationsmay not have a preview function.
 7. Start printing.Click Print to start printing.
 Note Click the printer icon in the Dock to display the list of print jobs in progress. To cancel a print job in progress, select the desired job in the Name list and click Delete. Aftercanceling the print job, blank sheets of paper may be ejected.To temporarily stop a job in progress, click Hold. To temporarily stop all the jobs in the list, clickStop Jobs.
 If printed ruled lines are misaligned or print results are unsatisfactory, adjust the print headposition. See Aligning the Print Head.
 Стр. 20 из 396 стр.Printing Documents (Macintosh)
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Advanced Guide Troubleshooting
 Contents > Other Usages
 Other Usages This section describes the function to print photos from your PictBridge compliant device such as adigital camera connecting with a USB cable and the useful functions to start suppiled softwareapplications from the desktop.
 Printing Photos from a PictBridge Compliant Device
 Solution Menu and My Printer
 Page top
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Advanced Guide Troubleshooting
 Contents > Other Usages > Printing Photos from a PictBridge Compliant Device
 Printing Photos from a PictBridge Compliant Device Connecting the PictBridge compliant device to the printer with a USB cable that is recommended by thedevice's manufacturer, you can print saved images directly.For details on how to print saved images connecting with the PictBridge compliant device, refer to the on-screen manual: Advanced Guide.For details on the print settings on the PictBridge compliant device, refer to the instruction manualsupplied with the device.
 Connectable devices:Any PictBridge compliant device can be connected to the printer regardless of the manufacturer or modelas long as it is compliant with the PictBridge standard.
 Note PictBridge is the standard to print your photos directly without using a computer, connecting adevice such as a digital still camera, digital camcorder, or camera-equipped mobile phone.
 (PictBridge) A device with this mark is PictBridge compliant.
 Printable image data format:The printer prints images taken with a DCF (Design rule for Camera File system) ver. 1.0/2.0- compatibledigital camera (Exif ver. 2.2/2.21 compliant), as well as PNG files.
 Page top
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Advanced Guide Troubleshooting
 Contents > Other Usages > Solution Menu and My Printer
 Solution Menu and My Printer Using Solution Menu or My Printer (Windows only), you can easily get the information on the printer orchange the print settings by only clicking buttons on a screen.With Solution Menu, you can start the software applications supplied with the printer or display theoperating instructions. It also provides you with the information on troubleshooting.With My Printer, you can display the printer properties dialog box of the printer driver. It also provides youwith the information on how to take an action when you have trouble with the operation. My Printer is notavailable in Macintosh.
 To Start Solution Menu
 Double-click (Solution Menu) on the desktop.
 Click Here: Solution Menu
 Click (Solution Menu) in the Dock.* The screens below are for Windows Vista.
 Click the button of a function to use.
 After starting Solution Menu, click (Window size: small) on the title bar to reduce the window size.
 Note Install Solution Menu from the Setup CD-ROM when it has not been installed or has beenuninstalled. To install Solution Menu, select Solution Menu in Custom Install.
 The buttons displayed on the screen may vary depending on the country or region of purchase.
 To start Solution Menu from the Start menu, select All Programs (Programs in Windows 2000),Canon Utilities, Solution Menu, then Solution Menu.
 To start Solution Menu from the menu bar, select the Go menu, Applications, Canon Utilities, SolutionMenu, then double-click Solution Menu.
 To Start My Printer
 Double-click (My Printer) on the desktop.
 Стр. 24 из 396 стр.Solution Menu and My Printer
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Note You can also start My Printer from Solution Menu. Install My Printer from the Setup CD-ROM when it has not been installed or has been uninstalled. Toinstall My Printer, select My Printer in Custom Install.
 To start My Printer from the Start menu, select All Programs (Programs in Windows 2000), CanonUtilities, My Printer, then My Printer.
 Page top
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Advanced Guide Troubleshooting
 Contents > Loading Paper
 Loading Paper This section describes types of paper you can load and how to load printing paper in the Rear Tray orCassette.
 Loading PaperPaper Source to Load PaperLoading PaperLoading EnvelopesMedia Types You Can UseMedia Types You Cannot Use
 Page top
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Advanced Guide Troubleshooting
 Contents > Loading Paper > Loading Paper
 Loading Paper
 Paper Source to Load Paper You can select to load paper from two paper source, Cassette or Rear Tray.You can load paper in either one of the paper sources, depending on the page size and media type ofpaper. If you select Automatically Select in Paper Source, paper is fed from the Cassette or Rear Traydepending on the selection of the page size or media type.See Media Types You Can Use .
 Note For details on Automatically Select, see Printing Documents (Windows) or Printing Documents(Macintosh).For details on other paper feeding, refer to the on-screen manual: Advanced Guide.
 If you select A4, B5, A5, or Letter-sized plain paper when Automatically Select is selected in PaperSource, the printer feeds the paper from the Cassette. If you select other sizes or types of papersuch as photo paper, the printer feeds the paper from the Rear Tray.When printing, select the correct page size and media type. If you select wrong page size or mediatype, the printer may feed the paper from the wrong paper source or may not print with the properprint quality.For details on loading paper in each paper source, see Loading Paper or Loading Envelopes.
 Loading plain paper in the Cassette When you use A4, B5, A5, or Letter-sized plain paper, load it in the Cassette.The Cassette is inserted at the bottom of the printer.The printer feeds the paper from the Cassette automatically by selecting plain paper (A4, B5, A5, or Lettersize) in the print settings with the printer driver when printing.For details on how to change the paper source, refer to the on-screen manual: Advanced Guide.
 Loading Photo Paper in the Rear Tray When you use photo paper, load it in the Rear Tray.The printer feeds the paper from the Rear Tray automatically by selecting the media types other thanplain paper, such as photo paper, in the print settings with the printer driver when printing.When you use plain paper other than A4, B5, A5, or Letter size, also load it in the Rear Tray.
 Стр. 27 из 396 стр.Loading Paper
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Advanced Guide Troubleshooting
 Contents > Loading Paper > Loading Paper > Loading Paper
 Loading Paper Important If you cut plain paper into small size such as 4" x 6" / 10 x 15 cm, 4" x 8" / 101.6 x 203.2 mm, 5" x 7"/ 13 x 18 cm, or 2.16" x 3.58" / 55.0 x 91.0 mm (Card size) to perform trial print, it can cause paperjams.
 Note You can load only A4, B5, A5, or Letter-sized plain paper in the Cassette. Load other sizes or typesof paper in the Rear Tray.
 We recommend Canon genuine photo paper for printing photos.For details on the Canon genuine paper, see Media Types You Can Use .
 You can use general copy paper. When printing on both sides, we recommend Canon's SuperWhite Paper.For the page size and paper weight you can use for the printer, see Media Types You Can Use .
 Loading Paper in the Rear Tray
 1. Flatten the four corners of paper before loading it.
 Note Align the edges of paper neatly before loading. Loading paper without aligning the edges maycause paper jams.
 If paper is curled, hold the curled corners and gently bend them in the opposite direction untilthe paper becomes completely flat.For details on how to flatten curled paper, refer to the " Troubleshooting" in the on-screenmanual: Advanced Guide.
 2. Prepare for loading paper.
 (1) Open the Paper Support, and pull it out.
 Стр. 29 из 396 стр.Loading Paper
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(2) Put your finger on the center of the top of the Paper Output Tray and open itgently.
 (3) Extend to open the Output Tray Extension.
 3. Load paper.
 (1) Slide the Paper Guides (A) to open them, and load the paper in the center of theRear Tray WITH THE PRINT SIDE FACING YOU.
 Important Always load paper in the portrait orientation (B). Loading paper in the landscapeorientation (C) can cause paper jams.
 (2) Slide the Paper Guides to align with the both sides of the paper stack.Do not slide the Paper Guides too hard. The paper may not be fed properly.
 Note Do not load higher than the Load Limit Mark (D).
 NoteAfter Loading Paper
 Select the size and type of the loaded paper in Page Size (or Paper Size) and Media Type in theprinter driver. See Printing Documents (Windows) or Printing Documents (Macintosh) .
 Стр. 30 из 396 стр.Loading Paper

Page 31
                        

Loading Paper in the Cassette You can load only A4, B5, A5, or Letter-sized plain paper in the Cassette.See Media Types You Can Use .
 1. Flatten the four corners of paper before loading it.See Loading Paper in the Rear Tray .
 2. Pull out the Cassette from the printer.
 3. Remove the Cover on the Cassette.
 4. Prepare for loading the paper in the Cassette.Pull the tab (A) towards you to unlock and extend the Cassette.
 5. Load paper.
 Стр. 31 из 396 стр.Loading Paper
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(1) Load the paper stack WITH THE PRINT SIDE FACING DOWN and THELEADING EDGE TO THE FAR SIDE, and align it against the right side of theCassette.
 (2) Slide the Paper Guide (B) to align with the mark of paper size.The Paper Guide (B) will stop when it aligns with the corresponding mark of paper size.
 Note There may be a little space between the Paper Guide (B) and the paper stack.
 (3) Slide the Paper Guide (C) on the left to align completely with the side of thepaper stack.
 Note Do not load higher than the Load Limit Mark (D).
 6. Set the Cover on the Cassette.
 7. Insert the Cassette into the printer.Push the Cassette all the way into the printer.
 Note The Cassette will stick out of the printer, but do not force it into the printer any further.This can damage the printer or Cassette.
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8. Open the Paper Output Tray.
 (1) Put your finger in the center of the top of the Paper Output Tray and open itgently.
 (2) Extend to open the Output Tray Extension.
 Note
 After Loading Paper Select the size and type of the loaded paper in Page Size (or Paper Size) and Media Type in theprinter driver. See Printing Documents (Windows) or Printing Documents (Macintosh) .
 Page top
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Advanced Guide Troubleshooting
 Contents > Loading Paper > Loading Paper > Loading Envelopes
 Loading Envelopes You can print on European DL and US Comm. Env. #10-sized envelopes.The address is automatically rotated and printed according to the envelope's direction by specifying withthe printer driver properly.
 Important You cannot use the following envelopes.- Envelopes with an embossed or treated surface- Envelopes with a double flap (or sticker flaps)- Envelopes with pressure seals- Envelopes whose gummed flaps are already moistened and adhesive
 Note You cannot load envelopes in the Cassette. Load them in the Rear Tray.
 1. Prepare envelopes. Press down on all four corners and edges of the envelopes to flatten them.
 If the envelopes are curled, hold the opposite corners and gently twist them in theopposite direction.
 If the corner of the envelope flap is folded, flatten it. Use a pen to press the leading edge in the inserting direction flat and sharpen thecrease.
 The figures above show a side view of the leading edge of the envelope.
 Important The envelopes may jam in the printer if they are not flat or the edges are not aligned. Makesure that no curl or puff exceeds 0.1 inches / 3 mm.
 2. Load envelopes.
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(B) Rear side(C) Address side
 (1) Slide the Paper Guides (A) to open them, and load the envelopes in the center ofthe Rear Tray WITH THE ADDRESS SIDE FACING YOU.The folded flap of the envelope will be faced down on the left side.
 Up to 10 envelopes can be loaded at once.
 (2) Slide the Paper Guides to align them with both sides of the envelopes.Do not slide the Paper Guides too hard. The envelopes may not be fed properly.
 3. Specify the settings in the printer driver.
 (1) Select Envelope in Media Type.
 (2) Select the size for envelopes.
 Select DL Env. or Comm. Env. #10 in Page Size.
 Select DL Envelope or #10 Envelope in Paper Size.
 (3) Select Landscape in Orientation.
 Important If you do not specify Page Size(or Paper Size) or Orientation properly, the address will beprinted upside down or will be turned to 90 degrees.
 Note In Windows, if the print result is upside down, select Rotate 180 degrees on the Page Setupsheet in the printer properties dialog box of the printer driver.
 Page top
 Стр. 35 из 396 стр.Loading Envelopes

Page 36
                        

Advanced Guide Troubleshooting
 Contents > Loading Paper > Loading Paper > Media Types You Can Use
 Media Types You Can Use Choose paper suitable for printing, for the best print results. Canon provides you various types of paperto enhance the fun of printing, such as stickers as well as papers for photo or document. Werecommend the use of Canon genuine paper for printing your important photos.
 Media Types
 Commercially available papers
 Name of Paper<Model No.>
 *1
 Paper Load Limit Paper OutputTray Load
 Limit
 Settings in PrinterDriver: Media TypeRear Tray Cassette
 Plain Paper(Recycled
 paper)*2
 Approx. 150sheets
 A4, B5, A5, Letter / 8.5"x 11": Approx. 150sheets
 Approx. 50sheets
 Plain Paper
 Envelopes 10 envelopes Not loadable*3 *4 Envelope
 Canon genuine papers
 Name of Paper <Model No.>
 *1
 Paper Load Limit Paper OutputTray Load
 Limit
 Settings inPrinter Driver:
 Media TypeRear Tray Cassette
 For printing documents:
 Super White Paper <SW-201>
 Approx. 100 sheets A4: Approx.100 sheets
 Approx. 50sheets
 Plain Paper
 For printing photos:
 Photo Paper ProPlatinum <PT-101>*5
 A4, Letter / 8.5" x 11", 5" x7" / 13 x 18 cm and 8" x 10"/ 20 x 25 cm: 10 sheets4" x 6" / 10 x 15 cm: 20sheets
 Not loadable*3 *4 Photo Paper ProPlatinum
 Photo Paper Pro II <
 PR-201>*5Photo Paper Pro II
 Glossy Photo Paper"Everyday Use" <GP-501>*5
 Glossy PhotoPaper
 Photo Paper Glossy<GP-502>*5
 Glossy PhotoPaper
 Photo Paper PlusGlossy II <PP- 201>*5
 Photo Paper PlusGlossy II
 Photo Paper PlusSemi-gloss <SG-201>*5
 Photo Paper PlusSemi-gloss
 Matte Photo Paper <MP-101>
 Matte Photo Paper
 For printing business documents:
 High ResolutionPaper <HR-101N>
 80 sheets Not loadable*3 50 sheets High ResolutionPaper
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For creating your own prints:
 T-Shirt Transfers <TR-301>
 1 sheet Not loadable*3 *4 T-Shirt Transfers
 Photo Stickers <PS-101>
 1 sheet Glossy PhotoPaper
 *1 Paper with a Model Number is Canon genuine paper. Refer to the instruction manual supplied withthe paper for detailed information on the printable side and notes on handling paper. For information onthe page sizes available for each Canon genuine paper, visit our website. You may not be able topurchase some Canon genuine papers depending on the country or region of purchase. Paper is notsold in the US by Model Number. Purchase paper by name.*2 Proper feeding of paper may not be possible at the maximum capacity depending on the type of paperor environmental conditions (either very high or low temperature or humidity). In such cases, reduce thenumber of paper you load at a time to less than half (100% recycled paper can be used).*3 Feeding this paper from the Cassette can damage the printer. Always load in the Rear Tray.*4 We recommend that you remove the previously printed sheet from the Paper Output Tray beforecontinuously printing to avoid blurs and discoloration.*5 When loading paper in stacks, the print side may become marked as it is fed or paper may not feedproperly. In this case, load one sheet at a time.
 Page Sizes You can load plain paper of the following page sizes in the Cassette.A4, B5, A5, and Letter sizesPlain paper of other page sizes is not loadable in the Cassette. Load them in the Rear Tray. In Macintosh, Choukei 3 and Choukei 4 are not available.
 Standard sizes: Letter (8.50 x 11.00 inches / 215.9 x 279.4
 mm) Legal (8.50 x 14.00 inches / 215.9 x 355.6 mm)
 A5 (5.83 x 8.27 inches / 148.0 x 210.0 mm) A4 (8.27 x 11.69 inches / 210.0 x 297.0 mm)
 B5 (7.17 x 10.12 inches / 182.0 x 257.0 mm) 4" x 6" (4.00 x 6.00 inches / 10 x 15 cm)
 4" x 8" (4.00 x 8.00 inches / 101.6 x 203.2mm)
 5" x 7" (5.00 x 7.00 inches / 13 x 18 cm)
 8" x 10" (8.00 x 10.00 inches / 20 x 25 cm) L (3.50 x 5.00 inches / 89.0 x 127.0 mm)
 2L (5.00 x 7.01 inches / 127.0 x 178.0 mm) Hagaki (3.94 x 5.83 inches / 100.0 x 148.0 mm)
 Hagaki 2 (7.87 x 5.83 inches / 200.0 x 148.0mm)
 Comm. Env. #10 (4.12 x 9.50 inches / 104.6 x 241.3mm)
 DL Env. (4.33 x 8.66 inches / 110.0 x 220.0mm)
 Choukei 3 (4.72 x 9.25 inches / 120.0 x 235.0 mm)
 Choukei 4 (3.54 x 8.07 inches / 90.0 x 205.0mm)
 Youkei 4 (4.13 x 9.25 inches / 105.0 x 235.0 mm)
 Youkei 6 (3.86 x 7.48 inches / 98.0 x 190.0mm)
 Card (2.16 x 3.58 inches / 55.0 x 91.0 mm)
 Wide (4.00 x 7.10 inches / 101.6 x 180.6 mm)
 Non-standard sizes:You can also specify a custom size within the following range.
 Minimum size: 2.17 x 3.58 inches / 55.0 x 91.0 mm (Rear Tray)5.83 x 8.27 inches / 148.0 x 210.0 mm (Cassette)
 Maximum size: 8.50 x 26.61 inches / 215.9 x 676.0 mm (Rear Tray)8.50 x 11.69 inches / 215.9 x 297.0 mm (Cassette)
 Paper Weight 17 to 28 lb / 64 to 105 gsm (plain paper except for Canon genuine paper)
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Do not use heavier or lighter paper (except for Canon genuine paper), as it could jam in the printer.
 Notes on Storing Paper Take out only the necessary number of paper from the package, just before printing. To avoid curling, when you do not print, put unused paper back into the package and keep it on alevel surface. And also, store it avoiding heat, humidity, and direct sunlight.
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Advanced Guide Troubleshooting
 Contents > Loading Paper > Loading Paper > Media Types You Cannot Use
 Media Types You Cannot Use Do not use the following types of paper. Using such paper will not only produce unsatisfactory results,but can also cause the printer to jam or malfunction.
 Folded, curled, or wrinkled paper Damp paper Paper that is too thin (weighing less than 17 lb / 64 gsm) Paper that is too thick (plain paper, except for Canon genuine paper, weighing more than 28 lb / 105gsm)
 Paper thinner than a postcard, including plain paper or notepad paper cut to a small size (whenprinting on A5 or smaller sized paper)
 Picture postcards Postcards affixed with photos or stickers Envelopes with a double flap (or sticker flaps) Envelopes with pressure seals Envelopes with an embossed or treated surface Envelopes whose gummed flaps are already moistened and adhesive Any type of paper with holes Paper that is not rectangular Paper bound with staples or glue Paper with adhesives Paper decorated with glitter, etc.
 Page top
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance
 Routine Maintenance This section describes how to replace ink tanks when they run out of ink, to clean the printer when theprint result is faint, or to take an action when paper does not feed properly.
 Replacing an Ink TankChecking the Ink StatusReplacing Procedure
 When Printing Becomes Faint or Colors Are IncorrectPrinting the Nozzle Check PatternExamining the Nozzle Check PatternCleaning the Print HeadCleaning the Print Head DeeplyAligning the Print Head
 Cleaning the Paper Feed Roller
 Cleaning the Pad in the Cassette
 Opening the Maintenance ScreensOpening the Printer Properties Dialog Box (Windows)Opening the Canon IJ Printer Utility (Macintosh)
 Page top
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > Replacing an Ink Tank
 Replacing an Ink Tank When ink runs out while printing is in progress, the Alarm lamp flashes orange four times and the errormessage will appear on your computer screen. Make sure which ink tank has run out of ink and replaceit with a new ink tank.
 Note If the error message appears, confirm the displayed message and take an appropriate action. For details, refer to the "Four Flashes: Ink has run out." of the "Alarm Lamp Flashes Orange" in the "Troubleshooting" of the on-screen manual: Advanced Guide.
 For information on compatible ink tanks, refer to the printed manual: Getting Started.
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > Replacing an Ink Tank > Checking the Ink Status
 Checking the Ink Status You can check the ink status on the ink lamps or your computer screen.
 With the Ink Lamps
 1. Make sure that the power is turned on, and open the Paper Output Tray gently.
 2. Open the Top Cover.
 Note The printer may make operating noise when the Print Head moves to the replacement position.
 3. Check the ink lamps.
 Ink lamp is onThe ink tank is correctly installed and there is sufficient ink left for printing.
 Ink lamp is flashingFlashing slowly (at around 3-second intervals)
 ..... Repeats
 Ink is low. You can continue printing for a while, but we recommend you to have a new ink tank available.
 Flashing fast (at around 1-second intervals)
 ...... Repeats
 The ink tank is installed in the wrong position or it is empty. Make sure that the ink tank is installed in thecorrect position as indicated by the label on the Print Head Holder. If the position is correct but the lampflashes, the ink tank is empty. Replace it with a new one.
 Ink lamp is offThe ink tank is not installed properly or the function for detecting the remaining ink level is disabled. If the ink
 tank is not installed properly, press the mark (Push) on the ink tank until the ink tank clicks into place. If itdoes not click into place, make sure that the orange protective cap has been removed from the bottom ofthe ink tank. If the function for detecting the remaining ink level is disabled, replace the ink tank with a newone.
 See Prepare the new ink tank. .
 If the ink lamp is still off after reinstalling the ink tank, there has been an error and the printer cannot print.Check the Alarm lamp on the printer.
 Refer to the "Troubleshooting" in the on-screen manual: Advanced Guide.
 With the Computer Screen
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You can confirm the status of each ink tank on the printer status monitor (Windows) and Canon IJ PrinterUtility (Macintosh).
 (A) Check if any symbol appears on the screen. Ink with (Ink low) is running low. You can continue printing for a while, but we recommend you tohave a new ink tank available.
 Note An error message may appear while printing. Confirm the message and take an appropriate action.
 Follow the procedure below to open each of the confirmation screens.
 1. Open the printer properties dialog box.See Opening the Printer Properties Dialog Box (Windows) .
 2. Click View Printer Status on the Maintenance sheet.To confirm the ink tank information, click the Ink Details menu.
 Note You can also display the printer status monitor by clicking Canon XXX (where " XXX" is yourprinter's name) which appears on the taskbar during printing.
 1. Open the Canon IJ Printer Utility.See Opening the Canon IJ Printer Utility (Macintosh).
 2. Select Ink Level Information in the pop-up menu.To confirm the ink tank information, click Ink Details.
 Page top
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > Replacing an Ink Tank > Replacing Procedure
 Replacing Procedure When the ink tanks run out of ink, follow the procedure below to replace them.
 ImportantHandling Ink
 To maintain optimal print quality, we recommend the use of specified Canon brand ink tanks. Refillingink is not recommended.
 If you remove an ink tank, replace it immediately. Do not leave the printer with ink tanks removed. Use new ink tanks for replacement. Installing used ink tanks may cause the nozzles to clog.Furthermore, with such tanks, the printer will not be able to inform you when to replace the inktanks properly.
 To maintain optimal print quality, install ink tanks in the printer within the date indicated on thepackage box. And also use ink tanks within 6 months of first use (We recommend you to put downthe date when installing them).
 Note Color ink may be consumed even when printing a black-and-white document or when black-and-white printing is specified.Every ink is also consumed in the standard cleaning and deep cleaning of the Print Head, whichmay be necessary to maintain the printer's performance. When an ink tank is out of ink, replace itimmediately with a new one.
 1. Make sure that the power is turned on and open the Paper Output Tray gently.
 2. Open the Top Cover.The Print Head moves to the replacement position.
 Caution Do not hold the Print Head Holder to stop or move it forcibly. Do not touch the Print Head Holderuntil it stops completely.
 Do not touch the metallic parts or other parts inside the printer.
 Important If the Top Cover is left open for more than 10 minutes, the Print Head Holder moves to the right.In this case, close and reopen the Top Cover.
 Note The printer may make operating noise when the Print Head moves to the replacement position.
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3. Replace the ink tank with the lamp flashing fast.Push the tab (A) and lift the ink tank to remove.Do no touch the Print Head Lock Lever (B).
 Important Handle the ink tank carefully to avoid staining of clothing or the surrounding area. Discard empty ink tank according to the local laws and regulations regarding disposal ofconsumables.
 Note Do not remove two or more ink tanks at the same time. Be sure to replace ink tanks one by onewhen replacing two or more ink tanks.
 For details on ink lamp flashing speed, see Checking the Ink Status.
 4. Prepare the new ink tank.
 (1) Take the new ink tank out of its package, pull the orange tape ( ) in the
 direction of the arrow to peel off the tape, then remove the film ( ).
 Important Make sure that the film is completely removed from the air hole (C). If the air hole is blockedwith the remaining film, ink may leak out or may not eject properly.
 (2) Hold the orange protective cap (D) as indicated in the figure below, then twistand remove it from the bottom of the ink tank.Remove the protective cap while holding it to prevent the ink from staining your fingers.
 Discard the protective cap once it is removed.
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Important Do not touch the electrical contacts (E) on the ink tank. It can cause the printer tomalfunction or become unable to print.
 Important If you shake an ink tank, the ink may spill out and stain your hands and the surrounding area.Handle an ink tank carefully.
 Do not squeeze the side of ink tanks as this may cause the ink to leak out. Be careful not to stain your hands and the surrounding area with ink on the removedprotective cap.
 Do not reattach the protective cap once you have removed it. Discard it according to the locallaws and regulations regarding disposal of consumables.
 Do not touch the open ink port once the protective cap is removed, as this may prevent the inkfrom being ejected properly.
 5. Install the new ink tank.
 (1) Insert the front end of ink tank into the Print Head at a slant.Make sure the position of the ink tank matches the label.
 (2) Press the mark (Push) on the ink tank until the ink tank snaps firmly intoplace.Make sure that the ink lamp lights up red.
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Important You cannot print if the ink tank is installed in the wrong position. Be sure to install the ink tank inthe correct position according to the label on the Print Head Holder.
 You cannot print unless all the ink tanks are installed. Be sure to install all the ink tanks.
 6. Close the Top Cover.If you replaced the ink tank during printing, the printer resumes printing automatically.
 Note If the Alarm lamp still flashes orange after the Top Cover is closed, refer to the "Alarm LampFlashes Orange" in the " Troubleshooting" of the on-screen manual: Advanced Guide.
 When you start printing after replacing the ink tank, the printer starts cleaning the Print Headautomatically. Do not perform any other operations until the printer completes the cleaning ofthe Print Head. The Power lamp flashes green during cleaning.
 If printed ruled lines are printed or the print head position is misaligned, adjust the print headposition.See Aligning the Print Head.
 The printer may make operating noise when preparing for printing.
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect
 When Printing Becomes Faint or Colors Are Incorrect If print results are blurred or colors are not printed correctly, the pint head nozzles are probably clogged.Follow the procedure below to print nozzle check pattern, check the print head nozzle condition, thenclean the Print Head.If printed ruled lines are misaligned or print results are otherwise unsatisfactory, aligning the Print Headmay improve print quality.
 Caution Do not rinse or wipe the Print Head and ink tanks. This can cause trouble with the Print Head and inktanks.
 NoteBefore performing maintenance
 Open the Top Cover and make sure that all lamps on the ink tanks are lit red.If not, see Checking the Ink Status and take an appropriate action.
 Increasing the print quality in the printer driver settings may improve the print result.For details, refer to the on-screen manual: Advanced Guide.
 When the Print Results Are Blurred or Uneven:
 Step 1See Printing the Nozzle Check Pattern.
 See Examining the Nozzle Check Pattern.After cleaning the Print Head, printand examine the nozzle checkpattern.
 If the pattern is missing:
 Step 2See Cleaning the Print Head.
 If the problem is not resolved after cleaning the Print Headtwice:
 Step 3See Cleaning the Print Head Deeply.
 Note If you have performed the procedure until step 3 and the problem has not been resolved, turn offthe power and clean the Print Head deeply again after 24 hours. If the problem is still not resolved,the Print Head may be damaged. Contact your Canon service representative.
 When the Print Results Are Not Even such as the Ruled LinesAre Misaligned:
 See Aligning the Print Head.
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect > Printing the Nozzle CheckPattern
 Printing the Nozzle Check Pattern Print the nozzle check pattern to determine whether the ink ejects properly from the print head nozzles.
 You need to prepare: a sheet of A4 or Letter-sized plain paper
 Note If the Inner Cover is open, close it. If the remaining ink level is low, the nozzle check pattern will not be printed correctly. Replace theink tank whose ink is low.See Replacing an Ink Tank.
 You can also print the nozzle check pattern from the printer itself using the RESUME/CANCELbutton.
 1. Make sure that the power is turned on and one or more sheets of A4 or Letter-sized plain paperare loaded in the Cassette.
 2. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 3. Hold down the RESUME/CANCEL button until the Power lamp flashes green twice, and thenrelease it immediately.The nozzle check pattern will be printed. Do not open the Top Cover while printing is in progress.Examine the pattern and take an appropriate action.See Examining the Nozzle Check Pattern.
 1. Make sure that the power is turned on and one or more sheets of A4 or Letter-sizedplain paper are loaded in the Cassette.
 2. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 3. Open the printer properties dialog box.See Opening the Printer Properties Dialog Box (Windows) .
 4. Print the nozzle check pattern.
 (1) Click the Maintenance tab.
 (2) Click Nozzle Check.
 (3) Confirm the displayed message and click Print Check Pattern.The nozzle check pattern will be printed. Do not open the Top Cover while printing is in progress.
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Note Clicking Initial Check Items displays the items to be checked before printing the pattern.
 5. Examine the pattern.See Examining the Nozzle Check Pattern.
 1. Make sure that the power is turned on and one or more sheets of A4 or Letter-sizedplain paper are loaded in the Cassette.
 2. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 3. Open the Canon IJ Printer Utility dialog box.See Opening the Canon IJ Printer Utility (Macintosh).
 4. Print the nozzle check pattern.
 (1) Select Test Print in the pop-up menu.
 (2) Click Nozzle Check.
 (3) Confirm the displayed message and click Print Check Pattern.The nozzle check pattern will be printed. Do not open the Top Cover while printing is in progress.
 Note Clicking Initial Check Items displays the items to be checked before printing the pattern.
 5. Examine the pattern.See Examining the Nozzle Check Pattern.
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect > Examining the Nozzle CheckPattern
 Examining the Nozzle Check Pattern Examine the nozzle check pattern, and clean the Print Head if necessary.
 1. Check if there are no missing lines in the pattern (1) or no white streaks in thepattern (2).
 (1) Check if lines are missing in this pattern.If yes, clean the Print Head of the PGBK black ink tank.
 (A) Good
 (B) Bad (Lines are missing)
 (2) Check if white streaks are present in this pattern.If yes, clean the Print Heads of the color ink tanks including the BK black ink tank.
 (A) Good
 (B) Bad (White streaks are present)
 If there are missing lines in (1) and also white streaks in (2), clean all the ink tanks.
 2. Take necessary action. When cleaning is not requiredClick Exit (Windows) or Quit (Macintosh) on the Pattern Check dialog box to exit nozzle checkpattern examination.
 When cleaning is required
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Click Cleaning.
 Make sure that one or more sheets of A4 or Letter-sized plain paper are loaded in the Cassette,and then proceed to the procedure below.
 Go to the procedure of (3) in step 4.
 Go to the procedure of (3) in step 4.
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect > Cleaning the Print Head
 Cleaning the Print Head Clean the Print Head if lines are missing or if white streaks are present in the printed nozzle checkpattern. Cleaning unclogs the nozzles and restores the print head condition. Cleaning the Print Headconsumes ink, so clean the Print Head only when necessary.
 You need to prepare: a sheet of A4 or Letter-sized plain paper
 Note If the Inner Cover is open, close it.
 Cleaning the Print Head without a computer You can also clean the Print Heads of all color ink tanks at the same time from the printer itself usingthe RESUME/CANCEL button.
 1. Make sure that the power is turned on.
 2. Hold down the RESUME/CANCEL button until the Power lamp flashes green once, and thenrelease it immediately.The printer starts cleaning the Print Head. When the Power lamp is lit green after flashing, thecleaning will be completed. Print the nozzle check pattern to check the print head condition aftercleaning.See Examining the Nozzle Check Pattern.
 If you click Cleaning on the Pattern Check dialog box that appears after printing the nozzle check pattern,the printer starts cleaning the Print Head. Make sure that one or more sheets of A4 or Letter-sized paperare loaded in the Cassette, and then go to the procedure of (3) in step 4.
 1. Make sure that the power is turned on and one or more sheets of A4 or Letter-sizedplain paper are loaded in the Cassette.
 2. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 3. Open the printer properties dialog box.See Opening the Printer Properties Dialog Box (Windows) .
 4. Clean the Print Head.
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(1) Click the Maintenance tab.
 (2) Click Cleaning.
 (3) Select the ink group to clean.When cleaning the nozzles of black ink tanks: Select Black if there are missing lines in PGBK of the nozzlecheck pattern, or Color if there are white streaks in BK of the nozzle check pattern.
 For details on the nozzle check pattern, see Examining the Nozzle Check Pattern.
 (4) Click Execute.The printer starts cleaning the Print Head when the Power lamp starts flashing green.
 Do not perform any other operations until the printer completes the cleaning of the Print Head. This takesabout 1 minute 30 seconds.
 Note Clicking Initial Check Items displays the items to be checked before printing the pattern.
 (5) Confirm the displayed message and click Print Check Pattern.The nozzle check pattern will be printed.
 Do not perform any other operations until the printer completes the printing of the nozzle check pattern.
 5. Check the printed nozzle check pattern.See Examining the Nozzle Check Pattern.
 Note If the problem is not resolved after cleaning the Print Head twice, clean the Print Head deeply.See Cleaning the Print Head Deeply.
 If you click Cleaning on the Pattern Check dialog box that appears after printing the nozzle check pattern,the printer starts cleaning the Print Head. Make sure that one or more sheets of A4 or Letter-sized paperare loaded in the Cassette, and then go to the procedure of (3) in step 4.
 1. Make sure that the power is turned on and one or more sheets of A4 or Letter-sizedplain paper are loaded in the Cassette.
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2. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 3. Open the Canon IJ Printer Utility dialog box.See Opening the Canon IJ Printer Utility (Macintosh).
 4. Clean the Print Head.
 (1) Make sure that Cleaning is selected in the pop-up menu.
 (2) Click Cleaning.
 (3) Select the ink group to clean.When cleaning the nozzles of black ink tanks: Select Black if there are missing lines in PGBK of the nozzlecheck pattern, or Color if there are white streaks in BK of the nozzle check pattern.
 For details on the nozzle check pattern, see Examining the Nozzle Check Pattern.
 (4) Click OK.The printer starts cleaning the Print Head when the Power lamp starts flashing green.
 Do not perform any other operations until the printer completes the cleaning of the Print Head. This takesabout 1 minute 30 seconds.
 Note Clicking Initial Check Items displays the items to be checked before cleaning.
 (5) Confirm the displayed message and click Print Check Pattern.The nozzle check pattern will be printed.
 Do not perform any other operations until the printer completes the printing of the nozzle check pattern.
 5. Check the printed nozzle check pattern.See Examining the Nozzle Check Pattern.
 Note If the problem is not resolved after cleaning the Print Head twice, clean the Print Head deeply.See Cleaning the Print Head Deeply.
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect > Cleaning the Print HeadDeeply
 Cleaning the Print Head Deeply If print quality does not improve by standard cleaning of the Print Head, clean the Print Head deeply.Cleaning the Print Head deeply consumes more ink than standard cleaning of the Print Head, so cleanthe Print Head deeply only when necessary.
 1. Make sure that the power is turned on.
 2. Open the printer properties dialog box.See Opening the Printer Properties Dialog Box (Windows) .
 3. Clean the Print Head deeply.
 (1) Click the Maintenance tab.
 (2) Click Deep Cleaning.
 (3) Select the ink group to clean deeply.When cleaning the nozzles of black ink tanks: Select Black if there are missing lines in PGBK of the nozzlecheck pattern, or Color if there are white streaks in BK of the nozzle check pattern.
 For details on the nozzle check pattern, see Examining the Nozzle Check Pattern.
 (4) Click Execute.
 Note Clicking Initial Check Items displays the items to be checked before cleaning the Print Headdeeply.
 (5) Confirm the displayed message and click OK.The printer starts cleaning the Print Head deeply when the Power lamp starts flashing green.
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Do not perform any other operations until the printer completes the deep cleaning of the Print Head. Thistakes about 3 minutes.
 4. Print the nozzle check pattern to check the print head condition.See Printing the Nozzle Check Pattern.
 Note If the problem is not resolved, open the Top Cover to confirm that the ink is remaining, turn offthe printer, then clean the Print Head deeply again after 24 hours.
 If this does not solve the problem, the Print Head may be damaged. Contact the Canon servicerepresentative.
 1. Make sure that the power is turned on.
 2. Open the Canon IJ Printer Utility dialog box.See Opening the Canon IJ Printer Utility (Macintosh).
 3. Clean the Print Head deeply.
 (1) Make sure that Cleaning is selected in the pop-up menu.
 (2) Click Deep Cleaning.
 (3) Select the ink group to clean deeply.When cleaning the nozzles of black ink tanks: Select Black if there are missing lines in PGBK of the nozzlecheck pattern, or Color if there are white streaks in BK of the nozzle check pattern.
 For details on the nozzle check pattern, see Examining the Nozzle Check Pattern.
 (4) Click OK.The printer starts cleaning the Print Head deeply when the Power lamp starts flashing green.
 Do not perform any other operations until the printer completes the deep cleaning of the Print Head. Thistakes about 3 minutes.
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Note Clicking Initial Check Items displays the items to be checked before cleaning the Print Headdeeply.
 4. Print the nozzle check pattern to check the print head condition.See Printing the Nozzle Check Pattern.
 Note If the problem is not resolved, open the Top Cover to confirm that the ink is remaining, turn offthe printer, then clean the Print Head deeply again after 24 hours.
 If this does not solve the problem, the Print Head may be damaged. Contact the Canon servicerepresentative.
 Page top
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > When Printing Becomes Faint or Colors Are Incorrect > Aligning the Print Head
 Aligning the Print Head If printed ruled lines are misaligned or print results are otherwise unsatisfactory, adjust the print headposition.
 You need to prepare: a sheet of A4 or Letter-sized supplied paper or CanonMatte Photo Paper MP-101
 Note If the Inner Cover is open, close it.
 Aligning the Print Head without a computer You can also align the Print Head from the printer itself using the RESUME/CANCEL button.
 1. Make sure that the power is turned on and a sheet of A4 or Letter-sized supplied paper or CanonMatte Photo Paper MP-101 is loaded in the Rear Tray. Load them with the printing side (whiterside) facing you in the Rear Tray.
 2. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 3. Hold down the RESUME/CANCEL button until the Power lamp flashes green four times, and thenrelease it immediately.The print head alignment pattern will be printed. Do not open the Top Cover while printing is inprogress.The print head position is adjusted automatically when the printer finishes printing the print headalignment pattern.
 1. Make sure that the power is turned on and a sheet of A4 or Letter-sized suppliedpaper or Canon Matte Photo Paper MP-101 is loaded in the Rear Tray.Load them with the printing side (whiter side) facing you in the Rear Tray.
 2. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 3. Open the printer properties dialog box.See Opening the Printer Properties Dialog Box (Windows) .
 4. Adjust the print head position.
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(1) Click the Maintenance tab.
 (2) Click Print Head Alignment.
 (3) Confirm the displayed message, and click Align Print Head.The print head alignment pattern will be printed and the printer will adjust the print head positionautomatically. Do not open the Top Cover while printing is in progress. Printing takes about 7 minutes tocomplete.
 Note The pattern will be printed in black and blue. If the adjustment has failed, the Alarm lamp will flash.Refer to the "Eleven flashes: Automatic Print Head Alignment failed." in the "Alarm LampFlashes Orange" of the on-screen manual: Advanced Guide.
 If the above does not improve the print results, align the Print Head manually.Refer to the on-screen manual: Advanced Guide.
 1. Make sure that the power is turned on and a sheet of A4 or Letter-sized suppliedpaper or Canon Matte Photo Paper MP-101 is loaded in the Rear Tray.Load them with the printing side (whiter side) facing you in the Rear Tray.
 2. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
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3. Open the Canon IJ Printer Utility dialog box.See Opening the Canon IJ Printer Utility (Macintosh).
 4. Adjust the print head position.
 (1) Select Test Print in the pop-up menu.
 (2) Click Print Head Alignment.
 (3) Confirm the displayed message, and click Align Print Head.The print head alignment pattern will be printed and the printer will adjust the print head positionautomatically. Do not open the Top Cover while printing is in progress. Printing takes about 7 minutes tocomplete.
 Note The pattern will be printed in black and blue. If the adjustment has failed, the Alarm lamp flashes.Refer to the "Eleven flashes: Automatic Print Head Alignment failed." in the "Alarm LampFlashes Orange" of the on-screen manual: Advanced Guide.
 If the above does not improve the print results, align the Print Head manually.Refer to the on-screen manual: Advanced Guide.
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > Cleaning the Paper Feed Roller
 Cleaning the Paper Feed Roller If the Paper Feed Roller is dirty or paper powder is attached to it, paper may not be fed from the Rear Trayor Cassette properly. In this case, clean the Paper Feed Roller. Cleaning will wear out the Paper FeedRoller, so perform this only when necessary.
 You need to prepare: three sheets of A4 or Letter-sized plain paper
 Note If the Inner Cover is open, close it.
 1. Make sure that the power is turned on, and remove any paper in the printer.
 2. Open the Paper Output Tray gently, and extend to open the Output Tray Extension.
 3. Open the printer properties dialog box.See Opening the Printer Properties Dialog Box (Windows) .
 4. Clean the Paper Feed Roller.
 (1) Click the Maintenance tab.
 (2) Click Roller Cleaning.
 (3) Select the paper source to clean.
 (4) Click OK.
 (5) Confirm the displayed message, and click OK.The Paper Feed Roller will rotate as it is cleaned.
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5. Make sure that the Paper Feed Roller stops rotating. When the message appears,load paper in the paper source you selected in the procedure of (3) in step 4.Load three sheets of A4 or Letter-sized plain paper.
 6. Confirm the displayed message, and click OK.The paper that is loaded in the printer will feed through the printer and be ejected.Do not perform any other operations until the printer completes the cleaning of the Paper Feed Roller.
 7. When the completion message appears, click OK.
 If the problem is not resolved after cleaning the Paper Feed Roller (A) in the Rear Tray as describedabove, turn off the printer, unplug the power cord, and then wipe the Paper Feed Roller located inthe center inside the Rear Tray with a moistened cotton swab or the like. Rotate the roller manuallyin the direction of the arrow (B) as you clean it. Do not touch the roller with your fingers; rotate it withthe cotton swab. If this does not solve the problem, contact your Canon service representative.
 1. Make sure that the power is turned on, and remove any paper in the printer.
 2. Open the Paper Output Tray gently, and extend to open the Output Tay Extension.
 3. Open the Canon IJ Printer Utility dialog box.See Opening the Canon IJ Printer Utility (Macintosh).
 4. Clean the Paper Feed Roller.
 (1) Make sure that Cleaning is selected in the pop-up menu.
 (2) Click Roller Cleaning.
 (3) Select the paper source to clean.
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(4) Click OK.
 (5) Confirm the displayed message, and click OK.The Paper Feed Roller will rotate as it is cleaned.
 5. Make sure that the Paper Feed Roller stops rotating. When the message appears,load paper in the paper source you selected in the procedure of (3) in step 4.Load three sheets of A4 or Letter-sized plain paper.
 6. Confirm the displayed message, and click OK.The paper that is loaded in the printer will feed through the printer and be ejected.Do not perform any other operations until the printer completes the cleaning.
 If the problem is not resolved after cleaning the Paper Feed Roller (A) in the Rear Tray as describedabove, turn off the printer, unplug the power cord, and then wipe the Paper Feed Roller located inthe center inside the Rear Tray with a moistened cotton swab or the like. Rotate the roller manuallyin the direction of the arrow (B) as you clean it. Do not touch the roller with your fingers; rotate it withthe cotton swab. If this does not solve the problem, contact your Canon service representative.
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > Cleaning the Pad in the Cassette
 Cleaning the Pad in the Cassette If the Pad in the Cassette is smeared with paper powder or dirt, two or more sheets of paper may beejected. Follow the procedure below to clean the Pad in the Cassette.
 You need to prepare: cotton swab
 1. Pull out the Cassette from the printer, and remove all the papers.
 2. Clean the Pad sideways with a moistened cotton swab.
 (A) Pad
 Important After cleaning the smeared Pad, dry it completely. If the problem is not resolved, contact your Canon service representative.
 Page top
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Advanced Guide Troubleshooting
 Contents > Routine Maintenance > Opening the Maintenance Screens
 Opening the Maintenance Screens You can maintain the printer from the printer properties dialog box (Windows) or Canon IJ Printer Utility(Macintosh).
 Opening the Printer Properties Dialog Box (Windows)
 1. Click Control Panel, and Printer under Hardware and Sound. In Windows XP, click Control Panel, Printers and Other Hardware, then Printers and Faxes. In Windows 2000, click Control Panel, and Printers.
 2. Right-click the Canon XXX icon (where "XXX" is your printer's name), and selectPrinting Preferences.
 The printer properties dialog box opens.
 Note You can also open the printer properties dialog box from your software application or MyPrinter on a desktop.For details, refer to the on-screen manual: Advanced Guide.
 Opening the Canon IJ Printer Utility (Macintosh)
 1. Open System Preferences, and click Print & Fax.
 2. Select your printer's name in Printers, and click Open Print Queue.The list of printer jobs appears.
 3. Click Utility.The print list dialog box appears.
 4. Select your printer's name in the Product list, and click Maintenance.
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The Canon IJ Printer Utility starts up.
 Note You can also open Canon IJ Printer Utility by the procedure below.Select Applications from the Go menu, double-click the Utilities folder, then double-click PrinterSetup Utility.For details, refer to the on-screen manual: Advanced Guide.
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Advanced Guide Troubleshooting
 Contents > Appendix
 Appendix Safety Precautions
 Legal Limitations on Use of Your Product and Use of Images
 Tips on How to Use Your Printer
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Advanced Guide Troubleshooting
 Contents > Appendix > Safety Precautions
 Safety Precautions Please read the safety warnings and cautions provided in this manual to ensure that you use the printersafely. Do not attempt to use the printer in any way not described in this manual. It causes unexpectedaccident, fire, or electrical shock.
 Warning This product emits low level magnetic flux. If you use a cardiac pacemaker and feel abnormalities,please move away from this product and consult your doctor.
 You may cause an electric shock, fire, or damage the printer if you ignore any of these safetyprecautions.
 Choosing alocation
 Do not place the printer close to flammable solvents such asalcohol or thinners.
 Powersupply
 Never attempt to plug in or unplug the printer from the powersupply when your hands are wet.
 Always push the plug all the way into the power outlet.
 Never damage, modify, stretch orexcessively bend or twist the powercord.Do not place heavy objects onthe power cord.
 Never plug the printer into a powersocket that is shared with otherequipment (extension lead/cord, 2- or3-way adapter, etc.).
 Never use the printer if the power cord is bundled or knotted.
 If you detect smoke, unusual smells or strange noises aroundthe printer, immediately unplug the printer at the power supplyand call for service.
 Periodically, unplug the printer anduse a dry cloth to wipe off any dust ordirt collected on the plug and thepower outlet.If the printer is placed ata location exposed to a lot of dust,smoke, or high humidity, the dustcollected on the plug absorbsmoisture and may cause insulation
 failure and fire.
 If you hear thunder, disconnect the power supply of the printerand refrain from using it.Leaving the printer plugged in maycause fire, electric shock, or damage to the printer, dependingon the thunder storm.
 Use the power cable included with the printer.
 Cleaning theprinter
 Use a damp cloth to clean the printer.Never use flammable solvents suchas alcohol, benzene or thinners.If flammable solvents come in contact withelectrical components inside the printer, itcould cause a fire or electric shock.
 Always unplug the printer from the power outlet beforecleaning the printer.
 Стр. 70 из 396 стр.Safety Precautions

Page 71
                        

If you accidentally switch the printer on while cleaning it, you couldinjure yourself or damage the printer.
 Maintainingthe printer
 Do not attempt to disassemble or modify the printer. There areno user serviceable parts inside the printer.The printer contains high-voltage components. Never attempt anymaintenance procedure not described in this guide.
 Workingaround theprinter
 Do not use highly flammable sprays near the printer.This could cause a fire or electric shock if the spray comes into contactwith electrical components inside the printer.
 Caution You may cause injury or damage the printer if you ignore any of these safety precautions.
 Choosing alocation
 Do not install the printer in a location that is unstable orsubject to excessive vibration.
 Do not install the printer in locations that are very humid ordusty, in direct sunlight, outdoors, or close to a heatingsource.To avoid the risk of fire or electric shocks, install the printer ina location with an ambient temperature range of 5°C to 35°C(41°F to 95°F) and humidity of 10% to 90% (condensation free).
 Do not place the printer on a thick rug or carpet.
 Do not place the printer with its back attached to the wall.
 Power supply Never remove the plug by pulling onthe cord.
 Do not use an extension lead/cord.
 Ensure that the area around thepower outlet is kept clear at all timesso you can easily unplug the powercord if necessary.
 Workingaround theprinter
 Never put your hands or fingers in the printer while it isprinting.
 When moving the printer, carry the printer at both ends.
 Do not place any object on the printer.
 Do not place metal objects (paper clips, staples, etc.) orcontainers of flammable solvents (alcohol, thinners, etc.) ontop of the printer.
 If any foreign object (metal or liquid) fall into the printer,unplug the power cord and call for service.
 Do not transport or use the printer on a slant, vertically orupside-down, as the ink may leak and damage the printer.
 Print Headand ink tanks
 Keep ink tanks out of the reach of children.In case ink is accidentally licked or swallowed, rinse out mouth or giveone or two glasses of water to drink.
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If irritation or discomfort occurs, obtain medical advice immediately.
 In case ink gets in contact with eyes, rinse with waterimmediately.In case ink gets in contact with skin, wash with soap andwater immediately.If irritation to eyes or skin persists, obtain medical advice immediately.
 Do not shake Print Heads or ink tanks.Ink may spill out and stain clothing or the surrounding area.
 Never touch the electrical contacts ona Print Head after printing.The metal parts may be very hot and couldcause burns.
 Do not throw ink tanks into fire.
 Do not attempt to disassemble or modify the Print Head andink tanks.
 Do not handle the Print Head and ink tanks roughly such asapplying them excessive pressure or dropping them.
 Do not rinse or wipe the Print Headand ink tanks.
 Once you have installed the Print Head and ink tanks, do notremove them unnecessarily.
 Note when you place the printer near other electrical appliances such as fluorescent lamps Place the printer at least 5.91 inches / 15 cm away from other electrical appliances such asfluorescent lamps. If the printer is placed closer to those, it may not be able to work properly due tofluorescent noises. When you turn off the powerWhen you turn off the power, always press the Power button and be sure that the Power lamp (ingreen) has gone out. If you disconnect the power plug from the power outlet when the Power lamplights or flashes, the Print Head cannot be protected and you may not be able to print later.
 Page top
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Advanced Guide Troubleshooting
 Contents > Appendix > Legal Limitations on Use of Your Product and Use of Images
 Legal Limitations on Use of Your Product and Use of Images It may be unlawful to print the following documents.The list provided is non-exhaustive. When in doubt, check with a legal representative in your jurisdiction.
 Paper money Money orders Certificates of deposit Postage stamps (canceled oruncanceled)
 Identifying badges or insignias Selective service or draft papers Checks or drafts issued bygovernmental agencies
 Motor vehicle licenses andcertificates of title
 Traveler's checks Food stamps Passports Immigration papers Internal revenue stamps (canceled oruncanceled)
 Bonds or other certificates of indebtedness Stock certificates Copyrighted works/works of art withoutpermission of copyright owner
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Advanced Guide Troubleshooting
 Contents > Appendix > Tips on How to Use Your Printer
 Tips on How to Use Your Printer This section introduces the tips on how to use your printer and for printing with optimal quality.
 Ink is used for various purposes.
 How is ink used for various purposes other than printing?
 Ink may be used for purposes other than printing. Ink is not only used for printing, but also for cleaningthe Print Head to maintain the optimal printing quality.The printer has the function to automatically clean the ink jet nozzles to prevent clogging. In the cleaningprocedure, ink is pumped out from the nozzles. Used ink for nozzle cleaning is limited to a small amount.
 Important The ink pumped out from the nozzles, such as when cleaning the Print Head, is absorbed by inkabsorber in the printer. The ink absorber needs to be replaced when it is full. You cannot replace itby yourself. Contact your Canon service representative as soon as possible. Before the inkabsorber becomes full, the Alarm lamp indicates you that it needs to be replaced with a new one.Refer to the "Troubleshooting" in the on-screen manual: Advanced Guide.
 Does black-and-white printing use color ink?
 The use of each ink varies depending on the color of image to be printed or the contents of document.Two kinds of black ink (PGBK and BK) are used automatically depending on the media type to print or onthe settings of the printer driver. PGBK is used mainly for printing text-based documents and BK is usedmainly for printing photos, illustration, etc. Black-and-white printing may also use ink other than black ink.So, color ink is consumed even when printing in black-and-white.
 The ink lamp informs you when ink is running low. The inside of the ink tank consists of (A) the part where ink is preserved and (B) the sponge withabsorbed ink.
 When the ink (A) runs out, the ink lamp flashes slowly to indicate that the ink is running low. Then,when the ink (B) runs out, the ink lamp flashes fast to indicate that the ink needs to be replaced witha new one.
 Printing on special paper: How to print with optimal quality!?
 Tip!: Check the printer status before printing!
 Is the Print Head ok? If print head nozzles are clogged, print will be faint and papers will be wasted. Print the nozzlecheck pattern to check the Print Head.
 See When Printing Becomes Faint or Colors Are Incorrect .
 Is the inside of the printer smeared with ink? After printing large quantities of paper or performing borderless printing, the area where papersgo through may get smeared with ink. Clean the inside of your printer with Bottom PlateCleaning.
 Refer to the on-screen manual: Advanced Guide.
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Tip!: Check how to load the paper correctly!
 Is the paper loaded in the correct orientation? When loading paper in the Rear Tray or Cassette, make sure the orientation of paper.
 (A)(A) Rear Tray(B) Cassette
 (B)
 To load paper in the Rear Tray, loadpaper with the printing side facingyou.
 To load paper in the Cassette, load paper with theprinting side facing down.
 Is the paper curled? The curled paper causes paper jam. Flatten the curled paper, then reload it.
 Refer to the "Troubleshooting" in the on-screen manual: Advanced Guide .
 Tip!: After loading paper, be sure to specify the paper settings! After loading paper, be sure to select the loaded paper in Media Type of the printer driver. If the type ofpaper is not selected, you may not be able to get the satisfactory print result.See Printing.There are various types of paper: paper with special coating on the surface for printing photos withoptimal quality and paper suitable for documents. Media Type of the printer driver has different settingsfor each type of paper in advance (such as using ink, ejecting ink, or distance from nozzles) so that youcan print on each paper with the optimal image quality. You can print with different settings in Media Typesuitable for each type of loaded paper.
 Use the RESUME/CANCEL button to cancel printing!
 Tip!: Never press the Power button! If you press the Power button while printing is in progress, the print data sent from the computer queuesin the printer and you may not be able to continue to print.Press the RESUME/CANCEL button to cancel printing.
 Note If you cannot cancel printing by pressing the RESUME/CANCEL button while printing from acomputer, open the printer properties dialog box to delete the unnecessary print jobs from theprinter status monitor (Windows).
 How to maintain the optimal printing quality?
 The key to printing with the optimal printing quality is to prevent the Print Head from drying or clogging.Always follow the following steps for optimal printing quality.
 Follow the procedure below to unplug the power cord.
 1 Press the Power button on the printer to turn it off.
 2 Be sure that the Power lamp is not lit.
 3 Unplug the power cord from the wall outlet, or turn off the extender cable connector.
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If you press the Power button to turn off the power, the printer caps the Print Head (nozzles)automatically to prevent from drying. If you unplug the power cord from the wall outlet or turn offthe extender cable connector before the Power lamp is turned off, the Print Head will not becapped properly and this will cause drying or clogging.
 To unplug the power cord, be sure to follow this procedure.
 Print periodically! Just as the tip of a felt pen becomes dry and unusable if it has not been used for a long time,even if it is capped, the Print Head too, may become dried or clogged if the printer has not beenused for a long time.
 We recommend the printer to be used at least once a month.
 Note Depending on the type of paper, ink may blur if you trace the printed area with a highlight penor paint-stick, or bleed if water or sweat comes in contact with the printed area.
 Does the printer need to be handled with care when using ortransporting?
 Tip!: Do not use or transport the printer vertically or slanted!
 If the printer is used or transported vertically or slanted, the printer may become damaged or ink mayleak from the printer. Be sure not to use or transport the printer vertically or slanted.
 Lamp on the printer is flashing: What can I do?
 Alarm lamp is flashing orange.
 (A) Alarm lamp flashes
 (B) Alarm lamp is off
 (C) Alarm lamp flashes repeatedly
 →Your printer has an error. Refer to the " Troubleshooting" in the on-screen manual: AdvancedGuide, then resolve the error.
 Power lamp flashes green once and Alarm lamp flashes orange oncealternately.
 →An error that requires repair has occurred. Contact your Canon service representative.
 Colors are uneven, and print results are blurred.
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Tip!: Print the nozzle check pattern to check if the nozzlesare clogged.
 If the print head nozzles are clogged, colors may become uneven or the print results may be blurred.
 In this case
 Print the nozzle check patternCheck the printed check pattern to see if the nozzles are clogged.See When Printing Becomes Faint or Colors Are Incorrect .
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 When you display this On-screenManual in a language environmentother than English, some Englishdescriptions may be displayed.
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Using the Blemish Remover Function
 Adjusting Images
 Correct/Enhance Images Window
 Questions and AnswersHow Can I Move (or Copy) the Saved File?
 Which Side of the Displayed Image Does the PrintingStart from?
 How Do I Print with Even Margins?
 What Is "C1" or "C4"?
 Appendix 1: Easy-PhotoPrint EX Settings
 Printing on a DVD/CD
 Printing Vivid Photos
 Reducing Photo Noise
 Cropping Photos (Photo Print)
 Printing Dates on Photos (Photo Print)
 Printing Multiple Photos on One Page
 Printing an Index
 Printing ID Photos (ID Photo Print)
 Printing Photo Information
 Saving Photos
 Opening Saved Files
 Changing Layout
 Changing Background
 Adding Photos
 Swapping Positions of Photos
 Replacing Photos
 Changing Position, Angle and Size of Photos
 Cropping Photos
 Framing Photos
 Printing Dates on Photos
 Attaching Comments to Photos
 Adding Text to Photos
 Saving
 Setting Holidays
 Setting Calendar Display
 Printing with Other Application Software
 Various Printing Methods
 Printing with Easy Setup
 Setting a Page Size and Orientation
 Setting the Number of Copies and Printing Order
 Setting the Stapling Margin
 Borderless Printing
 Fit-to-Page Printing
 Scaled Printing
 Page Layout Printing
 Poster Printing
 Booklet Printing
 Duplex Printing
 Stamp/Background Printing
 Saving a Stamp Setting
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Saving Image Data to be Used as a Background
 Printing an Envelope
 Switching the Paper Source to Match the Purpose
 Displaying the Print Results before Printing
 Setting Paper Dimensions (Custom Size)
 Changing the Print Quality and Correcting Image Data
 Selecting a Combination of the Print Quality Leveland a Halftoning Method
 Printing a Color Document in Monochrome
 Specifying Color Correction
 Optimal Photo Printing of Image Data
 Adjusting Colors with the Printer Driver
 Printing with ICC Profiles
 Adjusting Color Balance
 Adjusting Brightness
 Adjusting Intensity
 Adjusting Contrast
 Simulating an Illustration
 Representing Image Data with a Single Color
 Presenting Image Data with Vivid Colors
 Smoothing Jagged Outlines
 Changing Color Properties to Improve Coloration
 Reducing Photo NoiseOverview of the Printer Driver
 Canon IJ Printer Driver
 How to Open the Printer Driver Setup Window
 Maintenance Tab
 Canon IJ Status Monitor
 The Canon IJ Preview
 Printing Photographs Directly from a Compliant Device
 Printing Photographs Directly from a Compliant Device
 Printing Photographs Directly from a Compliant Device
 About PictBridge Print Settings
 Settings on a PictBridge Compliant Device
 Troubleshooting
 Troubleshooting
 If an Error Occurs
 The Printer Can Not Be Powered On
 Alarm Lamp Flashes Orange
 Power Lamp Flashes Green and Alarm Lamp FlashesOrange Alternately
 Cannot Install the Printer Driver
 Cannot Connect to Computer Properly
 Printing Speed Is Slow / Hi-Speed USB Connection DoesNot Work/"This device can perform faster" Message IsDisplayed
 Print Results Not Satisfactory
 Cannot Print to End of Job
 Part of the Page Is Not Printed
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No Printing Results/Printing Is Blurred/Colors Are Wrong/White Streaks
 Lines Are Misaligned
 Printed Paper Curls or Has Ink Blots
 Paper Is Smudged/Printed Surface Is Scratched
 Back of the Paper Is Smudged
 Vertical Lines Are Printed on the Sides of the Printout
 Colors Are Uneven or Streaked
 Printing Does Not Start
 Printing Stops Before It Is Completed
 Printer Moves But Ink Is Not Ejected
 Printing Speed Not as Fast as Expected
 Print Head Holder Does Not Move to the Position forReplacing
 Paper Does Not Feed Properly
 Paper Does Not Feed from the Paper Source Specified in thePrinter Driver
 Paper Jams
 Message Appears on the Computer Screen
 Service Error 5100 Is Displayed
 Error Regarding Automatic Duplex Printing Is Displayed
 Error Regarding Automatic Print Head Alignment IsDisplayed
 Writing Error/Output Error/Communication Error
 Error Number: 300 Is Displayed
 Error Number: 1700 Is Displayed
 Ink Info Number: 1600 Is Displayed
 Ink Info Number: 1683 Is Displayed
 Ink Info Number: 1688 Is Displayed
 Error Number: 1851 Is Displayed
 Error Number: 1856 Is Displayed
 Error Number: 2001 Is Displayed
 Error Number: 2002 Is Displayed
 Error Number: 2500 Is Displayed
 Other Error Messages
 Cannot Print Properly with Automatic Duplex Printing
 For Windows Users
 Printer Status Monitor Is Not Displayed
 The Inkjet Printer/Scanner Extended Survey ProgramScreen Is Displayed
 Error Message Appears on a PictBridge Compliant DeviceFAQs
 If You Cannot Resolve the Problem
 Instructions for Use (Printer Driver)
 Using Easy-PhotoPrint EX
 About Solution Menu
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Advanced Guide > How to Use This Manual
 How to Use This ManualOperating the Contents ScreenOperating the Explanation Screen
 Printing This ManualUsing Keywords to Find a TopicRegistering Topics to My Manual
 Symbols Used in this DocumentTrademarks
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Advanced Guide > How to Use This Manual > Operating the Contents Screen
 Operating the Contents Screen
 When you click a title displayed in the Contents screen found to the left of the On-screen Manual, thepages of that title are displayed in the description window on the right side.
 When you click found to the left of , the titles found in the lower hierarchies are displayed.
 Note
 Click to close or display the Contents screen.
 Page top
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Advanced Guide > How to Use This Manual > Operating the Explanation Screen
 Operating the Explanation Screen
 (1) Click the green characters to jump to the corresponding page.(2) The cursor jumps to the top of this page.
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Advanced Guide > How to Use This Manual > Printing This Manual
 Printing This Manual
 Click to display the Print window to the left of the On-screen Manual.
 Note
 Click , and then click Option Settings to display the Option Settings dialog box. You can then set upthe printing operation.To display the Print dialog box, click and then click Print Settings. When the dialog box isdisplayed, select the printer to be used for printing.After selecting the printer to be used, click Properties... to specify the print settings.
 The following four methods of printing are available:
 Current Document
 Selected Documents
 My Manual
 All Documents
 Current DocumentYou can print the currently displayed topic.
 1. From Select Target, select Current DocumentThe title of the currently displayed topic is displayed in the Documents to Be Printed list.
 Note
 By selecting Print linked documents, you can also print documents that are linked to the currentdocument. The linked documents are added to the Documents to Be Printed list.Click Print Preview to display and check what the print results will look like before you actuallyprint the document.
 2. Click Start PrintingThe Print Page Count Confirmation dialog box is displayed.
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3. Execute printConfirm the number of pages to be printed, and then click Yes.The topics that are currently displayed are printed.
 Selected DocumentsYou can select and print the topics that you want printed.
 1. From Select Target, select Selected DocumentsThe titles of all topics are displayed in the Documents to Be Printed list.
 2. Select the topics to be printedFrom the Documents to Be Printed list, select the title check boxes of the topics to be printed.
 Note
 When you select the Automatically select documents in lower hierarchies check box, the checkboxes of all titles found in the lower hierarchies are selected.Click Select All to select the check boxes of all titles.Click Clear All to clear the check boxes of all titles.Click Print Preview to display and check what the print results will look like before you actuallyprint the document.
 3. Click Start PrintingThe Print Page Count Confirmation dialog box is displayed.
 4. Execute printConfirm the number of pages to be printed, and then click Yes.All topics with selected check boxes are printed.
 My ManualYou can select and print topics registered in My Manual.
 For details about My Manual, see " Registering Topics to My Manual ."
 1. From Select Target, select My ManualThe titles of the topics that have been registered to My Manual are displayed in the Documents to BePrinted list.
 2. Select the topics to be printedFrom the Documents to Be Printed list, select the title check boxes of the topics to be printed.
 Note
 Click Select All to select the check boxes of all titles.Click Clear All to clear the check boxes of all titles.Click Print Preview to display and check what the print results will look like before you actuallyprint the document.
 3. Click Start PrintingThe Print Page Count Confirmation dialog box is displayed.
 4. Execute printConfirm the number of pages to be printed, and then click Yes.All topics with selected check boxes are printed.
 All DocumentsYou can print all topics of the On-screen Manual.
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1. From Select Target, select All DocumentsThe titles of all topics are displayed in the Documents to Be Printed list, and the check boxes areautomatically selected.
 Note
 If you clear the check box of a topic, that topic is not printed.Click Select All to select the check boxes of all titles.Click Clear All to clear the check boxes of all titles.Click Print Preview to display and check what the print results will look like before you actuallyprint the document.
 2. Click Start PrintingThe Print Page Count Confirmation dialog box is displayed.
 3. Execute printConfirm the number of pages to be printed, and then click Yes.All topics are printed.
 Important A large amount of paper is necessary to print all topics. Before printing, be sure to check thenumber of print pages displayed in the Print Page Count Confirmation dialog box.You can change the print magnification from the Print Preview dialog box. However, if the printdata extends outside the paper with the new magnification, the portion of the document will notbe printed on the paper.
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Advanced Guide > How to Use This Manual > Using Keywords to Find a Topic
 Using Keywords to Find a TopicYou can enter a keyword to search for a target page.
 All installed On-screen Manuals (user's guides) are searched.
 1. Click A search window is displayed to the left of the On-screen Manual.
 Note
 Click to close or display the Search window.
 2. Enter a keywordIn Keyword, enter a keyword for the item to be checked.
 If you want to enter multiple keywords, insert a space between the keywords.
 Note
 You can enter up to 10 keywords or up to 255 characters.Uppercase and lowercase are not discriminated.The program can also search for keywords that contain spaces.
 3. Click Start SearchingThe search is started, and the titles of topics containing the keyword are displayed in the searchresults list.When you execute a search by entering multiple keywords, the search results are displayed asshown below.
 [Documents Containing Perfect Match] Topics containing the entire search character string (including spaces) exactly as entered (perfectmatch)
 [Documents Containing All Keywords] Topics containing all keywords that were entered
 [Documents Containing Any Keyword] Topics containing at least one of the keywords that were entered
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4. Display the topic that you want to readFrom the search results list, double-click (or select and press Enter) the title of the topic you want toread.When the pages of that title are displayed, the keywords found on those pages are highlighted.
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Advanced Guide > How to Use This Manual > Registering Topics to My Manual
 Registering Topics to My ManualRegister frequently read pages as My Manual topics so that you can refer to those pages easily at anytime.
 1. Display the topicDisplay the topic to be added to My Manual.
 2. Click The My Manual window is displayed to the left of the On-screen Manual.
 Note
 Click to close or display the My Manual window.
 3. Register the topic to My ManualClick Add.
 The currently displayed topic is added to List of My Manual.
 Note
 Alternatively, from the Recently Displayed Documents list, double-click (or select and pressEnter) the topic to be added to My Manual to display that topic, and then click Add.
 4. Display My ManualWhen you double-click (or select and press Enter) a topic displayed in List of My Manual, that topic isdisplayed in the Description window.
 Note
 To delete a topic from List of My Manual, select that topic from the list, and then click Delete (orpress Delete).
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Advanced Guide > How to Use This Manual > Symbols Used in this Document
 Symbols Used in this Document
 Warning Instructions that, if ignored, could result in death or serious personal injury caused by incorrect operationof the equipment. These must be observed for safe operation.
 Caution Instructions that, if ignored, could result in personal injury or material damage caused by incorrectoperation of the equipment. These must be observed for safe operation.
 Important Instructions that must be observed for safe operation.
 Note Instructions as notes for operation or additional explanations.
 Indicates operations in Windows.
 Indicates operations in Macintosh.
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Advanced Guide > How to Use This Manual > Trademarks
 TrademarksMicrosoft is a registered trademark of Microsoft Corporation.
 Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or othercountries.
 Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/orother countries.
 Macintosh and Mac are trademarks of Apple Inc., registered in the U.S. and other countries.
 Adobe, Adobe Photoshop, Adobe RGB and Adobe RGB (1998) are either registered trademarks ortrademarks of Adobe Systems Incorporated in the United States and or other countries.
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Advanced Guide > Printing from a Computer
 Printing from a ComputerPrinting with the Bundled Application SoftwarePrinting with Other Application Software
 Page top
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software
 Printing with the Bundled Application SoftwareWhat Is Easy-PhotoPrint EX?
 Printing PhotosCreating an AlbumPrinting a DVD/CD
 Printing CalendarsPrinting StickersPrinting Layout
 Correcting and Enhancing PhotosQuestions and AnswersAppendix 1: Easy-PhotoPrint EX Settings
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > What Is Easy-PhotoPrintEX?
 What Is Easy-PhotoPrint EX?Easy-PhotoPrint EX allows you to create albums, calendars and stickers easily using photos taken withdigital cameras.You can also print borderless photos easily.
 ImportantEasy-PhotoPrint EX does not support Windows 95, Windows 98, Windows Me, or Windows NT4.Easy-PhotoPrint EX can only be used with Canon inkjet printers. It does not support some printers,including Canon compact printers (SELPHY CP series).If a printer that supports Easy-PhotoPrint EX is not installed, you cannot print items you create.If Easy-PhotoPrint EX is installed on a computer that already has Easy-LayoutPrint installed, Easy-LayoutPrint will be replaced by Easy-PhotoPrint EX.
 Note
 Printing on paper larger than A4 is available with supported printers only. See your printer manualfor details.See Help of Easy-PhotoPrint EX for descriptions of Easy-PhotoPrint EX screens.Click Help in a screen or dialog box, or select Easy-PhotoPrint EX Help from the Help menu. Helpappears.
 About Exif PrintEasy-PhotoPrint EX supports "Exif Print." Exif Print is a standard for enhancing the communicationbetween digital cameras and printers.By connecting to an Exif Print-compliant digital camera, the image data at the time of shooting is usedand optimized, yielding extremely high quality prints.
 Starting Easy-PhotoPrint EX from Other ApplicationsEasy-PhotoPrint EX can be started from other applications.See the application's manual for details on the procedure for starting.The Album function is available with the following applications:
 MP Navigator EX Ver.1.00 or later
 ZoomBrowser EX Ver.5.8 or later
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The Photo Print function is available with the following applications:
 MP Navigator EX Ver.1.00 or later
 ZoomBrowser EX Ver.6.0 or later
 Digital Photo Professional Ver.3.2 or later
 Note
 Easy-PhotoPrint EX is subject to the following restrictions when started from Digital PhotoProfessional:- Menu does not appear in the step button area on the left side of the screen.- Images cannot be corrected/enhanced.- Image display order cannot be changed.- Edited images cannot be saved.- Options other than Enable ICC Profile cannot be selected for Color correction for printing on theAdvanced tab of the Preferences dialog box. Therefore, you cannot use the Vivid Photo and PhotoNoise Reduction functions.
 Supported Image File Formats (Extensions)
 BMP (.bmp)
 JPEG (.jpg, .jpeg)
 TIFF (.tif, .tiff)
 PICT (.pict, .pct)
 Easy-PhotoPrint image files (.epp)
 ImportantWhen selecting an image, if there is a TIFF file in the selected folder, the image may not bedisplayed correctly or Easy-PhotoPrint EX may shut down depending on the TIFF format. In suchcases, move the TIFF file to another folder or recreate the file in a different file format, and thenselect the folder again.
 The thumbnails of files in unsupported formats are displayed as (Question Mark).
 Note
 When Easy-PhotoPrint EX is started from Digital Photo Professional, all image files supported byDigital Photo Professional will be displayed.
 File Formats (Extensions) Supported by Easy-PhotoPrint EX
 Easy-PhotoPrint EX Photo Print file (.el6)
 Easy-PhotoPrint EX Album file (.el1)
 Easy-PhotoPrint EX Stickers file (.el2)
 Easy-PhotoPrint EX Calendar file (.el4)
 Easy-PhotoPrint EX Layout file (.el5)
 CD-LabelPrint data (.cld)
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Photos
 Printing PhotosEasy-PhotoPrint EX allows you to print your favorite photos in a variety of layouts.
 You can also create borderless photos easily.Corrections suitable for photos will be applied automatically when printing.
 Steps
 1. Starting Easy-PhotoPrint EX
 2. Selecting a Photo
 3. Selecting the Paper
 4. Printing
 Try ThisCorrecting and Enhancing PhotosPrinting on a DVD/CD
 Printing Vivid Photos
 Reducing Photo NoiseCropping Photos (Photo Print)Printing Dates on Photos (Photo Print)Printing Multiple Photos on One PagePrinting an Index
 Printing ID Photos (ID Photo Print)
 Printing Photo InformationSaving PhotosOpening Saved Files
 Questions and AnswersHow Can I Move (or Copy) the Saved File?
 Which Side of the Displayed Image Does the Printing Start from?How Do I Print with Even Margins?
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Photos > StartingEasy-PhotoPrint EX
 Starting Easy-PhotoPrint EX
 1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX> Easy-PhotoPrint EX.Easy-PhotoPrint EX starts and Menu appears.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Photos >Selecting a Photo
 Selecting a Photo
 1. Click Photo Print from Menu.The Select Images screen appears.
 ImportantThe reduced images (thumbnails) displayed in the screen may appear as follows:- A black line appears along an edge of the image.- An edge of the image appears cropped.However, such images will be displayed normally when enlarged or previewed, and printresults will not be affected.
 2. Select the folder that contains the image you want to print from the folder tree area.The images in the folder will be displayed as thumbnails (miniatures).
 Note
 If Easy-PhotoPrint EX is started from another application (MP Navigator EX, ZoomBrowser EXor Digital Photo Professional), the folder tree area will not be displayed.The images opened in the application will be displayed as thumbnails.
 3. Click the image you want to print.The number of copies appears as "1" below the clicked image, while the selected image itself willappear in the selected image area.
 Note
 To delete an image in the selected image area, select the image you want to delete and click
 (Delete Imported Image).
 To delete all images from the selected image area, click (Delete All Imported Images).To print two or more copies of an image, click (Up arrow) until the number of copies youwant is reached. To reduce the number of copies shown in the box, click (Down arrow).You can change the order of photos using the list located at the top right corner of the screen.You can select the printing order from Sort by Date and Sort by Name.
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Note
 You can correct or enhance the selected image before printing.Correcting and Enhancing Photos
 See Help for details on the Select Images screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Photos >Selecting the Paper
 Selecting the Paper
 1. Click Select Paper.The Select Paper screen appears.
 2. Set the following items according to the printer and paper to be used:PrinterPaper SourcePaper SizeMedia Type
 Note
 The paper sizes and media types may vary depending on the printer. See Help for details.The paper sources may vary depending on the printer and the media type.
 ImportantWhen Fine Art Photo Rag is selected for Media Type, a 1.38 inch (35 mm) margin is automaticallyleft at the top and bottom of the paper.It is recommended that you check the print range with the image shown in Preview before printing.
 Note
 You can print directly on the DVD/CD surface by selecting CD-R for Paper Size.Printing on a DVD/CD
 You can print photos with more vivid colors or you can reduce the photo noise.Printing Vivid PhotosReducing Photo Noise
 See Help for details on the Select Paper screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Photos > Printing
 Printing
 1. Click Layout/Print.The Layout/Print screen appears.
 ImportantThe reduced images (thumbnails) displayed in the screen may appear as follows:- A black line appears along an edge of the image.- An edge of the image appears cropped.However, such images will be displayed normally when enlarged or previewed, and printresults will not be affected.
 2. Select a layout you want to use.Click a borderless layout to print borderless photos.
 Note
 The layouts that can be selected may vary depending on the printer, paper size, and mediatype.
 3. Click Print.
 ImportantWhen you print on large size paper such as A3/A3+, some computers cannot print properly if youprint more than one page or copy at a time. It is recommended that you print page by page whenyou print on such paper.While printing on paper larger than A4 or printing high-resolution images, data may be printed onlyto the middle if many images are printed at one time. In such cases, select the Spool print job pageby page checkbox in the Preferences dialog box, and then print again.
 To display the Preferences dialog box, click (Settings) or select Preferences... from the Filemenu.When Fine Art Photo Rag is selected for Media Type in the Select Paper screen, a 1.38 inch (35mm) margin is automatically left at the top and bottom of the paper.It is recommended that you check the print range with the image shown in Preview before printing.
 Note
 The photo print settings will be discarded if you exit Easy-PhotoPrint EX without saving the settings.
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It is recommended that you save the printed image if you want to print it again.Saving Photos
 When you print on a bordered layout, the margins on the left and right or the top and bottom maybecome wider than the other.
 How Do I Print with Even Margins?You can crop images or print dates on photos.
 Cropping Photos (Photo Print)Printing Dates on Photos (Photo Print)
 You can correct or enhance the selected image before printing.Correcting and Enhancing Photos
 You can specify advanced Photo Print settings (number of copies, print quality, etc.) in thePreferences dialog box.
 To display the Preferences dialog box, click (Settings) or select Preferences... from the Filemenu.See Help for details on the Layout/Print screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Creating an Album
 Creating an AlbumEasy-PhotoPrint EX allows you to create your own personalized photo album.
 Steps
 1. Starting Easy-PhotoPrint EX
 2. Selecting the Paper and Layout
 3. Selecting a Photo
 4. Editing
 5. Printing
 Try ThisCorrecting and Enhancing PhotosChanging LayoutChanging BackgroundAdding PhotosSwapping Positions of PhotosReplacing PhotosChanging Position, Angle and Size of PhotosCropping PhotosFraming PhotosPrinting Dates on PhotosAttaching Comments to PhotosAdding Text to Photos
 Saving
 Opening Saved Files
 Questions and AnswersHow Can I Move (or Copy) the Saved File?
 What Is "C1" or "C4"?
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Creating an Album >Starting Easy-PhotoPrint EX
 Starting Easy-PhotoPrint EX
 1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX> Easy-PhotoPrint EX.Easy-PhotoPrint EX starts and Menu appears.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Creating an Album >Selecting the Paper and Layout
 Selecting the Paper and Layout
 1. Click Album from Menu.The Page Setup screen appears.
 2. Set the following items in the General Settings section:Paper Size
 OrientationCover
 Double page albumPage number
 Note
 See Help on the paper size that can be selected.You can select whether to display images on the inside of the front and back covers in theCover Options dialog box. To display the Cover Options dialog box, select Front or Front & Backfor Cover and click Options....Select the Double page album checkbox to enable the spread page layout (consisting of two-page master). In a double-page album, you can arrange an image across the left and rightpages.You can customize the page numbers (position, font size, etc.) in the Page Number Settingsdialog box. To display the Page Number Settings dialog box, select the Page number checkboxand click Settings....You can customize the margins of the front cover, inside pages and back cover in the MarginSettings dialog box. To display the Margin Settings dialog box, click Margins....
 3. Select the theme you want to use from Theme in Sample Layout.
 4. If you want to change the layout, click Layout....The Change Layout dialog box appears.In the Change Layout dialog box, you can change the layout or select whether to print the date (onwhich the picture was taken) on the photo.
 Note
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The album layouts that can be selected may vary depending on the Paper Size, Orientation,Double page album, or the type of page selected (front cover, inside pages or back cover).You can customize the date (position, size and color) in the Date Settings dialog box. Todisplay the Date Settings dialog box, select the Print date checkbox in the Change Layoutdialog box and click Date Settings....
 5. If you want to change the background, click Background....The Change Background dialog box appears.In the Change Background dialog box, you can paint the background in a single color or paste animage file to it.
 Note
 See Help for details on the Page Setup screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Creating an Album >Selecting a Photo
 Selecting a Photo
 1. Click Select Images.The Select Images screen appears.
 2. Select the folder that contains the image you want to print from the folder tree area.The images in the folder will be displayed as thumbnails (miniatures).
 Note
 If Easy-PhotoPrint EX is started from another application (MP Navigator EX or ZoomBrowserEX), the folder tree area will not be displayed.The images opened in MP Navigator EX or ZoomBrowser EX will be displayed as thumbnails.
 3. Select the image(s) you want to print, and click one of the buttons below.
 To print on the front cover, click (Import to Front Cover).
 To print on the inside pages, click (Import to Inside Pages).
 To print on the back cover, click (Import to Back Cover).
 The selected images are displayed in the selected image area.You can also select the image(s) you want to print by dragging them into the selected image area.
 Note
 To delete an image in the selected image area, select the image you want to delete and click
 (Delete Imported Image).
 To delete all images from the selected image area, click (Delete All Imported Images).
 Note
 See Help for details on the Select Images screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Creating an Album >Editing
 Editing
 1. Click Edit.The Edit screen appears.
 2. Edit your album if necessary.Changing LayoutChanging BackgroundAdding PhotosSwapping Positions of PhotosReplacing PhotosChanging Position, Angle and Size of PhotosCropping PhotosFraming PhotosPrinting Dates on PhotosAttaching Comments to PhotosAdding Text to Photos
 Note
 The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the editedalbum. It is recommended that you save the item if you want to edit it again.The page numbers on the front and back covers of the album are displayed as follows:
 C1: Front cover
 C2: Inside the front cover
 C3: Inside the back cover
 C4: Back cover
 SavingSee Help for details on the Edit screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Creating an Album >Printing
 Printing
 1. Click Print Settings.The Print Settings screen appears.
 2. Set the following items according to the printer and paper to be used:PrinterMedia Type
 CopiesPaper SourcePrint Quality
 Borderless Printing
 Note
 The media types may vary depending on the printer and the paper size.Duplex Printing appears if the selected printer and media type support duplex printing. Selectthis checkbox to print on both sides of the paper.Automatic appears if you select the Duplex Printing checkbox after selecting a printer thatsupports automatic duplex printing and media type that supports duplex printing. Select thischeckbox to print on both sides of the paper automatically.The paper sources may vary depending on the printer and the media type.You can set a custom print quality level in the Print Quality Settings dialog box. To display thePrint Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....Select the Borderless Printing checkbox to print borderless photos.You can specify the print range and the amount of extension for borderless printing in the PrintSettings dialog box. To display the Print Settings dialog box, click Advanced....
 3. Click Print.
 Note
 See Help for details on the Print Settings screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing a DVD/CD
 Printing a DVD/CDSelect DVD/CD Label in Menu to start CD-LabelPrint. CD-LabelPrint allows you to print DVD/CD labelseasily.For details on how to use CD-LabelPrint, install CD-LabelPrint and refer to the application's manual asfollows. From the Start menu, select (All) Programs > CD-LabelPrint > Manual.
 ImportantDVD/CD Label is not displayed in Menu if CD-LabelPrint is not installed on your computer.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars
 Printing CalendarsEasy-PhotoPrint EX allows you to create your own calendar using your favorite photos.
 Steps
 1. Starting Easy-PhotoPrint EX
 2. Selecting the Paper and Layout
 3. Selecting a Photo
 4. Editing
 5. Printing
 Try ThisCorrecting and Enhancing PhotosChanging LayoutChanging BackgroundAdding PhotosSwapping Positions of PhotosReplacing PhotosChanging Position, Angle and Size of PhotosCropping PhotosFraming PhotosPrinting Dates on PhotosAdding Text to Photos
 Setting Calendar DisplaySetting HolidaysSaving
 Opening Saved Files
 Questions and AnswersHow Can I Move (or Copy) the Saved File?
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars >Starting Easy-PhotoPrint EX
 Starting Easy-PhotoPrint EX
 1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX> Easy-PhotoPrint EX.Easy-PhotoPrint EX starts and Menu appears.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars >Selecting the Paper and Layout
 Selecting the Paper and Layout
 1. Click Calendar from Menu.The Page Setup screen appears.
 2. Set the following items in the General Settings section:Paper Size
 OrientationStart from
 Period
 Note
 See Help on the paper size that can be selected.You can add holidays to your calendar.
 Setting Holidays
 3. Select a layout.If necessary, make advanced settings on the calendar and set the background.
 Note
 You can customize the calendar display (font colors of the dates and days of the week, positionand size of the calendar, etc.).
 Setting Calendar DisplayYou can paint the background in a single color or paste an image file to it in the ChangeBackground dialog box. To display the Change Background dialog box, click Background....
 Note
 See Help for details on the Page Setup screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars >Selecting a Photo
 Selecting a Photo
 1. Click Select Images.The Select Images screen appears.
 2. Select the folder that contains the image you want to print from the folder tree area.The images in the folder will be displayed as thumbnails (miniatures).
 3. Select the image(s) you want to print and click (Import to Inside Pages).The selected images are displayed in the selected image area.You can also select the image(s) you want to print by dragging them into the selected image area.
 Note
 To delete an image in the selected image area, select the image you want to delete and click
 (Delete Imported Image).
 To delete all images from the selected image area, click (Delete All Imported Images).
 Note
 See Help for details on the Select Images screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars >Editing
 Editing
 1. Click Edit.The Edit screen appears.
 2. Edit the calendar if necessary.Changing LayoutChanging BackgroundAdding PhotosSwapping Positions of PhotosReplacing PhotosChanging Position, Angle and Size of PhotosCropping PhotosFraming PhotosPrinting Dates on PhotosAdding Text to Photos
 Setting Calendar DisplaySetting Holidays
 Note
 The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the editedcalendar. It is recommended that you save the item if you want to edit it again.
 SavingSee Help for details on the Edit screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Calendars >Printing
 Printing
 1. Click Print Settings.The Print Settings screen appears.
 2. Set the following items according to the printer and paper to be used:PrinterMedia Type
 CopiesPaper SourcePrint Quality
 Borderless Printing
 Note
 The media types may vary depending on the printer and the paper size.Duplex Printing appears if the selected printer and media type support duplex printing. Selectthis checkbox to print on both sides of the paper.Automatic appears if you select the Duplex Printing checkbox after selecting a printer thatsupports automatic duplex printing and media type that supports duplex printing. Select thischeckbox to print on both sides of the paper automatically.The paper sources may vary depending on the printer and the media type.You can set a custom print quality level in the Print Quality Settings dialog box. To display thePrint Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....You can specify the print range and the amount of extension for borderless printing in the PrintSettings dialog box. To display the Print Settings dialog box, click Advanced....
 3. Click Print.
 Note
 See Help for details on the Print Settings screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers
 Printing StickersYou can print your favorite photos on compatible sticker sheets.
 Steps
 1. Starting Easy-PhotoPrint EX
 2. Selecting the Paper and Layout
 3. Selecting a Photo
 4. Editing
 5. Printing
 Try ThisCorrecting and Enhancing PhotosAdding PhotosSwapping Positions of PhotosReplacing PhotosChanging Position, Angle and Size of PhotosCropping PhotosFraming PhotosAdding Text to Photos
 Saving
 Opening Saved Files
 Questions and AnswersHow Can I Move (or Copy) the Saved File?
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers >Starting Easy-PhotoPrint EX
 Starting Easy-PhotoPrint EX
 1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX> Easy-PhotoPrint EX.Easy-PhotoPrint EX starts and Menu appears.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers >Selecting the Paper and Layout
 Selecting the Paper and Layout
 1. Click Stickers from Menu.The Page Setup screen appears.
 2. Set the following items in the General Settings section:Paper Size
 OrientationPrint date
 Use the same image in all frames
 Note
 Paper sizes other than Photo Stickers cannot be selected.Select the Use the same image in all frames checkbox to use the same image in all theframes on the page.You can customize the date (position, size and color) in the Date Settings dialog box. Todisplay the Date Settings dialog box, select the Print date checkbox and click Date Settings....
 Note
 See Help for details on the Page Setup screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers >Selecting a Photo
 Selecting a Photo
 1. Click Select Images.The Select Images screen appears.
 2. Select the folder that contains the image you want to print from the folder tree area.The images in the folder will be displayed as thumbnails (miniatures).
 3. Select the image(s) you want to print and click (Import to Inside Pages).The selected images are displayed in the selected image area.You can also select the image(s) you want to print by dragging them into the selected image area.
 Note
 To delete an image in the selected image area, select the image you want to delete and click
 (Delete Imported Image).
 To delete all images from the selected image area, click (Delete All Imported Images).
 Note
 See Help for details on the Select Images screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers > Editing
 Editing
 1. Click Edit.The Edit screen appears.
 2. Edit the stickers if necessary.Adding PhotosSwapping Positions of PhotosReplacing PhotosChanging Position, Angle and Size of PhotosCropping PhotosPrinting Dates on PhotosAdding Text to Photos
 Note
 The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the editedstickers. It is recommended that you save the item if you want to edit it again.
 SavingSee Help for details on the Edit screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Stickers >Printing
 Printing
 1. Click Print Settings.The Print Settings screen appears.
 2. Set the following items according to the printer and paper to be used:PrinterMedia Type
 CopiesPaper SourcePrint Quality
 Borderless Printing
 Note
 The media types may vary depending on the printer and the paper size.The paper sources may vary depending on the printer and the media type.You can set a custom print quality level in the Print Quality Settings dialog box. To display thePrint Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....You can adjust the printing position in the Adjust Print Position dialog box. To display the AdjustPrint Position dialog box, click Print Position....You can specify the print range and the amount of extension for borderless printing in the PrintSettings dialog box. To display the Print Settings dialog box, click Advanced....
 3. Click Print.
 Note
 See Help for details on the Print Settings screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout
 Printing LayoutYou can add text to your favorite photos and print them in a variety of layouts.
 Steps
 1. Starting Easy-PhotoPrint EX
 2. Selecting the Paper and Layout
 3. Selecting a Photo
 4. Editing
 5. Printing
 Try ThisCorrecting and Enhancing PhotosChanging LayoutAdding PhotosSwapping Positions of PhotosReplacing PhotosChanging Position, Angle and Size of PhotosCropping PhotosPrinting Dates on PhotosAdding Text to Photos
 Saving
 Opening Saved Files
 Questions and AnswersHow Can I Move (or Copy) the Saved File?
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout > StartingEasy-PhotoPrint EX
 Starting Easy-PhotoPrint EX
 1. From the Start menu, select (All) Programs > Canon Utilities > Easy-PhotoPrint EX> Easy-PhotoPrint EX.Easy-PhotoPrint EX starts and Menu appears.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout >Selecting the Paper and Layout
 Selecting the Paper and Layout
 1. Click Layout Print from Menu.The Page Setup screen appears.
 2. Set the following items in the General Settings section:Paper Size
 OrientationPrint date
 Note
 See Help on the paper size that can be selected.You can customize the date (position, size and color) in the Date Settings dialog box. Todisplay the Date Settings dialog box, select the Print date checkbox and click Date Settings....
 3. Select a layout from Layouts.
 Note
 The layouts displayed may vary depending on the Orientation.
 Note
 See Help for details on the Page Setup screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout >Selecting a Photo
 Selecting a Photo
 1. Click Select Images.The Select Images screen appears.
 2. Select the folder that contains the image you want to print from the folder tree area.The images in the folder will be displayed as thumbnails (miniatures).
 3. Select the image(s) you want to print and click (Import to Inside Pages).The selected images are displayed in the selected image area.You can also select the image(s) you want to print by dragging them into the selected image area.
 Note
 To delete an image in the selected image area, select the image you want to delete and click
 (Delete Imported Image).
 To delete all images from the selected image area, click (Delete All Imported Images).
 Note
 See Help for details on the Select Images screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout > Editing
 Editing
 1. Click Edit.The Edit screen appears.
 2. Edit the layout if necessary.Changing LayoutAdding PhotosSwapping Positions of PhotosReplacing PhotosChanging Position, Angle and Size of PhotosCropping PhotosPrinting Dates on PhotosAdding Text to Photos
 Note
 The edit information will be discarded if you exit Easy-PhotoPrint EX without saving the edited layout.It is recommended that you save the item if you want to edit it again.
 SavingSee Help for details on the Edit screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Printing Layout > Printing
 Printing
 1. Click Print Settings.The Print Settings screen appears.
 2. Set the following items according to the printer and paper to be used:PrinterMedia Type
 CopiesPaper SourcePrint Quality
 Borderless Printing
 Note
 The media types may vary depending on the printer and the paper size.Duplex Printing appears if the selected printer and media type support duplex printing. Selectthis checkbox to print on both sides of the paper.Automatic appears if you select the Duplex Printing checkbox after selecting a printer thatsupports automatic duplex printing and media type that supports duplex printing. Select thischeckbox to print on both sides of the paper automatically.The paper sources may vary depending on the printer and the media type.You can set a custom print quality level in the Print Quality Settings dialog box. To display thePrint Quality Settings dialog box, select Custom for Print Quality and click Quality Settings....Select the Borderless Printing checkbox to print borderless photos.You can specify the print range and the amount of extension for borderless printing in the PrintSettings dialog box. To display the Print Settings dialog box, click Advanced....
 3. Click Print.
 Note
 See Help for details on the Print Settings screen.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting andEnhancing Photos
 Correcting and Enhancing PhotosYou can correct and enhance images.
 Click (Correct/Enhance Images) in the Select Images or Edit screen, or in the Layout/Print screen ofPhoto Print. You can make the following corrections and enhancements in the Correct/Enhance Imageswindow.
 ImportantFor Photo Print, if you select Enable ICC Profile in the Advanced tab of the Preferences dialog box,you cannot correct/enhance images.
 Note
 See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.
 Auto Photo FixThis function will automatically analyze the captured scene and apply suitable corrections.
 Using the Auto Photo Fix Function
 Red-Eye Correction FunctionYou can correct red eyes caused by a camera flash.
 Using the Red-Eye Correction Function
 Face Brightener FunctionYou can brighten dark faces caused by bright background.
 Using the Face Brightener Function
 Face Sharpener FunctionYou can sharpen out-of-focus faces in a photo.
 Using the Face Sharpener Function
 Digital Face Smoothing FunctionYou can enhance skin beautifully by removing blemishes and wrinkles.
 Using the Digital Face Smoothing Function
 Blemish Remover FunctionYou can remove moles.
 Using the Blemish Remover Function
 Image AdjustmentYou can make fine adjustments to the overall brightness, contrast, etc. of images.
 Adjusting Images
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting andEnhancing Photos > Using the Auto Photo Fix Function
 Using the Auto Photo Fix FunctionApply optimum corrections automatically to the photos used for an album or calendar.
 ImportantThe Auto Photo Fix function is not available for Photo Print. Photo Print allows you to automaticallyapply suitable corrections to all photos when printing. Select this option in Image on the Advanced
 tab of the Preferences dialog box. To display the Preferences dialog box, click (Settings) in theLayout/Print screen or select Preferences... from the File menu.Once image is corrected with Auto Photo Fix and saved, it cannot be corrected again with AutoPhoto Fix.Also, Auto Photo Fix may not be available for images edited using an application, digital camera,etc. manufactured by other companies.
 1. Select photos in the Select Images screen, then click (Correct/EnhanceImages).The Correct/Enhance Images window appears.
 Note
 You can also display the Correct/Enhance Images window by clicking (Correct/EnhanceImages) in the Layout/Print or Edit screen. In that case, only the image displayed in Previewcan be corrected/enhanced.See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.
 2. Select the image you want to correct from the list displayed in the lower part of theCorrect/Enhance Images window.The image appears in Preview.
 Note
 If only one image is selected, the thumbnail does not appear below Preview.
 3. Make sure that Auto is selected.
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4. Click Auto Photo Fix, then click OK.
 The entire photo is corrected automatically and the (Correction/Enhancement) mark appears onthe upper left of the image.
 Note
 Click (Compare) to display the images before and after the correction side by side so thatyou can compare and check the result.Click Reset Selected Image to undo the correction operation.If you want to apply the correction to all the selected images at once, select the Apply to allimages checkbox.
 5. Click Save Selected Image or Save All Corrected Images.You can save corrected images as new files.
 Note
 To save only the image you like, click Save Selected Image. To save all images, click Save AllCorrected Images.Only JPEG/Exif file format is available for corrected images.
 6. Click Exit.
 Note
 The corrections will be lost if you exit before saving corrected images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting andEnhancing Photos > Using the Red-Eye Correction Function
 Using the Red-Eye Correction FunctionYou can correct red eyes caused by a camera flash.
 You can perform the Red-Eye Correction function either automatically or manually.
 Note
 Photo Print allows you to automatically correct red eyes when printing. To correct automatically,select Enable Auto Photo Fix in Color correction for printing on the Advanced tab of the Preferencesdialog box and select the Enable Red-Eye Correction checkbox.
 1. Select photos in the Select Images screen, then click (Correct/EnhanceImages).The Correct/Enhance Images window appears.
 Note
 You can also display the Correct/Enhance Images window by clicking (Correct/EnhanceImages) in the Layout/Print or Edit screen. In that case, only the image displayed in Previewcan be corrected/enhanced.See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.
 2. Select the image you want to correct from the list displayed in the lower part of theCorrect/Enhance Images window.The image appears in Preview.
 Note
 If only one image is selected, the thumbnail does not appear below Preview.
 Auto Correction
 3. Make sure that Auto is selected.
 4. Click Red-Eye Correction.
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5. Click OK.
 Red eyes are corrected and the (Correction/Enhancement) mark appears on the upper left ofthe image.
 ImportantAreas other than the eyes may be corrected depending on the image.
 Note
 Click (Compare) to display the images before and after the correction side by side so thatyou can compare and check the result.Click Reset Selected Image to undo the correction operation.If you want to apply the correction to all the selected images at once, select the Apply to allimages checkbox.
 Manual Correction
 3. Click Manual, then click Correct/Enhance.
 4. Click Red-Eye Correction.Move the cursor over the image. The shape of the cursor changes to (Paintbrush).
 5. Drag to select the red area you want to correct, then click OK that appears over theimage.
 Red eye is corrected and the (Correction/Enhancement) mark appears on the upper left of theimage.
 Note
 Click Undo to undo the preceding correction operation.Effect levels can be changed using the slider below Red-Eye Correction.
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6. Click Save Selected Image or Save All Corrected Images.You can save corrected images as new files.
 Note
 To save only the image you like, click Save Selected Image. To save all images, click Save AllCorrected Images.Only JPEG/Exif file format is available for corrected images.
 7. Click Exit.
 Note
 The corrections will be lost if you exit before saving corrected images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting andEnhancing Photos > Using the Face Brightener Function
 Using the Face Brightener FunctionYou can brighten dark faces caused by bright background.
 1. Select photos in the Select Images screen, then click (Correct/EnhanceImages).The Correct/Enhance Images window appears.
 Note
 You can also display the Correct/Enhance Images window by clicking (Correct/EnhanceImages) in the Layout/Print or Edit screen. In that case, only the image displayed in Previewcan be corrected/enhanced.See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.
 2. Select the image you want to correct from the list displayed in the lower part of theCorrect/Enhance Images window.The image appears in Preview.
 Note
 If only one image is selected, the thumbnail does not appear below Preview.
 3. Click Manual, then click Correct/Enhance.
 4. Click Face Brightener.
 Move the cursor over the image. The shape of the cursor changes to (Cross).
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5. Drag to select the area you want to correct, then click OK that appears over theimage.
 The entire image is corrected so that the selected area containing the face becomes brighter, andthe (Correction/Enhancement) mark appears on the upper left of the image.
 Note
 You can also drag to rotate the rectangle.Click Undo to undo the preceding correction operation.Effect levels can be changed using the slider below Face Brightener.
 6. Click Save Selected Image or Save All Corrected Images.You can save corrected images as new files.
 Note
 To save only the image you like, click Save Selected Image. To save all images, click Save AllCorrected Images.Only JPEG/Exif file format is available for corrected images.
 7. Click Exit.
 Note
 The corrections will be lost if you exit before saving corrected images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting andEnhancing Photos > Using the Face Sharpener Function
 Using the Face Sharpener FunctionYou can sharpen out-of-focus faces in a photo.You can perform the Face Sharpener function either automatically or manually.
 1. Select photos in the Select Images screen, then click (Correct/EnhanceImages).The Correct/Enhance Images window appears.
 Note
 You can also display the Correct/Enhance Images window by clicking (Correct/EnhanceImages) in the Layout/Print or Edit screen. In that case, only the image displayed in Previewcan be corrected/enhanced.See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.
 2. Select the image you want to correct from the list displayed in the lower part of theCorrect/Enhance Images window.The image appears in Preview.
 Note
 If only one image is selected, the thumbnail does not appear below Preview.
 Auto Correction
 3. Make sure that Auto is selected.
 4. Click Face Sharpener.
 5. Click OK.
 The face is sharpened and the (Correction/Enhancement) mark appears on the upper left of theimage.
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Note
 Effect levels can be changed using the slider below Face Sharpener.Click (Compare) to display the images before and after the correction side by side so thatyou can compare and check the result.Click Reset Selected Image to undo the correction operation.If you want to apply the correction to all the selected images at once, select the Apply to allimages checkbox.
 Manual Correction
 3. Click Manual, then click Correct/Enhance.
 4. Click Face Sharpener.
 Move the cursor over the image. The shape of the cursor changes to (Cross).
 5. Drag to select the area you want to correct, then click OK that appears over theimage.
 The facial area in and around the selected area is sharpened and the (Correction/Enhancement) mark appears on the upper left of the image.
 Note
 You can also drag to rotate the rectangle.Click Undo to undo the preceding correction operation.Effect levels can be changed using the slider below Face Sharpener.
 6. Click Save Selected Image or Save All Corrected Images.You can save corrected images as new files.
 Note
 To save only the image you like, click Save Selected Image. To save all images, click Save AllCorrected Images.
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Only JPEG/Exif file format is available for corrected images.
 7. Click Exit.
 Note
 The corrections will be lost if you exit before saving corrected images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting andEnhancing Photos > Using the Digital Face Smoothing Function
 Using the Digital Face Smoothing FunctionYou can enhance skin beautifully by removing blemishes and wrinkles.You can perform the Digital Face Smoothing function either automatically or manually.
 1. Select photos in the Select Images screen, then click (Correct/EnhanceImages).The Correct/Enhance Images window appears.
 Note
 You can also display the Correct/Enhance Images window by clicking (Correct/EnhanceImages) in the Layout/Print or Edit screen. In that case, only the image displayed in Previewcan be corrected/enhanced.See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.
 2. Select the image you want to enhance from the list displayed in the lower part of theCorrect/Enhance Images window.The image appears in Preview.
 Note
 If only one image is selected, the thumbnail does not appear below Preview.
 Auto Enhancement
 3. Make sure that Auto is selected.
 4. Click Digital Face Smoothing.
 5. Click OK.
 Skin is enhanced beautifully and the (Correction/Enhancement) mark appears on the upper leftof the image.
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Note
 Effect levels can be changed using the slider below Digital Face Smoothing.Click (Compare) to display the images before and after the enhancement side by side sothat you can compare and check the result.Click Reset Selected Image to undo the enhancement operation.If you want to apply the enhancement to all the selected images at once, select the Apply to allimages checkbox.
 Manual Enhancement
 3. Click Manual, then click Correct/Enhance.
 4. Click Digital Face Smoothing.
 Move the cursor over the image. The shape of the cursor changes to (Cross).
 5. Drag to select the area you want to enhance, then click OK that appears over theimage.
 Skin in and around the selected area is enhanced beautifully and the (Correction/Enhancement)mark appears on the upper left of the image.
 Note
 You can also drag to rotate the rectangle.Click Undo to undo the preceding enhancement operation.Effect levels can be changed using the slider below Digital Face Smoothing.
 6. Click Save Selected Image or Save All Corrected Images.You can save enhanced images as new files.
 Note
 To save only the image you like, click Save Selected Image. To save all images, click Save AllCorrected Images.
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Only JPEG/Exif file format is available for enhanced images.
 7. Click Exit.
 Note
 The enhancements will be lost if you exit before saving enhanced images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting andEnhancing Photos > Using the Blemish Remover Function
 Using the Blemish Remover FunctionYou can remove moles.
 1. Select photos in the Select Images screen, then click (Correct/EnhanceImages).The Correct/Enhance Images window appears.
 Note
 You can also display the Correct/Enhance Images window by clicking (Correct/EnhanceImages) in the Layout/Print or Edit screen. In that case, only the image displayed in Previewcan be corrected/enhanced.See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.
 2. Select the image you want to enhance from the list displayed in the lower part of theCorrect/Enhance Images window.The image appears in Preview.
 Note
 If only one image is selected, the thumbnail does not appear below Preview.
 3. Click Manual, then click Correct/Enhance.
 4. Click Blemish Remover.Move the cursor over the image. The shape of the cursor changes to (Cross).
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5. Drag to select the area you want to enhance, then click OK that appears over theimage.
 Moles in and around the selected area are removed and the (Correction/Enhancement) markappears on the upper left of the image.
 Note
 Click Undo to undo the preceding enhancement operation.
 6. Click Save Selected Image or Save All Corrected Images.You can save enhanced images as new files.
 Note
 To save only the image you like, click Save Selected Image. To save all images, click Save AllCorrected Images.Only JPEG/Exif file format is available for enhanced images.
 7. Click Exit.
 Note
 The enhancements will be lost if you exit before saving enhanced images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting andEnhancing Photos > Adjusting Images
 Adjusting ImagesYou can make fine adjustments to the overall brightness, contrast, etc. of images.
 1. Select photos in the Select Images screen, then click (Correct/EnhanceImages).The Correct/Enhance Images window appears.
 Note
 You can also display the Correct/Enhance Images window by clicking (Correct/EnhanceImages) in the Layout/Print or Edit screen. In that case, only the image displayed in Previewcan be corrected/enhanced.See "Correct/Enhance Images Window" for details on the Correct/Enhance Images window.
 2. Select the image you want to adjust from the list displayed in the lower part of theCorrect/Enhance Images window.The image appears in Preview.
 Note
 If only one image is selected, the thumbnail does not appear below Preview.
 3. Click Manual, then click Adjust.
 4. Move the slider of the item you want to adjust and set the effect level.The following adjustments are available:BrightnessContrastSharpnessBlurShow-through Removal
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Note
 Click Defaults to reset all adjustments.
 5. Click Save Selected Image or Save All Corrected Images.You can save adjusted images as new files.
 Note
 To save only the image you like, click Save Selected Image. To save all images, click Save AllCorrected Images.Only JPEG/Exif file format is available for adjusted images.
 6. Click Exit.
 Note
 The adjustments will be lost if you exit before saving adjusted images.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Correcting andEnhancing Photos > Correct/Enhance Images Window
 Correct/Enhance Images WindowYou can correct/enhance images in this window.
 To display the Correct/Enhance Images window, click (Correct/Enhance Images) in the SelectImages or Edit screen, or in the Layout/Print screen of Photo Print.
 (1)Toolbar
 Toolbar
 (Zoom In/Zoom Out)
 Displays the enlarged or reduced preview of the page.
 (Full Screen)
 Displays the entire image in Preview.
 (Compare)Displays the Compare Images window. You can compare the images before and after the correctionside by side.The image before the correction/enhancement is displayed on the left, and the image after thecorrection/enhancement is displayed on the right.
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(2)Task AreaAvailable tasks and settings may vary between the Auto and Manual tabs.
 Click Auto or Manual to display the corresponding tab.
 Auto Tab
 Select to correct automatically.
 Auto Photo Fix
 Applies automatic corrections suitable for photos.
 ImportantThe Auto Photo Fix function is not available for Photo Print. Photo Print allows you toautomatically apply suitable corrections to all photos when printing. Select this option in Imageon the Advanced tab of the Preferences dialog box. To display the Preferences dialog box, click
 (Settings) in the Layout/Print screen or select Preferences... from the File menu.
 Red-Eye Correction
 Corrects red eyes.
 Note
 For Photo Print, you can also correct red eyes by selecting Enable Auto Photo Fix in Colorcorrection for printing on the Advanced tab of the Preferences dialog box and selecting theEnable Red-Eye Correction checkbox.
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Face SharpenerSharpens out-of-focus faces.You can adjust the effect level using the slider.
 Digital Face Smoothing
 Enhances skin beautifully by removing blemishes and wrinkles.You can adjust the effect level using the slider.
 Apply to all images
 Automatically corrects all the images displayed in the list.OK
 Applies the selected effect to the selected image or all images.Reset Selected Image
 Cancels all corrections and enhancements applied to the selected image.Save Selected Image
 Saves the selected image.Save All Corrected Images
 Saves all the images displayed in the list.Exit
 Click to close the Correct/Enhance Images window.
 Manual Tab
 Select to correct manually.
 Use Adjust to adjust brightness and contrast, or to sharpen the entire image.Use Correct/Enhance to correct/enhance specific areas.
 Adjust
 BrightnessAdjusts the overall image brightness.Move the slider to the left to darken and right to brighten the image.
 ContrastAdjusts the contrast of the image. Adjust the contrast when the image is flat due to lack of contrast.Move the slider to the left to decrease and right to increase the contrast of the image.
 SharpnessEmphasizes the outline of the subjects to sharpen the image. Adjust the sharpness when the photois out of focus or text is blurred.Move the slider to the right to sharpen the image.
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Blur
 Blurs the outline of the subjects to soften the image.Move the slider to the right to soften the image.
 Show-through Removal
 Removes show-through of text from the reverse side or removes the base color. Adjust the show-through level to prevent text on the reverse side of thin document or the base color of the documentfrom appearing on the image.Move the slider to the right to increase the show-through removal effect.
 DefaultsResets all adjustments (brightness, contrast, sharpness, blur, and show-through removal).
 Reset Selected ImageCancels all adjustments applied to the selected image.
 Save Selected ImageSaves the selected image.
 Save All Corrected ImagesSaves all the images displayed in the list.
 Exit
 Click to close the Correct/Enhance Images window.
 Correct/Enhance
 Red-Eye Correction
 Corrects red eyes.You can specify the area you want to apply the effect to. You can adjust the effect level using theslider.
 Note
 For Photo Print, red eyes are automatically corrected when Enable Auto Photo Fix is selected inColor correction for printing on the Advanced tab of the Preferences dialog box and the EnableRed-Eye Correction checkbox is selected. To disable the automatic correction, deselect thecheckbox.
 Face BrightenerCorrects the entire image so that the selected facial area is brightened.You can adjust the effect level using the slider.
 Face SharpenerSharpens out-of-focus faces.You can specify the area you want to apply the effect to. You can adjust the effect level using theslider.
 Стр. 154 из 396 стр.Correct/Enhance Images Window

Page 155
                        

Digital Face Smoothing
 Enhances skin beautifully by removing blemishes and wrinkles.You can specify the area you want to apply the effect to. You can adjust the effect level using theslider.
 Blemish Remover
 Removes moles.You can specify the area you want to apply the effect to.
 Undo
 Cancels the latest correction/enhancement.OK
 Applies the selected effect to the specified area.Reset Selected Image
 Cancels all corrections and enhancements applied to the selected image.Save Selected Image
 Saves the selected image.Save All Corrected Images
 Saves all the images displayed in the list.Exit
 Click to close the Correct/Enhance Images window.
 Page top
 Стр. 155 из 396 стр.Correct/Enhance Images Window

Page 156
                        

Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Questions and Answers
 Questions and AnswersHow Can I Move (or Copy) the Saved File?
 Which Side of the Displayed Image Does the Printing Start from?How Do I Print with Even Margins?What Is "C1" or "C4"?
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Questions and Answers> How Can I Move (or Copy) the Saved File?
 How Can I Move (or Copy) the Saved File?If you want to move (or copy) a file created and saved with Easy-PhotoPrint EX from one folder to another,you need to move (or copy) the folder that was automatically created when originally saving that file aswell.For example, when you save a file named "MyAlbum.el1," a folder named "MyAlbum.el1.Data" isautomatically created in the same folder that contains the "MyAlbum.el1" file. If you want to move (or copy)the "MyAlbum.el1" file to another folder, move (or copy) the "MyAlbum.el1.Data" folder as well.
 The "MyAlbum.el1.Data" folder contains the photos used in the album.
 Note
 The icons may vary depending on the items.
 ImportantDo not change the Data folder name; otherwise you will not be able to display the photos you editedwith Easy-PhotoPrint EX.
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 Which Side of the Displayed Image Does the Printing Startfrom?As shown below, printing starts from the left side of the image displayed in the Layout/Print screen.
 Outputs the paper in the direction as the arrow indicates.See your printer manual for details on how to load paper (to print on the front/back, etc.).
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 How Do I Print with Even Margins?When you print on a bordered layout, the margins on the left and right or the top and bottom may becomewider than the other, depending on the image and printer.
 To always print with even margins, select the Always crop images when selecting a layout with marginscheckbox on the Advanced tab of the Preferences dialog box.
 To display the Preferences dialog box, click (Settings) in the Layout/Print screen or selectPreferences... from the File menu.Crop the photo to apply even margins individually.
 Cropping Photos (Photo Print)
 Note
 The following setting is available for Photo Print only.
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 What Is "C1" or "C4"?When an album is printed, labels such as "C1" and "C4" are printed as page numbers.The "C1" and "C4" represent the front cover and back cover, respectively.
 C1: Front cover
 C2: Inside the front cover
 C3: Inside the back cover
 C4: Back cover
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 Appendix 1: Easy-PhotoPrint EX SettingsPrinting on a DVD/CD
 Printing Vivid Photos
 Reducing Photo NoiseCropping Photos (Photo Print)Printing Dates on Photos (Photo Print)Printing Multiple Photos on One PagePrinting an IndexPrinting ID Photos (ID Photo Print)
 Printing Photo InformationSaving PhotosOpening Saved FilesChanging LayoutChanging BackgroundAdding PhotosSwapping Positions of PhotosReplacing PhotosChanging Position, Angle and Size of PhotosCropping PhotosFraming PhotosPrinting Dates on PhotosAttaching Comments to PhotosAdding Text to Photos
 Saving
 Setting HolidaysSetting Calendar Display
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 Printing on a DVD/CDYou can print on a DVD/CD using Photo Print.
 Select CD-R for Paper Size in the Select Paper screen, then select a layout and enter the title.
 If you want to edit the details, return to Menu and select DVD/CD Label and edit/print using CD-LabelPrint.
 Follow the steps for other items to complete image selection in the Select Images screen.Selecting a Photo
 1. Select CD-R for Paper Size in the Select Paper screen.Set the Printer and Media Type according to the printer and DVD/CD to be used.
 Note
 When CD-R is selected, only Disc tray will be selectable for Paper Source.
 2. Click Layout/Print.The Layout/Print screen appears.
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3. Select a layout you want to use.
 4. Enter the title(s) and specify the details of the layout in Advanced.
 Note
 Items that can be set may vary depending on the selected layout.
 5. Click Print.Set a DVD/CD and print according to the message.Printing starts from the top of the image displayed in Preview.
 ImportantDo not install a CD-R tray until the message prompting you to set a DVD/CD appears.
 Note
 You can adjust the printing position on the DVD/CD in the Adjust dialog box. To display the Adjust
 dialog box, click (Adjust Print Area/Print Position).You can specify advanced Photo Print settings (number of copies, print quality, etc.) in the
 Preferences dialog box. To display the Preferences dialog box, click (Settings) or selectPreferences... from the File menu.
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 Printing Vivid PhotosSelect the Vivid Photo checkbox in the Select Paper screen to boost the colors in a photo before printing.
 ImportantThis function is available only with a printer that supports Vivid Photo.This function is not available when Enable ICC Profile is selected on the Advanced tab of thePreferences dialog box.
 Note
 Even if you select the Vivid Photo checkbox, this effect applies only to the print result. The originalimage or preview image will not be affected.
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 Reducing Photo NoiseWhen a photo is taken in a dark location such as night scene using digital camera, noise may appear inthe image.
 Select the Photo Noise Reduction checkbox in the Select Paper screen to reduce noise in the image andmake the printed photos more vivid.
 ImportantThis function is not available when Enable ICC Profile is selected on the Advanced tab of thePreferences dialog box.
 Note
 When the noise is severe, change Normal to Strong.The noise reduction effect applies only to the print result. The original image or preview image willnot be affected.
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 Cropping Photos (Photo Print)Cropping a photo is the act of removing the unnecessary portions of the photo by selecting thenecessary portions.
 Click (Crop Image) in the Layout/Print screen.Move the white frame to the portion to print and click OK.
 Note
 To move the cropping area, place the cursor within the white frame and drag it. Drag the white linesto enlarge/reduce the cropping area.Select the The Rule of Thirds checkbox to display white broken lines. To create a balancedcomposition, drag any of the intersecting points (white squares) or white broken lines over the mainsubject of the photo.
 The cropping effect applies only to the print result. The original image will not be cropped.See Help for details on the Crop window.
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 Printing Dates on Photos (Photo Print)
 To print the date the photo was taken on the photo, click (Date Settings) in the Layout/Print screen,then select the Print date checkbox in the Date Settings dialog box.
 Note
 The date is displayed in the short date format (mm/dd/yyyy, etc.) specified in your operating system.In the Date Settings dialog box, you can change the orientation, position, size and color of the dateaccording to the orientation and background of the photo. See Help for details.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Appendix 1: Easy-PhotoPrint EX Settings > Printing Multiple Photos on One Page
 Printing Multiple Photos on One PageYou can print multiple photos on one page by selecting a multiple-photo layout in the Layout/Print screen.
 Note
 See the following section for details on how to select photos.Selecting a Photo
 The available number of photos and layout may vary depending on the media type.Photos are arranged in the following order.Example: Borderless (x4)
 You can change the printing order in Printing Order on the Print tab of the Preferences dialog box.You can select the printing order from By Date, By Name and By Selection.
 To display the Preferences dialog box, click (Settings) or select Preferences... from the Filemenu.
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 Printing an IndexYou can print an index of selected photos. An index print shows the thumbnails of the photos in onepage. It is convenient for managing your photos.
 To print an index, select Index from the layouts in the Layout/Print screen.
 Note
 See the following section for details on how to select photos.Selecting a Photo
 Index print will be disabled if you select any of the following paper sizes.- Credit Card- Fine Art A4- Fine Art A3- Fine Art A3+- Fine Art Letter- CD-RUp to 80 thumbnails can be printed on one page.Photos are arranged in the following order.Example: Index (x20)
 You can change the printing order in Printing Order on the Print tab of the Preferences dialog box.You can select the printing order from By Date, By Name, and By Selection.
 To display the Preferences dialog box, click (Settings) or select Preferences... from the Filemenu.
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 Printing ID Photos (ID Photo Print)You can print a variety of ID photos.
 ImportantThe photo may not qualify as an official ID photo depending on its use.For details, contact the party to whom you will be submitting the photo.
 To print ID photos, select 4"x6" 10x15cm for Paper Size in the Select Paper screen, and select a layout ofthe ID photo from the layouts in the Layout/Print screen.
 Note
 See the following section for details on how to select photos.Selecting a Photo
 Photos are arranged in the following order.Example: ID Photo 3.5x4.5cm
 You can change the printing order in Printing Order on the Print tab of the Preferences dialog box.You can select the printing order from By Date, By Name, and By Selection.
 To display the Preferences dialog box, click (Settings) or select Preferences... from the Filemenu.
 Page top
 Стр. 170 из 396 стр.Printing ID Photos (ID Photo Print)

Page 171
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 Printing Photo InformationSelect Captured Info from the layouts in the Layout/Print screen to print the photo and the Exif informationside by side.
 Note
 See the following section for details on how to select photos.Selecting a Photo
 This function is available only on paper sizes Letter 8.5"x11" and A4.
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 Saving PhotosYou can save edited photos. The information of cropping and layout can be saved.
 Click Save in the Layout/Print screen.
 When the Save As dialog box appears, specify the save location and file name, then click Save.
 ImportantIf you edit a saved file and save it again, the file will be overwritten.To save a file again with a new name or to a different location, select Save As... from the File menuand save.
 Note
 Save will not be displayed in the Select Images or Select Paper screen.
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 Opening Saved FilesYou can open files created with Easy-PhotoPrint EX.
 1. Click Library from Menu.
 The Open dialog box appears.You can check files created and saved with Easy-PhotoPrint EX by icon view (only for Windows Vista)or thumbnail view.
 ImportantWhen using 64bit Edition of Windows Vista or Windows XP, the contents of files cannot bedisplayed on Explorer.
 2. Select the file you want to open and click Open.The Edit or Select Paper screen appears.
 Note
 Easy-PhotoPrint EX supports the following file formats (extensions).- Easy-PhotoPrint EX Photo Print file (.el6)- Easy-PhotoPrint EX Album file (.el1)- Easy-PhotoPrint EX Stickers file (.el2)- Easy-PhotoPrint EX Calendar file (.el4)- Easy-PhotoPrint EX Layout file (.el5)- CD-LabelPrint data (.cld)
 3. Edit the file if necessary.
 Note
 See the following sections for details on the editing procedures.Editing AlbumEditing CalendarEditing StickersEditing Layout Print
 Note
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You can open files created with Easy-PhotoPrint EX with the following methods, besides fromLibrary in Menu.- Double-click or click the file.- From the File menu, click Open..., then select the file you want to edit.You can also open a recently used file by clicking the file name shown in the File menu.
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 Changing LayoutYou can change the layout of each page separately.
 Select the page you want to change the layout of in the Edit screen, then click (Change Layout).
 Select the layout you want to use in the Change Layout dialog box and click OK.
 Album
 ImportantThe album layouts that can be selected may vary depending on the Paper Size, Orientation, or thetype of page selected (front cover, inside pages or back cover).If the new layout has a different number of frames per page from the current layout, the following willhappen:If the number of layoutframes is increased
 : Images will move from the subsequent pages to fill all the framesin the new layout.
 If the number of layoutframes is decreased
 : Pages with the new layout will be added until all the images on thepages with the current layout can be fitted.
 If you change the selected layout for the front or back cover to one that has fewer layout frames, anyimage that does not fit in the new layout will be deleted, starting with the last image that was addedto the former layout page.
 Note
 Select the Apply to all pages checkbox to change the layouts of all pages to the one you newlyselected.
 Calendar
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ImportantThe layouts that can be selected may vary depending on the Paper Size and Orientation.The layouts of all pages are changed to the selected layout.All images that do not fit in the new layout will be collected on one page.
 Layout Print
 ImportantThe layouts that can be selected may vary depending on the Paper Size and Orientation.If the new layout has a different number of frames per page from the current layout, the following willhappen:If the number of layoutframes is increased
 : Images will move from the subsequent pages to fill all the framesin the new layout.
 If the number of layoutframes is decreased
 : Pages with the new layout will be added until all the images on thepages with the current layout can be fitted.
 Note
 Select the Apply to all pages checkbox to change the layouts of all pages to the one you newlyselected.
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 Changing BackgroundYou can change the background of each page.
 ImportantYou cannot change the background of the Photo Print, Stickers, and Layout Print.
 Select the page you want to change the background of in the Edit screen, then click (ChangeBackground).
 Note
 The screens for Album printing are used as examples in the following descriptions. The screensmay vary depending on what you create.
 Select the type of background you want to use in the Change Background dialog box.
 When Select from samples is SelectedSelect the image you want to use from Samples and click OK.
 Note
 Select from samples will be displayed only if Album has been selected.
 When Single color is SelectedSelect the color you want to use from Standard color or Custom color and click OK.
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When Image file is SelectedSet Image File Path and Image Layout, then click OK.
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Note
 See Help for details on how to set the background in the Change Background dialog box.
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 Adding PhotosYou can add images to pages.
 Select the page you want to add photos in the Edit screen, then click (Add Image).
 Note
 The screens for Album printing are used as examples in the following descriptions. The screensmay vary depending on what you create.
 Select the folder containing the image you want to add from the folder tree area on the left of the AddImage dialog box, and select the image you want to add from the thumbnail window on the right.
 Note
 Click an image to select it (background turns blue) or deselect it (background turns white). You canalso select multiple images.
 Select an option for Add to and click OK.
 ImportantYou can add up to 20 images at one time to a single page.Up to 99 of the same images can be added to all pages combined.You cannot add two or more of the same image at one time. In that case, add it one at a time.If you increase the number of pages to add images, you cannot add images beyond page 400.
 Note
 In the Add Image dialog box, you can select all images at one time or change the display size andorder of the thumbnails. See Help for details.
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 Swapping Positions of PhotosYou can swap the positions of images.
 Click (Swap Image Positions) in the Edit screen.
 Note
 The screens for Album printing are used as examples in the following descriptions. The screensmay vary depending on what you create.
 Select the target and source images you want to swap, then click Swap.When you finish swapping all images you want to swap, click Back to Edit.
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 Replacing PhotosYou can replace an image with another image.
 Select the image you want to replace in the Edit screen, then click (Replace Selected Image).
 Select the folder containing the image you want to replace with from the folder tree area on the left of theReplace Image dialog box.Select the image you want to replace with from the thumbnail window on the right of the screen and clickOK.
 If you want to select from the images already imported, click the Imported Images tab and select theimage you want to replace with from the thumbnail window and click OK.
 ImportantYou cannot select multiple images in the Replace Image dialog box.
 Note
 If you select multiple images in the Edit screen and use the replacement function, all the imagesselected in the Edit screen will be replaced with the image selected in the Replace Image dialogbox.When images are replaced, the following settings of the old image are inherited to the new image.- Position- Size- Frame- Position and size of the dateThe cropping information and image orientation are not inherited.In the Replace Image dialog box, you can change the display size and order of the thumbnails. SeeHelp for details.
 Page top
 Стр. 182 из 396 стр.Replacing Photos

Page 183
                        

Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Appendix 1: Easy-PhotoPrint EX Settings > Changing Position, Angle and Size of Photos
 Changing Position, Angle and Size of PhotosYou can adjust the position, angle and size of images.
 Select the image of which you want to change the position or size in the Edit screen and click (EditImage) or double-click the image.
 Set the Center Position, Rotation and Size, then click OK.
 Note
 You can also change the position and size of an image by dragging it in the Edit screen.
 Select an image in the Edit screen, then click (Free Rotate) and drag a corner of the image torotate it.See Help for details on the position and size of images.
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 Cropping PhotosCropping an image is the act of removing the unnecessary portions of the image by selecting thenecessary portions.
 Select the image you want to crop in the Edit screen and click (Edit Image) or double-click theimage.Click the Crop tab in the Edit Image dialog box.
 Drag the white squares on the image to change the area to be cropped and click OK.
 Note
 See Help for details on cropping.
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 Framing PhotosYou can add frames to images.
 ImportantYou cannot add frames to images in Photo Print, Stickers, and Layout Print.
 Select the image you want to frame in the Edit screen and click (Edit Image) or double-click theimage.Click the Frame tab in the Edit Image dialog box.
 Select the frame you want to use from Frames and click OK.
 ImportantYou cannot print dates on framed photos.
 Note
 Select the Apply to all images in the page checkbox to add the same frame to all the images on aselected page at one time.See Help for details on frames.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Appendix 1: Easy-PhotoPrint EX Settings > Printing Dates on Photos
 Printing Dates on PhotosYou can print dates on images.
 Select the image you want to print the date in the Edit screen and click (Edit Image) or double-clickthe image.Click the Date tab in the Edit Image dialog box.
 Select the Show date checkbox.
 Set the Text Orientation, Position, Font Size and Color, then click OK.
 ImportantYou cannot print dates on framed images.
 Note
 The date is displayed in the short date format (mm/dd/yyyy, etc.) specified in your operating system.See Help for details on setting dates.
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 Attaching Comments to PhotosYou can attach comments to images and display them in your album. The photo name, shooting dateand comments are displayed (from top to bottom) in a comment box.
 ImportantYou cannot attach comments to Photo Print, Calendar, Stickers, and Layout Print.
 Select the image you want to attach comments to in the Edit screen and click (Edit Image) ordouble-click the image.Click the Comments tab in the Edit Image dialog box.
 Select the Show comment box checkbox.
 Select the checkboxes of the items you want to display, and enter comments.Set the size and color of font, and position, etc. of the comments, then click OK.
 Note
 See Help for details on comments.
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Advanced Guide > Printing from a Computer > Printing with the Bundled Application Software > Appendix 1: Easy-PhotoPrint EX Settings > Adding Text to Photos
 Adding Text to PhotosYou can add text to photos.
 Click (Add Text) in the Edit screen and drag the mouse over the area in which you want to add text.
 Note
 The screens for Album printing are used as examples in the following descriptions. The screensmay vary depending on what you create.
 Select the Text tab in the Edit Text Box dialog box and enter text.
 Note
 In the Edit Text Box dialog box, you can change the position, angle and size of the text. You can alsoset the color and line of the text box. See Help for details.
 To change the entered text, select it and click (Edit Text Box). The Edit Text Box dialog boxappears. You can change the text.
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 SavingYou can save edited items.
 Click Save in the Edit or Print Settings screen.
 Note
 The screens for Album printing are used as examples in the following descriptions. The screensmay vary depending on what you create.
 When the Save As dialog box appears, specify the save location and file name, then click Save.
 ImportantIf you edit a saved file and save it again, the file will be overwritten.To save a file again with a new name or to a different location, select Save As... from the File menuand save.
 Note
 Save will not be displayed in the Page Setup or Select Images screen.
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 Setting HolidaysYou can add holidays to your calendar.
 Click Set Holidays... in the Page Setup screen of Calendar, or click (Setup Period/Holiday) in theEdit screen and click Set Holidays... in the Calendar General Settings dialog box to display the HolidaySettings dialog box.
 To add a holiday, click Add.... The Add/Edit Holiday dialog box appears. To edit a saved holiday, select itand click Edit....
 To delete a holiday, select it and click Delete. To delete all the saved holidays within your calendarperiod, click Clear.
 Enter the name in Holiday Name and specify the date.Select the Set as Holiday checkbox to display that day as a holiday in your calendar.
 Note
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See Help for details on each dialog box.
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 Setting Calendar DisplayYou can customize the calendar display (fonts, lines, colors, position, size, etc.).
 Click Settings... in the Page Setup screen of Calendar, or select a calendar in the Edit screen and click
 (Setup Calendar) to display the Calendar Settings dialog box.
 ImportantThe Position & Size tab is displayed only when the Calendar Settings dialog box is displayed fromthe Edit screen.
 Note
 See Help for details on the Calendar Settings dialog box.
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 Printing with Other Application SoftwareVarious Printing MethodsChanging the Print Quality and Correcting Image DataOverview of the Printer Driver
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 Various Printing MethodsPrinting with Easy SetupSetting a Page Size and Orientation
 Setting the Number of Copies and Printing OrderSetting the Stapling Margin
 Borderless PrintingFit-to-Page Printing
 Scaled PrintingPage Layout Printing
 Poster PrintingBooklet PrintingDuplex PrintingStamp/Background PrintingSaving a Stamp Setting
 Saving Image Data to be Used as a BackgroundPrinting an EnvelopeSwitching the Paper Source to Match the Purpose
 Displaying the Print Results before PrintingSetting Paper Dimensions (Custom Size)
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 Printing with Easy Setup The procedure for setting the basic print setup, which is necessary to print data properly with this printer,is as follows:
 1. Open the printer driver setup window
 2. Select the media type Select the type of paper loaded in the printer from the Media Type list on the Main tab.
 3. Select the paper source Select Automatically Select, Rear Tray, Cassette, Continuous Autofeed, or Paper Allocation fromPaper Source.
 Important The Paper Source settings that can be selected may differ depending on the paper type andsize.
 4. Select the print quality Select High, Standard, or Fast for Print Quality.
 5. Select color/intensity Select Auto for Color/Intensity.
 6. Check the settings Check the specified settings such as paper type and paper source displayed in the Settings Previewon the left side of the window.
 7. Complete the setup Click OK.When you execute print, the document will be printed in accordance with the type and size of themedia.
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 Setting a Page Size and Orientation The paper size and orientation are essentially determined by the application. If the page size andorientation set for Page Size and Orientation on the Page Setup tab are same as those set with theapplication, you do not need to select them on the Page Setup tab.
 If you are not able to specify them with the application, the procedure for selecting a page size andorientation is as follows:
 1. Open the printer driver setup window
 2. Select the paper size Select a page size from the Page Size list on the Page Setup tab.
 3. Select Orientation Select Portrait or Landscape for Orientation. Check Rotate 180 degrees check box if you want toperform printing with the original being rotated 180 degrees.
 4. Complete the setup Click OK.The document will be printed with the selected page size and the orientation.
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 Setting the Number of Copies and Printing Order
 Default Setting Print from Last Page
 Collate Print from Last Page + Collate
 The procedure for specifying the number of copies and printing order is as follows:
 1. Open the printer driver setup window
 2. Specify the number of copies to be printed For Copies on the Page Setup tab, specify the number of copies to be printed.
 3. Specify the print sequence Check the Print from Last Page check box if you want to print from the last page in order. If you dothis, you do not need to sort pages into their correct order after printing.
 4. Set up collated printing when you specify multiple copies in the Copies box Check the Collate check box if you are specifying multiple copy together.Uncheck this check box to print all pages with the same page number together.
 5. Complete the setup Click OK.The specified number of copies will be printed with the specified printing order.
 Important
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If your application has the same function, make the settings with the application. If you specify thenumber of copies and the printing order with both the application and this printer driver, the numberof copies may be multiplied numbers of the two settings or the specified printing order may not beenabled. Print from Last Page and Collate appear grayed out and are unavailable if Booklet Printing isselected for Page Layout. Print from Last Page appears grayed out and is unavailable if Poster Printing is selected for PageLayout.
 Note
 By setting both Print from Last Page and Collate, you can perform printing so that papers arecollated one by one starting from the last page.These settings can be used in combination with Borderless Printing, Normal-size Printing, Fit-to-Page Printing, Scaled Printing, Page Layout Printing, and Duplex Printing.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Setting the Stapling Margin
 Setting the Stapling Margin
 The procedure for setting the stapling direction and the width of the stapling margin is as follows:
 1. Open the printer driver setup window
 2. Specify the side to be stapled Check the position of the stapling margin from Staple Side on the Page Setup tab.The printer analyzes the Orientation and Page Layout settings, and automatically selects the beststaple position. If you want to change the setting, select from the list.
 3. Set the margin width If necessary, click Specify Margin... and set the width of the stapling margin, and then click OK.
 4. Complete the setup Click OK on the Page Setup tab.When you execute print, the data is printed with the specified staple side and margin.
 Important Staple Side and Specify Margin... appear grayed out and are unavailable when:
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Poster Printing or Booklet Printing is selected for Page Layout. Scaled Printing is selected for Page Layout (If Duplex Printing is also selected, only Staple Side isselectable). Borderless Printing check box is checked (If Duplex Printing is also selected, only Staple Side isselectable).
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Borderless Printing
 Borderless Printing The borderless printing function allows you to print data without any margin by enlarging the data so thatit extends slightly off the paper. Without the borderless printing function, a margin is provided around theprinted data. If you want to print data such as a photo without providing any margin around it, selectBorderless Printing.
 The procedure for performing borderless printing is as follows:
 Setting Borderless Printing
 1. Open the printer driver setup window
 2. Set borderless printing Check the Borderless Printing check box on the Page Setup tab.
 Click OK when the confirmation message appears.When a message prompting you to change the media type appears, select a media type from thelist and click OK.
 3. Check the paper size Check the Page Size list. If you want to change, select another page size from the list. The listdisplays only sizes that can be used for borderless printing.
 4. Adjust the amount of extension from the paper Adjust the amount of extension using the Amount of Extension slider as necessary.Moving the slider to the right makes the amount larger and moving the slider to the left makes theamount smaller.
 Стр. 202 из 396 стр.Borderless Printing

Page 203
                        

It is recommended to set the slider at the second position from the right for most cases.
 Important If you set the slider at the rightmost position, the back side of the paper may become smudged.
 5. Complete the setup Click OK.The data will be printed without any margins on the paper.
 Important If a page size that cannot be used for borderless printing is selected, the size is automaticallychanged to the valid page sizes for borderless printing. When High Resolution Paper, T-Shirt Transfers, or Envelope is selected from the Media Type list onthe Main tab, you cannot perform borderless printing. When Borderless Printing is checked, the Printer Paper Size, Page Layout, Staple Side (whenDuplex Printing is not selected) settings, and the Stamp/Background... button on the Page Setup tabappear grayed out and are unavailable. Print quality may deteriorate or the sheet may be stained at the top and bottom depending on thetype of the media used. When the ratio of the height to the width differs greatly from the image data, a portion of the imagemay not be printed depending on the size of the media used.In this case, crop the image data with an application software according to the paper size.
 Note
 When Plain Paper is selected for Media Type on the Main tab, borderless printing is notrecommended, and therefore the dialog box for media selection appears.If you are using plain paper for test printing, select Plain Paper, and click OK.
 Expanding the range of the document to print Specifying a large amount of extension allows you to perform borderless printing with no problems.However, the portion of the document that extends off the paper range will not be printed. Subjectsaround the perimeter of a photo may not be printed.
 Try borderless printing once. If you are not satisfied with the result of borderless printing, reduce theamount of extension. The extension amount becomes shorter as the Amount of Extension slider ismoved to the left.
 Important If the Amount of Extension is shortened, an unexpected margin may be produced on the print,depending on the size of the paper.
 Note
 If Preview before printing is checked on the Main tab, you can confirm before printing whether therewill be no border.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods > Fit-to-Page Printing
 Fit-to-Page Printing
 The procedure for printing document, which is enlarged or reduced to fit to the page size, is as follows:
 1. Open the printer driver setup window
 2. Set fit-to-page printing Select Fit-to-Page Printing from the Page Layout list on the Page Setup tab.
 3. Select the paper size for the data Using Page Size, select the page size that was set with your application.
 4. Select the print paper size Select the size of the paper loaded in the printer from the Printer Paper Size list.If the printer paper size is smaller than the Page Size, the page image will be reduced. If the printerpaper size is larger than the page size, the page image will be enlarged. The current settings are displayed in the Settings Preview on the left side of the printer driver.
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5. Complete the setup Click OK.When you execute print, the document will be enlarged or reduced to fit to the page size.
 Important When Borderless Printing check box is checked, Fit-to-Page Printing cannot be selected.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Scaled Printing
 Scaled Printing
 The procedure for printing a document with pages enlarged or reduced is as follows:
 1. Open the printer driver setup window
 2. Set scaled printing Select Scaled Printing from the Page Layout list on the Page Setup tab.
 3. Select the paper size for the data Using Page Size, select the page size that was set with your application.
 4. Set the scaling rate by using one of the following methods: Select a Printer Paper Size Select a printer paper size, which is different from the Page Size, from the Printer Paper Size list.If the printer paper size is smaller than the Page Size, the page image will be reduced. If theprinter paper size is larger than the page size, the page image will be enlarged.
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Specify a scaling factor Directly type in a value into the Scaling box.
 The current settings are displayed in the Settings Preview on the left side of the printer driver.
 5. Complete the setup Click OK.When you execute print, the document will be printed with the specified scale.
 Important If the application software with which you created the original has the scaled printing function,configure the settings on your application software. You do not need to also configure the samesetting in the printer driver. When Scaled Printing is selected, the Staple Side list box appears grayed out and is unavailable(when Duplex Printing is not selected). When Borderless Printing check box is checked, Scaled Printing cannot be selected.
 Note
 Selecting Scaled Printing changes the printable area.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Page Layout Printing
 Page Layout Printing The page layout printing function allows you to print more than one page image on a single sheet ofpaper.
 The procedure for performing page layout printing is as follows:
 1. Open the printer driver setup window
 2. Set page layout printing Select Page Layout Printing from the Page Layout list on the Page Setup tab.The current settings are displayed in the Settings Preview on the left side of the printer driver.
 3. Select the print paper size Select the size of the paper loaded in the printer from the Printer Paper Size list.Now you have finished setting the layout of the document from left to right.
 4. Set the number of pages to be printed on one sheet and the page sequence If necessary, click Specify..., specify the following settings in the Page Layout Printing dialog box, andclick OK.
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Pages To increase the number of pages to be included on a single sheet of paper, select a desirednumber of pages from the list.
 Page Order To change the page arrangement order, select an icon from the list to change the page placementorder.
 Page Border To print a page border around each document page, check this check box.
 5. Complete the setup Click OK on the Page Setup tab.When you execute print, the specified number of pages will be arranged on each sheet of paper inthe specified order.
 Important When Borderless Printing check box is checked, Page Layout Printing cannot be selected.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Poster Printing
 Poster Printing The poster printing function allows you to enlarge image data, divide it into several pages, and printthese pages on separate sheets of paper. When the pages are pasted together, they form a large printlike a poster.
 The procedure for performing poster printing is as follows:
 Setting Poster Printing
 1. Open the printer driver setup window
 2. Set poster printing Select Poster Printing from the Page Layout list on the Page Setup tab.The current settings are displayed in the Settings Preview on the left side of the printer driver.
 3. Select the print paper size Select the size of the paper loaded in the printer from the Printer Paper Size list.Now you have finished setting 2 by 2-page poster printing.
 4. Set the number of image divisions and the pages to be printed. If necessary, click Specify..., specify the following settings in the Poster Printing dialog box, and thenclick OK.
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Image Divisions Select the number of divisions (vertical x horizontal) from the Image Divisions list. As the number ofdivisions increases, the number of sheets used for printing increases, allowing you to create alarger poster.
 Print "Cut/Paste" in margins To leave out words "Cut" and "Paste", uncheck this check box.
 Important This feature is unavailable when the 64-bit printer driver is used.
 Print "Cut/Paste" lines in margins To leave out cut lines, uncheck this check box.
 Pages To reprint only specific pages, enter the page number you want to print. To print multiple pages,specify by separating the pages with commas or entering a hyphen between the page numbers.
 Note
 You can also specify the print range by clicking the pages in the setup preview.
 5. Complete the setup Click OK on the Page Setup tab.When you execute print, the document will be divided into several pages during printing.After all poster pages have been printed, paste the pages together to create a poster.
 Printing Only Specific Pages If ink becomes faint or runs out during printing, you can print the pages you still need, by following theprocedure below:
 1. Set the print range In the Settings Preview on the left of the Page Setup tab, click the pages that do not need to beprinted.The pages that were clicked are deleted, and only the pages to be printed are displayed.
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Note
 Click the deleted pages to display them again. Right-click the Settings Preview to select Print all pages or Delete all pages.
 2. Complete the setup After completing the page selection, click OK.When you execute print, only specified pages will be printed.
 Important When Poster Printing is selected, the Duplex Printing and Print from Last Page check boxes and theStaple Side list box appear grayed out and are unavailable. When Borderless Printing check box is checked, Poster Printing cannot be selected. Since poster printing enlarges the document when printing it, the print results may become coarse.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Booklet Printing
 Booklet Printing The booklet printing function allows you to print data for a booklet. Data is printed on both sides of thepaper. This type of printing ensures that pages can be collated properly, in page number order, when theprinted sheets are folded and stapled at the center.
 The procedure for performing booklet printing is as follows:
 1. Open the printer driver setup window
 2. Set booklet printing Select Booklet Printing from the Page Layout list on the Page Setup tab.The current settings are displayed in the Settings Preview on the left side of the window.
 3. Select the print paper size Select the size of the paper loaded in the printer from the Printer Paper Size list.
 4. Set the margin for stapling and the margin width Click Specify..., specify the following settings in the Booklet Printing dialog box, and then click OK.
 Margin for stapling Select which side the stapling margin should be on when the booklet is completed.
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Insert blank page To leave one side of a sheet blank, check Insert blank page check box, and select the page to be leftblank.
 Margin Enter the margin width. The specified width from the center of the sheet becomes the margin for onepage.
 Page Border To print a page border around each document page, check the Page Border check box.
 5. Complete the setup Click OK on the Page Setup tab.
 When you execute print, the document is automatically printed first on one side of a sheet of paperand then on the opposite side.When the printing is complete, fold the paper at the center of the margin and make a booklet.
 Important Booklet Printing is unavailable when:
 A media type other than Plain Paper or Hagaki is selected from the Media Type list. Borderless Printing check box is checked.
 When Booklet Printing is selected, Duplex Printing, Staple Side, Print from Last Page, and Collateappear grayed out and are unavailable.
 Note
 The stamp and background are not printed on blank sheets inserted with the Insert blank pagefunction of Booklet Printing.
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 Duplex Printing
 The procedure for printing data on both sides of a sheet of paper is as follows:
 Performing automatic duplex printing You can perform the duplex printing without having to turn over the paper.
 1. Open the printer driver setup window
 2. Set automatic duplex printing Check the Duplex Printing check box and confirm that Automatic is checked on the Page Setup tab.
 3. Select the layout Select Normal-size Printing (or Fit-to-Page Printing, Scaled Printing or Page Layout Printing) fromthe Page Layout list.
 4. Set the print area When you perform duplex printing, the print area of the document becomes slightly narrower thanusual and the document may not fit on one page.Click Print Area Setup..., and select one of the following processing methods.
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Use normal-size printing Print without reducing the page.
 Use reduced printing Reduce the page slightly during printing.
 5. Specify the side to be stapled The printer analyzes the Orientation and Page Layout settings, and automatically selects the bestStaple Side. If you want to change the setting, select another value from the list.
 6. Set the margin width If necessary, click Specify Margin... and set the width of the stapling margin, and then click OK.
 7. Complete the setup Click OK on the Page Setup tab.Duplex printing will be started.
 Performing duplex printing manually You can perform the duplex printing manually.
 1. Open the printer driver setup window
 2. Set duplex printing Check the Duplex Printing check box and uncheck the Automatic check box on the Page Setup tab.
 3. Select the layout Select Normal-size Printing (or Fit-to-Page Printing, Scaled Printing or Page Layout Printing) fromthe Page Layout list.
 4. Specify the side to be stapled The printer analyzes the Orientation and Page Layout settings, and automatically selects the bestStaple Side. If you want to change the setting, select another value from the list.
 5. Set the margin width If necessary, click Specify Margin... and set the width of the stapling margin, and then click OK.
 6. Complete the setup Click OK on the Page Setup tab.
 When you execute print, the document will be printed on one side of a sheet of paper. When the
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printing of one side is complete, set the paper correctly by following the message and click OK. Thedocument will be printed on the opposite side.
 Important Duplex Printing is unavailable when:
 A media type other than Plain Paper or Hagaki is selected from the Media Type list. Poster Printing is selected from the Page Layout list.
 When Booklet Printing is selected from the Page Layout list, Duplex Printing and Staple Sideappear grayed out and are unavailable. After printing the front page, there is an ink drying wait time before starting to print the back page(Operation stops temporarily). Do not touch the paper during the time. You can change the inkdrying wait time at Custom Settings on the Maintenance tab. When you perform the automatic duplex printing for Hagaki, print an address first and then print yourmessage.
 Note
 If the Media Type dialog box appears when performing borderless printing during duplex printing,select Plain Paper. When performing the automatic duplex printing, do not use any plain paper smaller than A5. Also,do not select any type of paper other than Plain Paper or Hagaki at Media Type. If the back side of the paper becomes smudged during duplex printing, perform Bottom PlateCleaning in the Maintenance tab.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Stamp/Background Printing
 Stamp/Background Printing This feature is unavailable when the 64-bit printer driver is used. The Stamp function allows you to print a stamp text or a bitmap over or behind document data. TheBackground function allows you to print a light illustration behind the document data.
 The procedure for performing stamp/background printing is as follows:
 Printing a stamp "CONFIDENTIAL," "IMPORTANT," and other stamps that are used often in companies are pre-registered.
 1. Open the printer driver setup window
 2. Click Stamp/Background... on the Page Setup tab
 The Stamp/Background dialog box opens.
 3. Select a stamp Check the Stamp check box, and select a desired stamp from the list.The current settings are displayed in the Settings Preview on the left side of the Page Setup tab.
 4. Set the stamp details If necessary, complete the following settings, and then click OK.
 Place stamp over text To print the stamp on the front of the document, check this check box.
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Note
 The stamp is given priority because the stamp is printed over the document data in thesections where the stamp and the document data overlap. If the Place stamp over text checkbox is unchecked, the stamp is printed behind the document data and may be hidden in theoverlapping sections depending on the application used.
 Stamp first page only To print the stamp only on the first page, check this check box.
 Define Stamp... button To change the stamp text, bitmap, or position, click this (refer to Saving a Stamp Setting).
 5. Complete the setup Click OK on the Page Setup tab.When you execute print, the data is printed with the specified stamp.
 Printing a background
 1. Select the background for which the settings are to be changed Two bitmap files are pre-registered as samples.
 2. Click Stamp/Background... on the Page Setup tab The Stamp/Background dialog box opens.
 3. Select the background Check the Background check box, and select a desired background from the list.The current settings are displayed in the Settings Preview on the left side of the Page Setup tab.
 4. Set the background details If necessary, complete the following settings, and then click OK.
 Background first page only To print the background only on the first page, check this check box.
 Select Background... button To use another bitmap file or change the layout or density of a background, click this (refer to SavingImage Data to be Used as a Background ).
 5. Complete the setup Click OK on the Page Setup tab.When you execute print, the data is printed with the specified background.
 Important When the Borderless Printing check box is checked, the Stamp/Background... button appearsgrayed out and is unavailable.
 Note
 The stamp and background are not printed on blank sheets inserted with the Insert blank pagefunction of Booklet Printing.
 Related Topics Saving a Stamp Setting
 Saving Image Data to be Used as a Background
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods > Stamp/Background Printing > Saving a Stamp Setting
 Saving a Stamp Setting This feature is unavailable when the 64-bit printer driver is used. You can create and save a new stamp. You can also change and register some of the settings of anexisting stamp. Unnecessary stamps can be deleted at any time.
 The procedure for registering a new stamp is as follows:
 Registering a new stamp
 1. Open the printer driver setup window
 2. Click Stamp/Background... on the Page Setup tab
 The Stamp/Background dialog box opens.
 3. Click Define Stamp... The Stamp Settings dialog box opens.
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4. Configure the stamp while viewing the preview window Stamp tab Select Text or Bitmap with Stamp Type.When registering a text, the characters must already be entered in Stamp Text. Change the TrueType Font, Style, Size, and Outline settings, as necessary. You can select the color of the stampby clicking Select Color....For Bitmap, click Select File... and select the bitmap file (.bmp) to be used. Change the settingsof the Size and Transparent white area if necessary.
 Placement tab Select the stamp position from the Position list. You can also select Custom from the Positionlist and specify coordinates for X-Position and Y-Position.You can also change the stamp position by dragging the stamp in the preview window.To change the stamp position angle, type a value in the Orientation box directly.
 5. Save the stamp Click the Save settings tab and enter a new stamp title in the Title box, and then click Save.Click OK when the confirmation message appears.
 6. Complete the setup Click OK. The Stamp/Background dialog box opens again.The registered title appears in the Stamp list.
 Changing and registering some of stamp settings
 1. Select the stamp for which the settings are to be changed Check the Stamp check box in the Stamp/Background dialog box, and then select the title of thestamp to be changed from the Stamp list.
 2. Click Define Stamp... The Stamp Settings dialog box opens.
 3. Configure the stamp while viewing the preview window
 4. Save the stamp Click Save overwrite on the Save settings tab.If you want to save the stamp with a different title, type a new title in the Title box and click Save.Click OK when the confirmation message appears.
 5. Complete the setup
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Click OK. The Stamp/Background dialog box opens again.The registered title appears in the Stamp list.
 Deleting an unnecessary stamp
 1. Click Define Stamp... in the Stamp/Background dialog box The Stamp Settings dialog box opens.
 2. Select the stamp to be deleted Select the title of the stamp you want to delete from the Stamps list on the Save settings tab. Thenclick Delete.Click OK when the confirmation message appears.
 3. Complete the setup Click OK. The Stamp/Background dialog box opens again.
 Page top
 Стр. 222 из 396 стр.Saving a Stamp Setting

Page 223
                        

Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods > Stamp/Background Printing > Saving Image Data to be Used as a Background
 Saving Image Data to be Used as a Background This feature is unavailable when the 64-bit printer driver is used. You can select a bitmap file and save it as a new background. You can also change and register someof the settings of an existing background. An unnecessary background can be deleted at any time.
 The procedure for registering image data to be used as a background is as follows:
 Registering image data to be used as a background
 1. Open the printer driver setup window
 2. Click Stamp/Background... on the Page Setup tab
 The Stamp/Background dialog box opens.
 3. Click Select Background... The Background Settings dialog box opens.
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4. Select the image data to be registered to the background Click Select File.... Select the target image data (bitmap file), and then click Open.
 5. Specify the following settings while viewing the preview window
 Layout Method Select how the background image data is to be placed.When Custom is selected, you can set coordinates for X-Position and Y-Position.You can also change the background position by dragging the image in the preview window.
 Intensity Set the intensity of the background image data with the Intensity slider. To lighten the background,move the slider to the left. To darken the background, move the slider to the right. To print thebackground at the original bitmap intensity, move the slider to the rightmost position.
 6. Save the background Click the Save settings tab and enter a new stamp title in the Title box, and then click Save.Click OK when the confirmation message appears.
 7. Complete the setup Click OK. The Stamp/Background dialog box opens again.The registered title appears in the Background list.
 Changing and saving some background settings
 1. Select the background for which the settings are to be changed Check the Background check box in the Stamp/Background dialog box, and then select the title ofthe background you want to change from the Background list.
 2. Click Select Background... The Background Settings dialog box opens.
 3. While viewing the preview, set the items on the Background tab
 4. Save the background Click Save overwrite on the Save settings tab. If you want to save the background with a different title,type a new title in the Title box and click Save.Click OK when the confirmation message appears.
 5. Complete the setup Click OK. The Stamp/Background dialog box opens again.The registered title appears in the Background list.
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Deleting an unnecessary background
 1. Click Select Background... in the Stamp/Background dialog box The Background Settings dialog box opens.
 2. Select the background to be deleted Select the title of the background you want to delete from the Backgrounds list on the Save settingstab, and then click Delete.Click OK when the confirmation message appears.
 3. Complete the setup Click OK. The Stamp/Background dialog box opens again.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Printing an Envelope
 Printing an Envelope For details on how to load an envelope into the machine, refer to the "Loading Envelopes" in the manual:Basic Guide. The procedure for performing envelope printing is as follows:
 1. Load an envelop into the printer Fold down the envelope flap.
 Orient the envelope so that the flap is on the left and the folded surface is facing down.
 2. Open the printer driver setup window
 3. Select the media type Select Envelope from the Media Type list on the Main tab.
 4. Select the paper size Click the Page Setup tab, and select Youkei 4, Youkei 6, Comm.Env. #10, or DL Env. for Page Size.
 5. Select the landscape for orientation To print the addressee horizontally, select Landscape for Orientation.
 6. Complete the setup Click OK.When you execute print, the information is printed on the envelope.
 Page top
 Стр. 226 из 396 стр.Printing an Envelope

Page 227
                        

Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Switching the Paper Source to Match the Purpose
 Switching the Paper Source to Match the Purpose In this printer, there are two paper sources, a rear tray and a cassette.You can facilitate printing by selecting a paper source setting that matches your print conditions orpurpose.
 The procedure for setting paper source is as follows:
 1. Open the printer driver setup window
 2. Select the paper source From the Paper Source list on the Main tab, select the paper source that matches your purpose.
 Automatically Select Plain paper whose Page Size is Letter 8.5"x11", A5, A4, or B5 is fed from the cassette. Other sizes ofplain paper and paper types other than plain paper are fed from the rear tray.
 Rear Tray Paper is always fed from the rear tray.
 Cassette Paper is always fed from the cassette.
 Important Plain paper that is not Letter 8.5"x11", A5, A4, or B5 and paper types other than plain papercannot be fed from the cassette.
 Continuous Autofeed If plain paper runs out in the specified paper source, the printer automatically switches the papersource. When printing a large volume of data, load plain paper of the same size in both paper sources. Youcan therefore reduce the trouble of having to load paper because the printer automatically switchesthe paper source when paper runs out in one paper source.
 Important Continuous Autofeed is unavailable when paper other than Plain Paper is selected for MediaType. Since the printer feeds paper from the paper source that was being used the last timeContinuous Autofeed was selected and printing ended, load the same paper in both the reartray and the cassette.
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Paper Allocation If the media type for the print data is plain paper and the paper size matches the paper allocationsetting, the printer automatically feeds paper from the cassette. If not, the printer feeds paper fromthe rear tray. To change the paper allocation settings, click Paper Allocation..., specify the Paper Size to be loadedin the cassette, and then click OK. If you load frequently used plain paper in the cassette, the printer feeds paper from the rear traywhen the print data uses a different type of paper. You can therefore reduce the trouble of having toload different paper.
 3. Complete the setup Click OK.When you execute print, the printer uses the specified paper source to print the data.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Displaying the Print Results before Printing
 Displaying the Print Results before Printing You can display and check the print result before printing.
 The procedure for displaying the print result before printing is as follows:
 1. Open the printer driver setup window
 2. Set the preview Check the Preview before printing check box on the Main tab.
 3. Complete the setup Click OK.The Canon IJ Preview will start and the print result will be displayed before printing.
 Related Topic Canon IJ Preview
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Various Printing Methods >Setting Paper Dimensions (Custom Size)
 Setting Paper Dimensions (Custom Size) You can specify the height and width of paper if its size cannot be selected in Page Size. Such a papersize is called a custom size.
 The procedure for specifying a custom size is as follows:
 1. Set the custom size in the application software On your application's paper size feature, specify your custom size.
 Important If the application software that created the document has a function for specifying the heightand width values, use the application software to set the values. If the application softwaredoes not have such a function or if the document does not print correctly, use the printer driverto set the values.
 2. Open the printer driver setup window
 3. Select the paper size Select Custom... for Page Size on the Page Setup tab.
 The Custom Paper Size dialog box opens.
 4. Set the custom size in the application software Specify Units, and enter the Width and Height of the paper to be used. Then click OK.
 5. Complete the setup Click OK on the Page Setup tab.When you execute print, the data is printed with the specified paper size.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data
 Changing the Print Quality and Correcting Image DataSelecting a Combination of the Print Quality Level and a Halftoning Method
 Printing a Color Document in MonochromeSpecifying Color CorrectionOptimal Photo Printing of Image DataAdjusting Colors with the Printer DriverPrinting with ICC ProfilesAdjusting Color BalanceAdjusting BrightnessAdjusting IntensityAdjusting ContrastSimulating an IllustrationRepresenting Image Data with a Single ColorPresenting Image Data with Vivid ColorsSmoothing Jagged OutlinesChanging Color Properties to Improve ColorationReducing Photo Noise
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Selecting a Combination of the Print Quality Level and a Halftoning Method
 Selecting a Combination of the Print Quality Level and aHalftoning Method You can set the print quality level and the halftoning method.
 The procedure for setting the print quality level and the halftoning method is as follows:
 1. Open the printer driver setup window
 2. Select the print quality Select Custom for Print Quality on the Main tab, and click Set....
 The Custom dialog box opens.
 3. Setting the print quality and halftone expression method Move the Quality slider to select the quality level.Select Halftoning and click OK.
 Note
 Стр. 233 из 396 стр.Selecting a Combination of the Print Quality Level and a Halftoning Method

Page 234
                        

Halftones refer to color shades between the darkest color and the brightest color.The printer replaces the color shades with a collection of small dots to express the halftones.Dither arranges the dots according to fixed rules to express the halftones. Diffusion places thedots randomly to express the halftones. When you select Auto, the data is printed with theoptimal halftoning method for the selected print quality.
 4. Complete the setup Click OK on the Main tab.When you execute print, the data is printed with the specified quality level and halftoning method.
 Important Certain print quality levels and halftoning methods cannot be selected depending on the settings ofMedia Type.
 Note
 When the part of the object is not printed, selecting Diffusion for Halftoning may solve the problem.
 Related Topics Specifying Color CorrectionAdjusting Color BalanceAdjusting BrightnessAdjusting IntensityAdjusting Contrast
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Printing a Color Document in Monochrome
 Printing a Color Document in Monochrome
 The procedure for printing a color document in monochrome is as follows:
 1. Open the printer driver setup window
 2. Set grayscale printing Check the Grayscale Printing check box on the Main tab.
 3. Complete the setup Click OK.When you execute print, the document is converted to grayscale data. It allows you to print the colordocument in monochrome.
 Important When the Grayscale Printing check box is checked, the printer driver processes image data assRGB data. In this case, actual colors printed may differ from those in the original image data.When using the grayscale printing function to print Adobe RGB data, convert the data to sRGB datausing an application software.
 Note
 During Grayscale Printing, color inks may be used as well as black ink.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Specifying Color Correction
 Specifying Color Correction You can specify the color correction method suited to the type of document to be printed.Normally, the printer driver adjusts the colors by using Canon Digital Photo Color so that data is printedwith color tints that most people prefer. This method is suitable for printing sRGB data. If you want to print by using the color space of sRGB or Adobe RGB data effectively, select ICM. If youwant to use an application software to specify an ICC profile, select None.
 The procedure for specifying color correction is as follows:
 1. Open the printer driver setup window
 2. Select the manual color adjustment On the Main tab, select Manual for Color/Intensity, and click Set....
 The Manual Color Adjustment dialog box opens.
 3. Select color correction Click Matching tab, select Color Correction setting suited to your purpose from the following, andclick OK.
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Driver Matching By using Canon Digital Photo Color, you can print sRGB data with color tints that most people prefer.Driver Matching is the default setting for Color Correction.
 ICM You can print by using the color space of sRGB or Adobe RGB data effectively.
 None The printer driver does not perform color adjustment. Select this value if you are specifying anindividually created profile or a profile for special Canon paper in an application software to printdata.
 4. Complete the setup Click OK on the Main tab.When you execute print, the data is printed with the specified color adjustment method.
 Important If ICM is disabled in the application software, ICM is unavailable for Color Correction and the printermay not be able to print the image data properly. When the Grayscale Printing check box on the Main tab is checked, Color Correction appearsgrayed out and is unavailable.
 Related Topics Optimal Photo Printing of Image DataAdjusting Colors with the Printer DriverPrinting with ICC Profiles
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Specifying Color Correction > Optimal Photo Printing of Image Data
 Optimal Photo Printing of Image Data When people print images taken with digital cameras, they sometimes feel that the printed color tonesdiffer from those of actual image or those displayed on the monitor.To get the print results as close as possible to the desired color tones, you must select a printingmethod that is best suited to the application software used or to your purpose.
 Color Management Devices such as digital cameras, scanners, monitors, and printers handle color differently. Colormanagement (color matching) is a method that manages device-dependent "colors" as a common colorspace. For Windows, a color management system called "ICM" is built into the operating system.sRGB and Adobe RGB are popularly used as common color spaces. Adobe RGB has a wider colorspace than sRGB. ICC profiles convert device-dependent "colors" into a common color space.By using an ICC profile and carrying out color management, you can draw out the color space of theimage data within the color reproduction area that the printer can express.
 Selecting a printing method suited to the image data The recommended printing method depends on the color space (Adobe RGB or sRGB) of the imagedata or the application software to be used. There are two typical printing methods. Check the colorspace (Adobe RGB or sRGB) of the image data and the application software to be used, and then selectthe printing method suited to your purpose.
 To print using Canon Digital Photo Color
 Target data: sRGB dataPrinting method: Adjusting Colors with the Printer Driver
 To print using the color space of the data effectively
 Target data: Adobe RGB data or sRGB dataApplication software: An ICC profile can or cannot be specified.Printing method: Printing with ICC Profiles
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Specifying Color Correction > Adjusting Colors with the Printer Driver
 Adjusting Colors with the Printer Driver You can specify the color correction function of the printer driver to print sRGB data with color tints thatmost people prefer (through the use of Canon Digital Photo Color).
 The procedure for adjusting colors with the printer driver is as follows:
 1. Open the printer driver setup window
 2. Select the media type Select the type of paper loaded in the printer from the Media Type list on the Main tab.
 3. Select the print quality Select High, Standard, or Fast for Print Quality.
 4. Select the manual color adjustment Select Manual for Color/Intensity, and click Set....The Manual Color Adjustment dialog box opens.
 5. Select color correction Click Matching tab, and select Driver Matching for Color Correction.
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6. Set the other items If necessary, click Color Adjustment tab, and adjust the color balance of Cyan, Magenta, Yellow, andadjust Brightness, Intensity, and Contrast settings, and then click OK.
 7. Complete the setup Click OK on the Main tab.When you execute print, the printer driver adjusts the colors when printing the data.
 Related Topics Selecting a Combination of the Print Quality Level and a Halftoning Method
 Specifying Color CorrectionAdjusting Color BalanceAdjusting BrightnessAdjusting IntensityAdjusting Contrast
 Page top
 Стр. 240 из 396 стр.Adjusting Colors with the Printer Driver

Page 241
                        

Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Specifying Color Correction > Printing with ICC Profiles
 Printing with ICC Profiles If the image data has a specified ICC profile, you can effectively use the color space (Adobe RGB orsRGB) of the data when printing.
 The printer driver setting procedure varies depending on the application software used to print.
 Printing image data from the application software that can specify an ICC profile When using Adobe Photoshop, Canon Digital Photo Professional, or any other application software thatallows you to specify an ICC profile, you can use the color management system (ICM) found in Windowswhen printing the data. You can print the editing and touch-up results of an application software byeffectively using the color space of the ICC profile specified in the image data. To use this printing method, you must first use an application software to specify an ICC profile in theimage data. For instructions on specifying an ICC profile with an application software program, refer tothe manual of the application software you are using.
 1. Open the printer driver setup window
 2. Select the media type Select the type of paper loaded in the printer from the Media Type list on the Main tab.
 3. Select the print quality Select High, Standard, or Fast for Print Quality.
 4. Select the manual color adjustment Select Manual for Color/Intensity, and click Set....The Manual Color Adjustment dialog box opens.
 5. Select color correction Click Matching tab, and select ICM for Color Correction.
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6. Set the other items If necessary, click Color Adjustment tab, and adjust the color balance of Cyan, Magenta, Yellow, andadjust Brightness, Intensity, and Contrast settings, and then click OK.
 7. Complete the setup Click OK on the Main tab.When you execute print, the printer uses the color space of the image data.
 Important If you print an image by specifying an individually created profile or a profile for special Canon paperin an application software, select None from the Color Correction menu of the printer driver.
 Printing image data from the application software that cannot specify an ICC profile When printing from an application software that does not allow you to specify an ICC profile, specify theICC profile in the print settings of the printer driver and print the data. When printing Adobe RGB data, youcan print the data with the Adobe RGB color space even if the application software does not supportAdobe RGB.
 1. Open the printer driver setup window
 2. Select the media type Select the type of paper loaded in the printer from the Media Type list on the Main tab.
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3. Select the print quality Select High, Standard, or Fast for Print Quality.
 4. Select the manual color adjustment Select Manual for Color/Intensity, and click Set....Manual Color Adjustment dialog box opens.
 5. Select color correction Click Matching tab, and select ICM for Color Correction.
 6. Select the input profile Select an Input Profile that matches the color space of the image data.
 For sRGB data or data without an ICC profile:
 Select Standard. For Adobe RGB data:
 Select Adobe RGB (1998).
 Important If the application software specifies an input profile, the input profile setting of the printer driverbecomes invalid. If no ICC profiles are installed on your computer, Adobe RGB (1998) is not displayed. You caninstall ICC profiles from the Setup CD-ROM that accompanies the printer.
 7. Set the other items If necessary, click Color Adjustment tab, and adjust the color balance of Cyan, Magenta, Yellow, andadjust Brightness, Intensity, and Contrast settings, and then click OK.
 8. Complete the setup Click OK on the Main tab.When you execute print, the data is printed with the color space of the selected image data.
 Related Topics Selecting a Combination of the Print Quality Level and a Halftoning Method
 Specifying Color CorrectionAdjusting Color BalanceAdjusting BrightnessAdjusting IntensityAdjusting Contrast
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Adjusting Color Balance
 Adjusting Color Balance You can adjust the color tints during printing.Since this function adjusts color balance of the output by changing the ink ratios of each color, it changesthe total color balance of the document. Use the application software if you want to change the colorbalance significantly. Use the printer driver only if you want to adjust the color balance slightly.The following sample shows the case when Color Balance is used to intensify cyan and to diminishyellow so that the overall colors are more uniform.
 No adjustment Adjusted in Color Balance
 The procedure for adjusting color balance is as follows:
 1. Open the printer driver setup window
 2. Select the manual color adjustment On the Main tab, select Manual for Color/Intensity, and click Set....
 The Manual Color Adjustment dialog box opens.
 3. Adjust color balance There are individual sliders for Cyan, Magenta, and Yellow. Each color becomes stronger when thecorresponding slider is moved to the right, and becomes weaker when the corresponding slider ismoved to the left. For example, if cyan becomes weaker, the color red becomes stronger.You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50.
 After adjusting each color, click OK.
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4. Complete the setup Click OK on the Main tab.When you execute print, the document is printed with the adjusted color balance.
 Important When the Grayscale Printing check box on the Main tab is checked, Cyan, Magenta, and Yellowappear grayed out and are unavailable.
 Related Topics Selecting a Combination of the Print Quality Level and a Halftoning Method
 Specifying Color CorrectionAdjusting BrightnessAdjusting IntensityAdjusting Contrast
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Adjusting Brightness
 Adjusting Brightness You can change the brightness of the overall image data during printing.This function does not change pure white or pure black but it changes the brightness of the intermediatecolors.The following sample shows the print result when the Brightness specification is changed.
 Light is selected Normal is selected Dark is selected
 The procedure for adjusting brightness is as follows:
 1. Open the printer driver setup window
 2. Select the manual color adjustment On the Main tab, select Manual for Color/Intensity, and click Set....
 The Manual Color Adjustment dialog box opens.
 3. Specify the brightness Select Light, Normal, or Dark for Brightness, and click OK.
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4. Complete the setup Click OK on the Main tab.When you execute print, the data is printed at the specified brightness.
 Related Topics Selecting a Combination of the Print Quality Level and a Halftoning Method
 Specifying Color CorrectionAdjusting Color BalanceAdjusting IntensityAdjusting Contrast
 Page top
 Стр. 248 из 396 стр.Adjusting Brightness

Page 249
                        

Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Adjusting Intensity
 Adjusting Intensity You can dilute (brighten) or intensify (darken) the colors of the overall image data during printing.If you want to sharpen the print results, you should intensify the colors.The following sample shows the case when the intensity is increased so that all colors become moreintense when the image data is printed.
 No adjustment Higher Intensity
 The procedure for adjusting intensity is as follows:
 1. Open the printer driver setup window
 2. Select the manual color adjustment Select Manual for Color/Intensity on the Main tab, and click Set....
 The Manual Color Adjustment dialog box opens.
 3. Adjust intensity Moving the Intensity slider to the right intensifies (darkens) the colors. Moving the slider to the leftdilutes (brightens) the colors.You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. After adjusting each color, click OK.
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Important Adjust the slider gradually.
 4. Complete the setup Click OK on the Main tab.When you execute print, the image data is printed with the adjusted intensity.
 Related Topics Selecting a Combination of the Print Quality Level and a Halftoning Method
 Specifying Color CorrectionAdjusting Color BalanceAdjusting BrightnessAdjusting Contrast
 Page top
 Стр. 250 из 396 стр.Adjusting Intensity

Page 251
                        

Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Adjusting Contrast
 Adjusting Contrast You can adjust the image contrast during printing.To make the differences between the light and dark portions of images greater and more distinct,increase the contrast. On the other hand, to make the differences between the light and dark portions ofimages smaller and less distinct, reduce the contrast.
 No adjustment Adjust the contrast
 The procedure for adjusting contrast is as follows:
 1. Open the printer driver setup window
 2. Select the manual color adjustment On the Main tab, select Manual for Color/Intensity, and click Set....
 The Manual Color Adjustment dialog box opens.
 3. Adjust the contrast Moving the Contrast slider to the right increases the contrast, and moving it to the left decreases thecontrast.You can also directly enter a value linked to the slider. Enter a value in the range from -50 to 50. After adjusting each color, click OK.
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4. Complete the setup Click OK on the Main tab.When you execute print, the image is printed with the adjusted contrast.
 Related Topics Selecting a Combination of the Print Quality Level and a Halftoning Method
 Specifying Color CorrectionAdjusting Color BalanceAdjusting BrightnessAdjusting Intensity
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Simulating an Illustration
 Simulating an Illustration With the Simulate Illustration function, you can print full-color or 256-color image data so that it looks likea hand-drawn illustration. You can add different effects to the original profile and colors.
 The procedure for performing Simulate Illustration is as follows:
 1. Open the printer driver setup window
 2. Set the Simulate Illustration Check the Simulate Illustration check box on the Effects tab, and adjust the Contrast as necessary.Moving the slider to the right lightens the image data and moving the slider to the left darkens theimage data.The current settings are displayed in the Settings Preview on the left side of the printer driver.
 3. Complete the setup Click OK.When you execute print, the image will be printed so that it looks hand-drawn.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Representing Image Data with a Single Color
 Representing Image Data with a Single Color With the Monochrome Effects function, you can benefit from coloring effects such as changing aphotograph to a sepia tone image.
 The procedure for performing Monochrome Effects is as follows:
 1. Open the printer driver setup window
 2. Set Monochrome Effects Check the Monochrome Effects check box on the Effects tab and select your desired color.If you use Select Color, move the Color slider to specify the color you want.The current settings are displayed in the Settings Preview on the left side of the printer driver.
 3. Complete the setup Click OK.When you execute print, the image will be printed with a single color.
 Important When the Grayscale Printing check box on the Main tab is checked, Monochrome Effects appearsgrayed out and is unavailable.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Presenting Image Data with Vivid Colors
 Presenting Image Data with Vivid Colors The Vivid Photo function allows you to print image data with vivid colors.The notable feature of Vivid Photo is that it emphasizes the colors in background sceneries whilemaintaining the human skin color natural. By using this function, you can make vivid hues appear evenmore vivid.
 The procedure for performing Vivid Photo is as follows:
 1. Open the printer driver setup window
 2. Set Vivid Photo Check the Vivid Photo check box on the Effects tab.
 3. Complete the setup Click OK.When you execute print, the image will be printed with vivid colors.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Smoothing Jagged Outlines
 Smoothing Jagged Outlines The Image Optimizer function allows you to smooth jagged outlines in photos and graphics that havebeen enlarged with your application. This feature is especially useful when printing low-resolutionimages from Web pages.
 The procedure for performing Image Optimizer is as follows:
 1. Open the printer driver setup window
 2. Perform Image Optimizer Check the Image Optimizer check box on the Effects tab.
 3. Complete the setup Click OK.The photos and graphics will be printed with jagged outlines smoothed.
 Note
 Depending on application software or resolution of image data, the Image Optimizer may have nodiscernible effects. It may take longer to complete printing if the Image Optimizer is used.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Changing Color Properties to Improve Coloration
 Changing Color Properties to Improve Coloration The Photo Optimizer PRO function corrects colors of digital camera images or scanned images. It isspecially designed to compensate for color shift, overexposure, and underexposure.
 The procedure for performing Photo Optimizer PRO is as follows:
 1. Open the printer driver setup window
 2. Set the Auto Photo mode Check the Photo Optimizer PRO check box on the Effects tab.
 Normally there is no need to check the Apply Throughout Page check box.Images within each page are optimized on an image-by-image basis.
 Note
 Check the Apply Throughout Page check box when printing image data that has beenprocessed, such as being cropped or rotated. In this case the entire page will be treated as asingle image to be optimized.
 3. Complete the setup Click OK.When you execute print, the images will be printed with color compensation.
 Important Photo Optimizer PRO does not function when:
 Background is set in the Stamp/Background dialog box on the Page Setup tab. Define Stamp... is selected in the Stamp/Background dialog box on the Page Setup tab, and thebitmapped stamp is configured.
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Note
 Depending on images, the Photo Optimizer PRO may have no discernible effect.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Changing the Print Quality andCorrecting Image Data > Reducing Photo Noise
 Reducing Photo Noise With the Photo Noise Reduction function, you can reduce the digital camera noise and improve theimage quality of the digital print.
 The procedure for performing Photo Noise Reduction is as follows:
 1. Open the printer driver setup window
 2. Set Photo Noise Reduction Check the Photo Noise Reduction check box on the Effects tab and select Normal or Strong for thelevel.
 3. Complete the setup Click OK.When you execute print, the image will be printed with the digital camera noise being reduced.
 Note
 It is recommended to select Normal for most cases. Select Strong if you have selected Normal andthe noise still bothers you. Depending on application software or resolution of image data, effects of digital camera noisereduction may not be obvious. When this function is used for other than photos taken by digital cameras, image may be distorted.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Overview of the Printer Driver> Overview of the Printer Driver
 Overview of the Printer DriverCanon IJ Printer Driver
 How to Open the Printer Driver Setup Window
 Maintenance Tab
 Canon IJ Status Monitor
 The Canon IJ Preview
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Overview of the Printer Driver> Canon IJ Printer Driver
 Canon IJ Printer Driver The Canon IJ printer driver is software that is installed on your computer for printing data on this printer. The Canon IJ printer driver converts the print data created by your Windows application into data that yourprinter can understand and sends the converted data to the printer. Because the format of print data varies depending on the your model, you need to have a Canon IJprinter driver for the specific model you are using.
 How to Use Help You can display the Help describing the driver setting items through the Printing Preferences screen ofthe Canon IJ printer driver.
 To view all descriptions of a tab...
 Click the Help button on each tab.A description for each item on the tab appears. You can also display a description for a dialog box by clicking the link that appears on thecorresponding tab.
 To see a description for each item... Right-click the item you want to learn about and then click Help.Alternatively, if the [Help] button is found at the right end of the title bar, click that button, andthen click the item you want to learn about.A description of the item is displayed.
 Related Topic How to Open the Printer Driver Setup Window
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Overview of the Printer Driver> Canon IJ Printer Driver > How to Open the Printer Driver Setup Window
 How to Open the Printer Driver Setup Window The printer driver setup window can be displayed through the application software in use or the Startmenu of the Windows.
 Note
 This guide mainly describes operations on the Windows Vista. Operations may differ depending onversions of the Windows.
 Open the Printer Driver Setup Window through the Application Software Follow the procedure below to configure print settings when printing.
 1. Select the command you perform printing on the application software in use In general, select Print on the File menu to open the Print dialog box.
 2. Select your model name and click Preferences (or Properties) The printer driver setup window appears.
 Note
 Depending on application software you use, command names or menu names may vary andthere may be more steps. For details, refer to the user's manual of your application software.
 Open the Printer Driver Setup Window through the Start Menu Follow the procedure below to perform maintenance operations such as print head cleaning, or toconfigure print settings that are common for all application software.
 1. Select items from the Start menu as shown below: In Windows Vista, select the Start menu -> Control Panel -> Hardware and Sound -> Printers. In Windows XP, select the Start menu -> Control Panel -> Printers and Other Hardware ->Printers and Faxes. In Windows 2000, select the Start menu -> Settings -> Printers.
 2. Right-click your model name icon, and then select Printing Preferences from thedisplayed menu. The printer driver setup window appears.
 Important Opening the printer driver setup window through Properties displays such tabs regarding theWindows functions as the Ports (or Advanced) tab. Those tabs do not appear when openingthrough Printing Preferences or application software. About tabs regarding Windows functions,refer to the user's manual for the Windows.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Overview of the Printer Driver> Canon IJ Printer Driver > Maintenance Tab
 Maintenance Tab The Maintenance tab allows you to perform printer maintenance or change the settings of the printer.
 Features Cleaning the Print HeadsCleaning the Paper Feed RollersAligning the Print Head PositionChecking the Print Head NozzlesSetting the Paper Source for Plain Paper
 Cleaning Inside the PrinterManaging the Printer Power
 Related features Reducing the Printer Noise/Quiet ModeChanging the Printer Operation Mode
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Overview of the Printer Driver> Canon IJ Status Monitor
 Canon IJ Status Monitor The Canon IJ Status Monitor is an application software that shows the status of the printer and theprogress of printing on the Windows screen. You will know the status of the printer with graphics, icons,and messages.
 Launching the Canon IJ Status Monitor The Canon IJ Status Monitor launches automatically when data is sent to the printer. When launched, theCanon IJ Status Monitor appears as a button on the Task Bar.
 Click the Status Monitor button displayed on the Task Bar. The Canon IJ Status Monitor appears.
 Note
 To open the Canon IJ Status Monitor when the printer is not printing, open the printer driver setupwindow and click View Printer Status... on the Maintenance tab.
 When Errors Occur The Canon IJ Status Monitor is automatically displayed when an error occurs (e.g., if the printer runs outof paper or if the ink is low).
 In such cases, take the appropriate action as described.
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Advanced Guide > Printing from a Computer > Printing with Other Application Software > Overview of the Printer Driver> The Canon IJ Preview
 The Canon IJ Preview The Canon IJ Preview is an application software that displays what the print result will look like before adocument is actually printed.
 The preview reflects the information that is set within the printer driver and allows you to check thedocument layout, print sequence, and number of pages. You can also change the media type and papersource settings. If you want to display a preview before printing, open the printer driver setup window , click the Main tab,and check the Preview before printing check box. If you do not want to display a preview before printing, uncheck the check box.
 Related Topic Displaying the Print Results before Printing
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Advanced Guide > Printing on DVD/CDs
 Printing on DVD/CDsPrinting on the Label Side of DVD/CDsTroubleshooting
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Advanced Guide > Printing on DVD/CDs > Printing on the Label Side of DVD/CDs
 Printing on the Label Side of DVD/CDsItems to PrepareCautions When Printing on DVD/CDsAttaching/Removing the CD-R Tray
 Printing on the Label Side of DVD/CDsPrinting with CD-LabelPrint from the ComputerPrinting from a PictBridge Compliant DevicePrinting Area
 Page top
 Стр. 267 из 396 стр.Printing on the Label Side of DVD/CDs

Page 268
                        

Advanced Guide > Printing on DVD/CDs > Printing on the Label Side of DVD/CDs > Items to Prepare
 Items to PrepareThe following items are needed to print on DVD/CDs:
 CD-R Tray
 "G" is on the upper side.
 8 cm CD-R Adapter
 Needed only when printing on 8 cm DVD/CDs.Attached to the CD-R Tray when shipped.
 ImportantYou cannot print on 8 cm DVD/CDs from a PictBridge compliant device. You need to print fromthe computer to print on 8 cm DVD/CDs.
 Printable DVD/CDsObtain a 12 cm or 8 cm DVD/CD with a label surface compatible with inkjet printing.A "printable disc" differs from regular DVD/CDs in that its label surface has been speciallyprocessed to be printed on by an inkjet printer.
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Advanced Guide > Printing on DVD/CDs > Printing on the Label Side of DVD/CDs > Cautions When Printing on DVD/CDs
 Cautions When Printing on DVD/CDsBe sure to use the CD-R Tray supplied with this printer. It has an "G" on the upper side.Do not print on DVD/CDs that are not compatible with ink-jet printing. The ink will not dry and maycause problems with the disc itself or devices which the disc is loaded onto.Do not print on the DVD/CDs' recording surface. Doing so will make data recorded on DVD/CDsunreadable.Hold DVD/CDs by their edges. Do not touch either the label surface (printing surface) or recordingsurface.Remove any dirt from the CD-R Tray before placing DVD/CDs on the CD-R Tray. Loading discs in adirty CD-R Tray may scratch the recording surface of the discs.After printing, allow the printing surface of the disc to dry naturally. Do not use hairdryers or exposethe disc to direct sunlight to dry the ink. Do not touch the printing surface until the ink has dried.Do not attach the CD-R Tray while the printer is in operation.Do not remove the CD-R Tray while printing on DVD/CDs. Doing so may damage the printer, the CD-R Tray, or the disc.Do not get dirt or scratches on the reflectors of the CD-R Tray. The printer may not be able torecognize loading of the DVD/CD, or printing may become misaligned. If the reflectors on the CD-RTray become dirty, wipe the reflector clean with a soft, dry cloth, taking care not to scratch the plate.The CD-R Tray may become dirty if software other than CD-LabelPrint or Easy-PhotoPrint EX isused.Always use the supplied 8 cm CD-R Adapter when printing on 8 cm DVD/CDs.Always close the Inner Cover after printing on DVD/CDs.
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Advanced Guide > Printing on DVD/CDs > Printing on the Label Side of DVD/CDs > Attaching/Removing the CD-R Tray
 Attaching/Removing the CD-R Tray
 Attaching the CD-R Tray
 1. Open the Paper Output Tray (A), then open the Inner Cover (B).
 2. Place the DVD/CD.
 ImportantMake sure that there is no dirt on the CD-R Tray before placing the DVD/CD on the CD-RTray.When placing the DVD/CD on the CD-R Tray, do not touch the printing surface of the discor the reflectors (C) on the CD-R Tray. When printing on an 8 cm DVD/CD, attach the supplied 8 cm CD-R Adapter. If you do not,printing quality will be reduced and the DVD/CD may become damaged.
 12 cm DVD/CD:1. Place the disc on the CD-R Tray with the printable surface facing up.
 Do not touch the reflectors (C).
 8 cm DVD/CD:1. Align the protrusions on both edge of the 8 cm CD-R Adapter with indentations on
 the CD-R Tray.
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2. Place the 8 cm disc on the CD-R Tray with the printing surface facing up.
 3. Place the CD-R Tray.
 ImportantDo not attach the CD-R Tray until the message asking you to load the DVD/CD isdisplayed. Doing so can damage the printer.
 Note
 The CD-R Tray may be ejected after a specified period of time has elapsed. In this case,follow the on-screen instructions to place the CD-R Tray.
 4. Insert the CD-R Tray straightly until the arrow ( ) on the Inner Cover is almost aligned
 with the arrow ( ) on the CD-R Tray.
 (D) Keep the CD-R Tray level when inserting it.
 (E) Align the arrow ( ) on the CD-R Tray with the arrow ( ) on the Inner Cover.
 Important
 Do not insert the CD-R Tray beyond the arrow ( ) on the Inner Cover.
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Removing the CD-R Tray
 1. Pull out the CD-R Tray.
 2. Close the Inner Cover.
 ImportantIf the Inner Cover is opened, you cannot print on paper as it will not feed properly. Makesure that the Inner Cover is closed.
 3. Remove the DVD/CD.
 Caution
 Do not touch the printable surface when removing the disc from the CD-R Tray.
 Note
 Dry the printing surface sufficiently before removing the disc. If you see printing on theCD-R Tray or the transparent parts on inner or outer diameter of DVD/CD, wipe them offafter the printing surface is dry.
 12 cm DVD/CD:1. Remove the disc from the CD-R Tray.
 8 cm DVD/CD:1. Remove the 8 cm CD-R Adapter from the CD-R Tray.
 Стр. 272 из 396 стр.Attaching/Removing the CD-R Tray

Page 273
                        

2. Remove the 8 cm disc from the CD-R Tray.
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Advanced Guide > Printing on DVD/CDs > Printing on the Label Side of DVD/CDs > Printing on the Label Side of DVD/CDs
 Printing on the Label Side of DVD/CDsThe CD-R Tray (supplied) allows the printing of images on printable DVD/CDs.CD-LabelPrint is bundled application software that allows you to edit and modify data before printing.Install it on your computer to use it.
 Printing with CD-LabelPrint from the Computer
 Note
 We recommend that you test print on an unneeded printable DVD/CD first.
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Advanced Guide > Printing on DVD/CDs > Printing on the Label Side of DVD/CDs > Printing with CD-LabelPrint from theComputer
 Printing with CD-LabelPrint from the ComputerCD-LabelPrint is bundled application software that allows you to edit and modify data beforeprinting. Install it on your computer to use it. For information on how to install this software, refer toyour setup manual.For details on how to print with CD-LabelPrint, refer to its manual.If you are using Windows, click Start > All Programs (or Programs in Windows 2000) > CD-LabelPrint > Help.If you are using a Macintosh, open Application folder in the location where the MP Drivers wereinstalled > CD-LabelPrint folder > Manual folder > double-click Manual.htm.
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Advanced Guide > Printing on DVD/CDs > Printing on the Label Side of DVD/CDs > Printing from a PictBridge CompliantDevice
 Printing from a PictBridge Compliant DeviceThis section describes how to print photos on DVD/CDs (printable discs) from a PictBridge compliantdevice.
 ImportantDepending on your PictBridge compliant device, you may not be able to print on the label side ofDVD/CDs.For details, refer to the instruction manual of your PictBridge compliant device.You cannot print on 8 cm DVD/CDs.
 1. Make sure that the printer is turned on.
 2. Connect the PictBridge compliant device to the printer using a USB cablerecommended by the manufacturer of the device.For details, refer to Printing Photographs Directly from a Compliant Device .
 3. Specify the print settings as followsPaper size: 12cmDVD/CDPaper type: DefaultLayout: Bordered or Default
 You can make image optimize settings using the menu on the LCD of your PictBridge compliantdevice. For details, refer to About PictBridge Print Settings .
 4. Set the printable DVD/CD.Attaching/Removing the CD-R Tray
 5. Start printing from your PictBridge compliant device.
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Advanced Guide > Printing on DVD/CDs > Printing on the Label Side of DVD/CDs > Printing Area
 Printing Area
 Printable DVD/CDsThe printing area of both printable DVDs and CDs is the area excluding the 1 mm area from theinternal and external diameters of the label.
 Recommended printing area
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Advanced Guide > Printing on DVD/CDs > Troubleshooting
 TroubleshootingMessage Appears on the Computer ScreenCannot Print on DVD/CDsError Message Appears on a PictBridge Compliant Device
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Advanced Guide > Printing on DVD/CDs > Troubleshooting > Message Appears on the Computer Screen
 Message Appears on the Computer Screen
 Errors About DVD/CD Printing Are Displayed
 Message: 1001 Is Displayed
 Error Number: 1002 Is Displayed
 Message: 1850 Is Displayed
 Errors About DVD/CD Printing Are Displayed
 Check 1: Is the CD-R Tray placed properly?Open the Inner Cover, properly place the CD-R Tray again, then press the RESUME/CANCELbutton.Make sure that you are using the CD-R Tray supplied with the printer ("G" is on the upperside).For details on how to place the CD-R Tray, see Attaching/Removing the CD-R Tray .
 Check 2: Is the DVD/CD placed on the CD-R Tray?Properly place the DVD/CD on the CD-R Tray, attach the CD-R Tray again, then press the RESUME/CANCEL button.
 Make sure that you are using the CD-R Tray supplied with this printer ("G" is on the upperside).For details on how to place the CD-R Tray, see Attaching/Removing the CD-R Tray .
 Check 3: Unrecognizable DVD/CD may be placed.Canon recommends that you use DVD/CDs specially processed to be printed on by an inkjetprinter.
 Check 4: Is the DVD/CD on the CD-R Tray already printed?If you place the DVD/CDs on which have already been printed on the CD-R Tray, the CD-RTray is ejected.
 In this case, change the settings of the printer driver and try printing again.Clear the Detects a printable disc in the CD-R tray check box in Custom Settings onthe Maintenance tab, then click Send.When printing is over, select the Detects a printable disc in the CD-R tray check boxand click Send.
 NoteIf the Detects a printable disc in the CD-R tray check box is cleared, printing may startwithout the DVD/CD loaded. Selecting the check box prevents the CD-R Tray from gettingdirty.
 Check 5: Is the Inner Cover opened when starting printing on paper, or whileprinting is in progress?Close Inner Cover, then press the RESUME/CANCEL button on the printer.
 Do not open or close the Inner Cover while printing is in progress. This may damage theprinter.
 Message: 1001 Is Displayed
 Check: Place the CD-R Tray properly.Place the CD-R Tray properly, then press the RESUME/CANCEL button.
 Make sure that you are using the CD-R Tray supplied with the printer ("G" is on the upperside).
 Стр. 279 из 396 стр.Message Appears on the Computer Screen

Page 280
                        

For details on how to place the CD-R Tray, see Attaching/Removing the CD-R Tray .
 Error Number: 1002 Is Displayed
 Check 1: Place the DVD/CD on the CD-R Tray properly.Place the DVD/CD on the CD-R Tray properly, then press the RESUME/CANCEL button on theprinter.Make sure that you are using the CD-R Tray supplied with the printer ("G" is on the upperside).For details on how to place the CD-R Tray, see Attaching/Removing the CD-R Tray .
 Check 2: Unrecognizable DVD/CD may be placed.Canon recommends that you use DVD/CDs specially processed to be printed on by an inkjetprinter.
 Check 3: Is the DVD/CD on the CD-R Tray already printed?If you place the DVD/CDs on which have already been printed on the CD-R Tray, the CD-RTray is ejected.
 In this case, change the settings of the printer driver and try printing again.Clear the Detects a printable disc in the CD-R tray check box in Custom Settings onthe Canon IJ Printer Utility dialog box, then click Send.When printing is over, select the Detects a printable disc in the CD-R tray check boxand click Send.
 NoteIf the Detects a printable disc in the CD-R tray check box is cleared, printing may startwithout the DVD/CD loaded. Selecting the check box prevents the CD-R Tray from gettingdirty.
 Message: 1850 Is Displayed
 Check: Open the Inner Cover, then place the CD-R Tray properly.Open the Inner Cover, place the CD-R Tray properly, then press the RESUME/CANCEL button.
 For details on how to place the CD-R Tray, see Attaching/Removing the CD-R Tray .
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Advanced Guide > Printing on DVD/CDs > Troubleshooting > Cannot Print on DVD/CDs
 Cannot Print on DVD/CDsDVD/CD Printing Does Not Start
 CD-R Tray Does Not Feed Properly
 CD-R Tray Jammed
 DVD/CD Printing Does Not Start
 Check 1: Is the CD-R Tray placed properly?Open the Inner Cover, properly place the CD-R Tray again, then press the RESUME/CANCELbutton.Use the CD-R Tray supplied with this printer ("G" is on the upper side).For details on how to place the CD-R Tray, see Attaching/Removing the CD-R Tray .
 Check 2: Is the DVD/CD placed on the CD-R Tray?Place the DVD/CD on the CD-R Tray properly, then press the RESUME/CANCEL button on theprinter.
 Make sure that you are using the CD-R Tray supplied with the printer ("G" is on the upperside).For details on how to place the CD-R Tray, see Attaching/Removing the CD-R Tray .
 Check 3: If DVD/CD printing stops before it is complete, try the operation again.If a certain period of time has elapsed while DVD/CD printing is in progress, the printer stopsinitializing.If you press the RESUME/CANCEL button, the printer resumes initializing.Try the operation again following the on-screen instructions.
 CD-R Tray Does Not Feed Properly
 Check 1: Is the CD-R Tray placed properly?Properly place the CD-R Tray again, then press the RESUME/CANCEL button.
 Make sure that you are using the CD-R Tray supplied with the printer ("G" is on the upperside).For details on how to place the CD-R Tray, see Attaching/Removing the CD-R Tray .
 Check 2: Unrecognizable DVD/CD may be placed.Canon recommends that you use DVD/CDs specially processed to be printed on by an inkjetprinter.
 Check 3: Is the DVD/CD on the CD-R Tray already printed?If you place the DVD/CDs on which have already been printed on the CD-R Tray, the CD-RTray is ejected.
 In this case, change the settings of the printer driver and try printing again.
 Clear the Detects a printable disc in the CD-R tray check box in Custom Settings onthe Maintenance tab, then click Send.When printing is over, select the Detects a printable disc in the CD-R tray check boxand click Send.
 Clear the Detects a printable disc in the CD-R tray check box in Custom Settings onthe Canon IJ Printer Utility dialog box, then click Send.When printing is over, select the Detects a printable disc in the CD-R tray check boxand click Send.
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NoteIf you left cleared Detects a printable disc in the CD-R tray check box and start printinganother DVD/CD, printing may start without the DVD/CD loaded. Selecting the check boxprevents the CD-R Tray from getting dirty.
 CD-R Tray JammedPull out the CD-R Tray gently.
 If the CD-R Tray cannot be pulled out, turn the printer off and then turn the printer back on again.The CD-R Tray will automatically be ejected.
 When the CD-R Tray is pulled out, place the CD-R Tray again, with an "G" on the upper side, andretry printing. Place the DVD/CD properly.
 Attaching/Removing the CD-R Tray
 If the CD-R Tray is still jammed, check if there is a problem with the DVD/CD.CD-R Tray Does Not Feed Properly
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Advanced Guide > Printing on DVD/CDs > Troubleshooting > Error Message Appears on a PictBridge Compliant Device
 Error Message Appears on a PictBridge Compliant DeviceThe following are the possible errors that may occur when printing directly from a PictBridge compliantdevice and the countermeasures to clear them.
 Note
 For the errors indicated on the PictBridge compliant device and their solution, also refer to theinstruction manual of the device. For other troubles on the device, contact the manufacturer.
 Error Message On PictBridgeCompliant Device Action
 "No paper" See Cannot Print on DVD/CDs and take the appropriateaction.
 "Paper Error" See Cannot Print on DVD/CDs and take the appropriateaction.
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Advanced Guide > Printing Photographs Directly from a Compliant Device
 Printing Photographs Directly from a Compliant DevicePrinting Photographs Directly from a Compliant Device
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Advanced Guide > Printing Photographs Directly from a Compliant Device > Printing Photographs Directly from aCompliant Device
 Printing Photographs Directly from a Compliant DevicePrinting Photographs Directly from a Compliant DeviceAbout PictBridge Print Settings
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Advanced Guide > Printing Photographs Directly from a Compliant Device > Printing Photographs Directly from aCompliant Device > Printing Photographs Directly from a Compliant Device
 Printing Photographs Directly from a Compliant DeviceYou can connect a PictBridge compliant device such as a digital camera, camcorder, or mobile phoneusing a USB cable recommended by the device's manufacturer, and print recorded images directlywithout using a computer.
 Note
 When printing photos with the PictBridge compliant device connected to the printer, we recommendthe use of the AC adapter supplied with the device. If you are using the device battery, be sure tocharge it fully.Depending on the model or brand of your device, you may have to select a print mode compliantwith PictBridge before connecting the device. You may also have to turn on the device or select Playmode manually after connecting the device to the printer.Perform necessary operations on the PictBridge compliant device before connecting it to this printeraccording to instructions given in the device's instruction manual.
 1. Make sure that the printer is turned on.
 2. Load paper.
 3. Make sure that the PictBridge compliant device is turned off.
 4. Connect the PictBridge compliant device to the printer using a USB cable (A)recommended by the manufacturer of the device.The PictBridge compliant device turns on automatically.If your device does not turn on automatically, turn it on manually.
 will appear on the LCD of the device when the printer is correctly connected.
 5. Specify the print settings such as paper type and layout.You can perform settings using the menu on the LCD of your PictBridge compliant device. Select the
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size and type of paper that you loaded in the printer.Settings on a PictBridge Compliant Device
 6. Start printing from your PictBridge compliant device.
 ImportantNever disconnect the USB cable during printing unless when explicitly allowed to by thePictBridge compliant device. When disconnecting the USB cable between the PictBridgecompliant device and printer, follow the instructions given in the device's instruction manual.
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Advanced Guide > Printing Photographs Directly from a Compliant Device > Printing Photographs Directly from aCompliant Device > About PictBridge Print Settings
 About PictBridge Print Settings
 Settings on a PictBridge Compliant DeviceThis section describes the PictBridge function of the printer. For the print settings on a PictBridgecompliant device, refer to the instructions given in the device's instruction manual.
 Note
 In the following description, names of setting items are given according to those used inCanon-brand PictBridge compliant devices. Setting item names may be different dependingon the brand or model of your device.Some setting items explained below may not be available on some devices. When youcannot change print settings on a device, the printer prints images as follows:Paper size: 4" x 6"/101.6 x 152.4 mmPaper type: PhotoLayout: 1-up, BorderlessDate/File No. Print: Not printedImage Optimize: The Photo optimizer pro function will be used for optimized printing.
 The following sizes and types of printing paper can be used when printing from a PictBridgecompliant device.
 Paper size 4" x 6"/10 x 15 cm, 5" x 7"*1, 8" x 10"/ 20 x 25 cm, A4, 8.5" x 11"(Letter), 4" x 7.1"/ 10.1x 18 cm*2*1 Can be selected only on certain Canon-brand PictBridge compliant devices.(May not be selected depending on the device.)*2 Hi Vision may appear on a non-Canon brand PictBridge compliant device.
 Paper type Default: Photo Paper Plus Glossy II PP-201Photo:Photo Paper Plus Glossy II PP-201*1/Glossy Photo Paper "Everyday Use" GP-501/Photo Paper Glossy GP-502/Photo Paper Plus Semi-gloss SG-201/PhotoStickers** When printing on sticker paper, select 10 x 15 cm/4" x 6" in Paper size. Do notset Layout to Borderless.Fast Photo:Photo Paper Pro PR-201Plain:A4/LetterWhen Paper type is set to Plain, borderless printing will be disabled even whenLayout is set to Borderless.
 Layout Default (Borderless), Index, Bordered, Borderless, N-up (2, 4, 9, 16)*1, 20-up*2, 35-up*3*1 Layout compatible with A4-sized paper and Canon-brand sticker above.A4: 4-upPhoto Stickers: 2-up, 4-up, 9-up, 16-up.*2 With a Canon brand PictBridge compliant device, selecting items with "i" markallows you to print shooting info (Exif Data) in list format (20-up) or on the marginsof the specified data (1-up). (May not be available with some Canon-brandPictBridge compliant devices.)*3 Printed in 35 mm Film Style Layout (Contact Printing Layout). Available only witha Canon-brand PictBridge compliant device. (May not be available with someCanon-brand PictBridge compliant devices.)
 Print date &file no.
 Default (Off: No printing), Date, File No., Both, Off
 Imageoptimize
 Default *1*2, On (Exif Print), Off, NR (Noise Reduction)*2, VIVID*2, Face*2, Red-Eye*2*1 Photos are optimized for printing using the Photo optimizer pro function.*2 Can be selected only on certain Canon-brand PictBridge compliant devices.(May not be selected depending on the device.)
 Trimming Default (Off: No trimming), On (follow camera's setting), Off
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Advanced Guide > Maintenance
 MaintenanceCleaning Your PrinterPerforming Maintenance from a Computer
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Advanced Guide > Maintenance > Cleaning Your Printer
 Cleaning Your PrinterCleaningCleaning the Exterior of the Printer
 Cleaning the Protrusions Inside the Printer
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Advanced Guide > Maintenance > Cleaning Your Printer > Cleaning
 CleaningThis section describes the cleaning procedure that is needed to maintain your printer.
 Caution
 Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so asnot to scratch the surface. Paper tissue powders or fine threads may remain inside the printer andcause problems such as Print Head blockage and poor printing results. Be sure to use a soft cloth.Never use volatile liquids such as thinners, benzene, acetone, or any other chemical cleaner toclean the printer, as this may cause a malfunction or damage the printer's surface.
 Cleaning the Exterior of the Printer
 Cleaning the Protrusions Inside the Printer
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Advanced Guide > Maintenance > Cleaning Your Printer > Cleaning the Exterior of the Printer
 Cleaning the Exterior of the PrinterBe sure to use a soft cloth such as eyeglasses cleaning cloth and wipe off dirt on the surface gently.Smooth out wrinkles on the cloth if necessary before cleaning.
 Caution
 Be sure to turn off the power and disconnect the power plug before cleaning the printer.Do not use tissue paper, paper towels, rough-textured cloth, or similar materials, as this mayscratch the surface.
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Advanced Guide > Maintenance > Cleaning Your Printer > Cleaning the Protrusions Inside the Printer
 Cleaning the Protrusions Inside the PrinterIf protrusions inside the printer are stained, wipe off any ink from the protrusions using a cotton swab orthe like.
 Caution
 Be sure to turn off the power and disconnect the power plug before cleaning the printer.
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Advanced Guide > Maintenance > Performing Maintenance from a Computer
 Performing Maintenance from a ComputerCleaning the Print HeadsCleaning the Paper Feed RollersAligning the Print Head PositionManual Print Head AlignmentChecking the Print Head NozzlesCleaning Inside the Printer
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Advanced Guide > Maintenance > Performing Maintenance from a Computer > Cleaning the Print Heads
 Cleaning the Print Heads The print head cleaning function allows you to remove any blockages in the print head nozzles. Performprint head cleaning if printing is faint or a specific color fails to print, even though there is enough ink.
 The procedure for cleaning the print heads is as follows:
 Cleaning
 1. Open the printer driver setup window
 2. Click Cleaning on the Maintenance tab The Print Head Cleaning dialog box opens. Follow the instruction shown in the dialog box.Click Initial Check Items to display the items you need to check before performing Cleaning.
 3. Execute cleaning Make sure that the printer is on and then click Execute. Print head cleaning starts.
 4. Complete cleaning Click OK when the confirmation message appears.Next, the Nozzle Check dialog box opens.
 5. Check the results To check whether the print quality has improved, click Print Check Pattern. To cancel the checkprocess, click Cancel. If cleaning the head once does not resolve the print head problem, clean it once more.
 Deep Cleaning Deep Cleaning is more thorough than Cleaning. Perform deep cleaning when two cleaning attempts donot resolve the print head problem.
 1. Open the printer driver setup window
 2. Click Deep Cleaning on the Maintenance tab The Deep Cleaning dialog box opens. Follow the instruction shown in the dialog box.Click Initial Check Items to display the items you need to check before performing Deep Cleaning.
 3. Make sure that the printer is on and then click Execute. Click OK when the confirmation message appears. Print head deep cleaning starts.
 Important Cleaning consumes a small amount of ink. Deep Cleaning consumes a larger amount of ink thanCleaning.Cleaning the print heads frequently will rapidly deplete your printer's ink supply. Consequently,perform cleaning only when necessary.
 Note
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If there is no sign of improvement after Deep Cleaning, switch off the printer, wait 24 hours, andthen perform Deep Cleaning again. If there is still no sign of improvement, the ink may have run outor the print head may be worn. For details on the remedial action to be taken, see " Printer MovesBut Ink Is Not Ejected."
 Related Topic Checking the Print Head Nozzles
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Advanced Guide > Maintenance > Performing Maintenance from a Computer > Cleaning the Paper Feed Rollers
 Cleaning the Paper Feed Rollers The feed roller cleaning function allows you to clean the paper feed roller. Perform feed roller cleaningwhen there are paper particles sticking to the paper feed roller and paper is not fed properly.
 The procedure for cleaning the feed rollers is as follows:
 Roller cleaning
 1. Prepare the printer Remove all sheets of paper from the paper source from which paper could not be properly fed.
 2. Open the printer driver setup window
 3. Click Roller Cleaning on the Maintenance tab The Roller Cleaning dialog box opens.
 4. Select Rear Tray or Cassette, and click OK The confirmation message appears.
 5. Execute paper feed roller cleaning Make sure that the printer is on and click OK.Paper feed roller cleaning starts.
 6. Complete paper feed roller cleaning After the rollers have stopped, follow the instruction in the message, load three sheets of plainpaper into the selected paper source of the printer, and click OK. Paper will be ejected and feed roller cleaning will be completed.
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Advanced Guide > Maintenance > Performing Maintenance from a Computer > Aligning the Print Head Position
 Aligning the Print Head Position Print head alignment corrects the installation positions of the print head and improves deviated colorsand lines.
 This printer supports two head alignment methods: automatic head alignment and manual headalignment. Normally, the printer is set for automatic head alignment.If the printing results are unsatisfactory even after you execute automatic head alignment, see " Aligningthe Print Head Manually ," and execute manual head alignment. To change to the manual headalignment, click Custom Settings on the Maintenance tab, and then check the Align heads manuallycheck box.
 The procedure for performing print head alignment is as follows:
 Print Head Alignment
 1. Open the printer driver setup window
 2. Click Print Head Alignment on the Maintenance tab The Start Print Head Alignment dialog box opens.
 3. Load paper in the printer Load a sheet of A4 size or Letter size Matte Photo Paper (MP-101) into the rear tray.
 Note
 The type of media and number of sheets to be used differ if you select the manual headalignment.
 4. Execute head alignment Make sure that the printer is on and click Align Print Head.Follow the instruction in the message.
 Note
 To check the current setting before you adjust the print head position, click Print AlignmentValue.
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Advanced Guide > Maintenance > Performing Maintenance from a Computer > Manual Print Head Alignment
 Manual Print Head AlignmentThis section describes how to align the Print Head manually.If the results of Automatic Print Head Alignment are not satisfactory, follow the procedure below toperform Manual Print Head Alignment to precisely align the Print Head.For details on performing Automatic Print Head Alignment, see Routine Maintenance.
 Note
 Close the Inner Cover if it is opened.The print head alignment pattern is printed in black and blue only.
 1. Make sure that the printer is turned on.
 2. Load three sheets of A4 or Letter-sized plain paper in the Cassette.
 3. Open the Paper Output Tray and extend the Output Tray Extension.
 4. Print the pattern.1. Open the printer properties dialog box.
 Open the Printer Properties Dialog Box through the Start Menu2. Click the Maintenance tab, then Custom Settings.3. Select the Align heads manually check box, then click Send.4. Confirm the displayed message and click OK.5. In the Maintenance sheet click Print Head Alignment.6. Confirm the displayed message and click Align Print Head.
 ImportantDo not open the Top Cover while printing is in progress.
 NoteClicking Print Alignment Value prints the current settings and finishes Print HeadAlignment.
 7. After the pattern is printed, click Yes.
 The dialog for entering a print head alignment value is displayed.
 5. Look at the first printout and adjust the print head position.1. Check the printed patterns and select the number of the pattern in column A that has the least
 noticeable vertical streaks.
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Note
 If it is difficult to pick the best pattern, pick the setting that produces the least noticeablevertical white streaks.
 (A) Less noticeable vertical white streaks(B) More noticeable vertical white streaks
 2. Repeat the procedure until you finish inputting the pattern number for column G, then click OK.For column F and G, pick the setting that produces the least noticeable horizontal streaks.
 Note
 If it is difficult to pick the best pattern, pick the setting that produces the least noticeablehorizontal white streaks.
 (C) Less noticeable horizontal white streaks(D) More noticeable horizontal white streaks
 3. Confirm the displayed message and click OK.The second pattern is printed.
 ImportantDo not open the Top Cover while printing is in progress.
 6. Look at the second printout and adjust the print head position.1. Check the printed patterns and select the number of the pattern in column H that has the least
 noticeable vertical streaks.
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Note
 If it is difficult to pick the best pattern, pick the setting that produces the least noticeablevertical white streaks.
 (E) Less noticeable vertical white streaks(F) More noticeable vertical white streaks
 2. Repeat the procedure until you finish inputting the pattern number for column Q, then click OK.3. Confirm the displayed message and click OK.
 The third pattern is printed.
 ImportantDo not open the Top Cover while printing is in progress.
 7. Look at the third printout and adjust the print head position.1. Check the printed patterns and select the number of the pattern in column a that has the least
 noticeable horizontal streaks.
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Note
 If it is difficult to pick the best pattern, pick the setting that produces the least noticeablehorizontal streaks.
 (G) Less noticeable horizontal white streaks(H) More noticeable horizontal white streaks
 2. Repeat the procedure until you finish inputting the pattern number for column j, then click OK.3. Confirm the displayed message and click OK.
 1. Make sure that the printer is turned on.
 2. Load four sheets of A4 or Letter-sized plain paper in the Cassette.
 3. Open the Paper Output Tray and extend the Output Tray Extension.
 4. Print the pattern.
 5. Open the Canon IJ Printer Utility dialog box.Opening the Canon IJ Printer Utility (Macintosh)
 1. Select Custom Settings in the pop-up menu.2. Select the Align heads manually check box, then click Send.3. Confirm the displayed message and click OK.4. Select Test Print in the pop-up menu.5. Click Print Head Alignment.6. Confirm the displayed message and click Align Print Head.
 The dialog for entering a print head alignment value is displayed.
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ImportantDo not open the Top Cover while printing is in progress.
 NoteClicking Print Alignment Value prints the current settings and finishes Print HeadAlignment.
 6. Look at the first printout and adjust the print head position.1. Check the printed patterns and select the number of the pattern in column A that has the least
 noticeable vertical streaks.
 NoteIf it is difficult to pick the best pattern, pick the setting that produces the least noticeablevertical white streaks.
 (A) Less noticeable vertical white streaks(B) More noticeable vertical white streaks
 2. Repeat the procedure until you finish inputting the pattern number for column G, then clickSend.For column F and G, pick the setting that produces the least noticeable horizontal streaks.
 Note
 If it is difficult to pick the best pattern, pick the setting that produces the least noticeablehorizontal white streaks.
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(C) Less noticeable horizontal white streaks(D) More noticeable horizontal white streaks
 3. Confirm the displayed message and click OK.The second pattern is printed.
 ImportantDo not open the Top Cover while printing is in progress.
 7. Look at the second printout and adjust the print head position.1. Check the printed patterns and select the number of the pattern in column H that has the least
 noticeable vertical streaks.
 Note
 If it is difficult to pick the best pattern, pick the setting that produces the least noticeablevertical white streaks.
 (E) Less noticeable vertical white streaks(F) More noticeable vertical white streaks
 2. Repeat the procedure until you finish inputting the pattern number for column Q, then clickSend.
 3. Confirm the displayed message and click OK.The third pattern is printed.
 ImportantDo not open the Top Cover while printing is in progress.
 8. Look at the third printout and adjust the print head position.1. Check the printed patterns and select the number of the pattern in column a that has the least
 noticeable horizontal streaks.
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Note
 If it is difficult to pick the best pattern, pick the setting that produces the least noticeablehorizontal streaks.
 (G) Less noticeable horizontal white streaks(H) More noticeable horizontal white streaks
 2. Repeat the procedure until you finish inputting the pattern number for column j, then click Send.
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Advanced Guide > Maintenance > Performing Maintenance from a Computer > Checking the Print Head Nozzles
 Checking the Print Head Nozzles The nozzle check function allows you to check whether the print heads are working properly by printing anozzle check pattern. Print the pattern if printing becomes faint, or if a specific color fails to print.
 The procedure for printing a nozzle check pattern is as follows:
 Nozzle Check
 1. Open the printer driver setup window
 2. Click Nozzle Check on the Maintenance tab The Nozzle Check dialog box opens.To display a list of items that you should check before printing the check pattern, click Initial CheckItems.
 3. Load paper in the printer Load a sheet of A4 size or Letter size plain paper into the cassette.
 4. Print a nozzle check pattern Make sure that the printer is on and click Print Check Pattern.The nozzle check pattern is printed.
 Click OK when the confirmation message appears.The Pattern Check dialog box opens.
 5. Check the print result Check the print result. If the print result is normal, click Exit.If the print result is smudged or if there are any unprinted sections, click Cleaning to clean the printhead.
 Related Topic Cleaning the Print Heads
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Advanced Guide > Maintenance > Performing Maintenance from a Computer > Cleaning Inside the Printer
 Cleaning Inside the Printer The bottom plate cleaning function allows you to prevent smudges on the reverse side of a sheet ofpaper. Perform bottom plate cleaning before you perform duplex printing.Also perform bottom plate cleaning if ink smudges caused by something other than print data appear onthe printed page.
 The procedure for performing bottom plate cleaning is as follows:
 Bottom Plate Cleaning
 1. Open the printer driver setup window
 2. Click Bottom Plate Cleaning on the Maintenance tab The Bottom Plate Cleaning dialog box opens.
 3. Load paper in the printer As instructed in the dialog box, fold the A4 size or Letter size plain paper in half horizontally, and thenunfold the sheet.Load the paper into the rear tray in the portrait orientation with the crest of the crease facing down.
 4. Perform the bottom plate cleaning Make sure that the printer is on and click Execute.Bottom plate cleaning starts.
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Advanced Guide > Changing the Printer Settings
 Changing the Printer SettingsChanging Printer Settings from Your Computer
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Advanced Guide > Changing the Printer Settings > Changing Printer Settings from Your Computer
 Changing Printer Settings from Your ComputerChanging the Print OptionsSaving a Changed Printing ProfileSetting the Paper Source for Plain Paper
 Managing the Printer Power
 Reducing the Printer NoiseChanging the Printer Operation Mode
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Advanced Guide > Changing the Printer Settings > Changing Printer Settings from Your Computer > Changing the PrintOptions
 Changing the Print Options You change detailed print driver settings for print data that is sent from an application software. With some applications, part of the image data may be cut off, the paper source during printing may differfrom the driver settings, or printing may fail. These are the only instances in which you would need tocheck this check box.
 The procedure for changing the print options is as follows:
 1. Open the printer driver setup window
 2. Click Print Options... on the Page Setup tab
 The Print Options dialog box opens.
 3. Change the individual settings If necessary, change the setting of each item, and then click OK.
 The Page Setup tab is displayed again.
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Advanced Guide > Changing the Printer Settings > Changing Printer Settings from Your Computer > Saving a ChangedPrinting Profile
 Saving a Changed Printing Profile You can assign a name to the settings made on the Main, Page Setup, and Effects tabs and save themas a printing profile. The saved printing profile can be retrieved and used from the Profiles tab at anytime. Unnecessary printing profiles can be deleted at any time.
 The procedure for registering a printing profile is as follows:
 Registering a printing profile
 1. Open the printer driver setup window
 2. Set the necessary items Make your desired settings on the Main, Page Setup, and Effects tabs.
 3. On the Profiles tab, click Add to Profiles...
 The Add to Profiles dialog box opens.
 4. Save the settings Set Name, Icon, and Description, then click OK.The profile is saved and the Profiles tab is displayed again.The name and icon are added to the Printing Profiles list.
 Note
 If you install the printer driver again or upgrade the version of the printer driver, the print settings you
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registered will be deleted from Printing Profiles.Registered print settings cannot be saved and preserved. In this case, register the print settingsagain.
 Using registered print settings
 1. Select the print settings to be used Select a printing profile in the Printing Profiles list on the Profiles tab.The parameters and settings of the profile are displayed in the Details box.
 2. Retrieve from Profiles Click Retrieve from Profiles.Click OK when a message appears.Settings of the selected profile are applied to the Main, Page Setup, and Effects tabs.
 Note
 If you want to revert a profile to the default settings, select Default Settings in the Printing Profiles listand click Retrieve from Profiles. Click OK on the confirmation message window. The settings whichwere made on the Main, Page Setup, and Effects tabs are reverted to the default settings.
 Deleting unnecessary printing profile
 1. Select the printing profile to be deleted Select the printing profile you want to delete from the Printing Profiles list on the Profiles tab.
 2. Delete the printing profile Click Delete. When the confirmation message appears, click OK.The selected printing profile is deleted from the Printing Profiles list.
 Note
 Current Settings and Default Settings cannot be deleted.
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Advanced Guide > Changing the Printer Settings > Changing Printer Settings from Your Computer > Setting the PaperSource for Plain Paper
 Setting the Paper Source for Plain Paper When you select Automatically Select from Paper Source, you can use the printer driver to select thepaper source for plain paper.
 The procedure for setting the paper source is as follows:
 Paper Source Setting for Plain Paper
 1. Open the printer driver setup window
 2. Click Paper Source Setting for Plain Paper on the Maintenance tab The Paper Source Setting for Plain Paper dialog box opens.
 3. Transmit the settings Select the paper source for plain paper, and then click the Send button. The selected settings are enabled hereafter.
 Important The descriptions in the printer manual assume that the plain paper is supplied from the cassette. Ifyou change the paper source setting, replace all instances of "cassette" with the new paper source.
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Advanced Guide > Changing the Printer Settings > Changing Printer Settings from Your Computer > Managing the PrinterPower
 Managing the Printer Power This function allows you to manage the printer power from the printer driver.
 The procedure for managing the printer power is as follows:
 Power Off The Power Off function turns off the printer. If you use this function, you will not be able to turn the printeron from the printer driver.
 1. Open the printer driver setup window
 2. Execute power off Click Power Off on the Maintenance tab. When the confirmation message appears, click OK. The printer power switches off, and the Maintenance tab is displayed again.
 Auto Power The Auto Power Off function automatically turns off the printer when print data has not been received fromthe computer for a specified period of time.The Auto Power On function automatically turns on the printer upon reception of print data.
 1. Open the printer driver setup window
 2. Make sure that the printer is on and then click Auto Power on the Maintenance tab The Auto Power Settings dialog box opens.
 Note
 If the printer is off or bi-directional communication is disabled, a message may appearbecause the computer cannot collect the printer status.If this happens, click OK to display the most recent settings specified on your computer.
 3. If necessary, complete the following settings:
 Auto Power On Specifying Enable from the list will turn the printer on upon receipt of print data.
 Auto Power Off Specify time from the list. If this time lapses without any print data being received, the printer isturned off automatically.
 4. Transmit the settings Click Send. When the confirmation message appears, click OK.The Maintenance tab is displayed again. The Auto Power On/Off function is enabled. If you want to disable this function, select Disable fromthe list according to the same procedure.
 Note
 When the printer is turned off, the Status Monitor message varies depending on the Auto Power Onsetting.When Auto Power On is enabled, "Printer is standing by" is displayed. When Auto Power On is
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disabled, "Printer is offline" is displayed.
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Advanced Guide > Changing the Printer Settings > Changing Printer Settings from Your Computer > Reducing the PrinterNoise
 Reducing the Printer Noise This function allows you to reduce the operating noise of the printer. Select if you wish to reduce theoperating noise of the printer at night, etc.Using this function may lower the print speed.
 The procedure for changing the quiet mode settings is as follows:
 Quiet Mode
 1. Open the printer driver setup window
 2. Click Quiet Mode on the Maintenance tab The Quiet Mode dialog box opens.
 3. Set the silent function If necessary, specify one of the following items:
 Do not use quiet mode The operating noise of the printer is at normal volume.
 Always use quiet mode Select this option when you wish to reduce the operating noise of the printer.
 Use quiet mode within specified time The operating noise of the printer can be reduced during a specified period of time.Set the Start time and End time when you wish the quiet mode to be activated.
 Important The time specified in Start time and in End time must be different.
 4. Transmit the settings Make sure that the printer is on and click Send.Click OK when the confirmation message appears. The selected settings are enabled hereafter.
 Note
 The effects of the quiet mode may be less depending on the paper source and the print qualitysettings.
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Advanced Guide > Changing the Printer Settings > Changing Printer Settings from Your Computer > Changing the PrinterOperation Mode
 Changing the Printer Operation Mode This function allows you to switch between various modes of printer operation.
 The procedure for changing the printer settings is as follows:
 Custom Settings
 1. Open the printer driver setup window
 2. Make sure that the printer is on, and then click Custom Settings on the Maintenancetab The Custom Settings dialog box opens.
 Note
 If the printer is off or bi-directional communication is disabled, a message may appearbecause the computer cannot collect the printer status.If this happens, click OK to display the most recent settings specified on your computer.
 3. If necessary, complete the following settings:
 Prevent paper abrasion The printer can increase the gap between the print head and the paper during high-density printingto prevent paper abrasion.Check this check box to use this function.
 Align heads manually The Print Head Alignment function on the Maintenance tab is normally set to automatic headalignment, but you can change it to manual head alignment. If the printing results are unsatisfactoryeven after you execute automatic head alignment, see "Aligning the Print Head Manually," andexecute manual head alignment.Check this check box to perform the manual head alignment.
 Ink Drying Wait Time You can set the length of the printer rest time until printing of the next page begins. Moving the sliderto the right increases the pause time and moving the slider to the left decreases the time.If the paper gets stained because the next page is ejected before the ink on the printed page dries,increase the ink drying wait time.Reducing the ink drying wait time speeds up printing.
 4. Transmit the settings Click Send. When the confirmation message appears, click OK. The printer runs in the changed mode hereafter.
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Advanced Guide > Troubleshooting
 TroubleshootingIf an Error Occurs
 The Printer Can Not Be Powered On
 Alarm Lamp Flashes OrangePower Lamp Flashes Green and Alarm Lamp Flashes Orange AlternatelyCannot Install the Printer Driver
 Cannot Connect to Computer ProperlyPrint Results Not SatisfactoryPrinting Does Not StartPrinting Stops Before It Is CompletedPrinter Moves But Ink Is Not Ejected
 Printing Speed Not as Fast as ExpectedPrint Head Holder Does Not Move to the Position for ReplacingPaper Does Not Feed ProperlyPaper Does Not Feed from the Paper Source Specified in the Printer Driver
 Paper JamsMessage Appears on the Computer ScreenCannot Print Properly with Automatic Duplex Printing
 For Windows UsersError Message Appears on a PictBridge Compliant DeviceFAQs
 If You Cannot Resolve the Problem
 Instructions for Use (Printer Driver)
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Advanced Guide > Troubleshooting > If an Error Occurs
 If an Error OccursWhen an error occurs in printing such as the printer is out of paper or paper is jammed, atroubleshooting message is displayed automatically. Take the appropriate action described in themessage. The message may vary depending on the version of your operating system.
 In Mac OS X v.10.5.x:
 In Mac OS X v.10.4.x or Mac OS X v.10.3.9:
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Advanced Guide > Troubleshooting > The Printer Cannot Be Powered On
 The Printer Cannot Be Powered On
 Check 1: Press the Power button.
 Check 2: Make sure that the power plug is securely plugged into the
 Power Cord Connector of the printer, then turn the printer back on.
 Check 3: Unplug the printer from the power supply, then plug the
 printer back in and turn the printer back on after leaving it for at least 5
 minutes.If the problem is not resolved, contact your Canon service representative.
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Advanced Guide > Troubleshooting > Alarm Lamp Flashes Orange
 Alarm Lamp Flashes OrangeWhen a printer error occurs, the Alarm lamp flashes orange as shown below. The number of flashesindicates the type of error that has occurred. Count the flashes and take the appropriate action to correctthe error.
 (A) Note the number of flashes(B) Flashes repeatedly
 Number of flashes/Cause Action
 Two flashes:Printer is out of paper./Paper does notfeed.
 Reload paper in the Rear Tray or Cassette and press the RESUME/CANCEL button on the printer.
 Three flashes:Paper Output Tray is closed./Paper jam.
 If the Paper Output Tray is closed, open it. The printerresumes printing.If opening the Paper Output Tray does not resolve theproblem, or if the tray was open to begin with, the paper maybe jammed. Remove the jammed paper, reload paperproperly in the printer, then press the RESUME/CANCELbutton on the printer.
 Paper Jams
 Four flashes:Ink tank is not installed properly./Inkmay have run out.
 If the lamp on the ink tank is not lit, the ink tank may notbe installed properly.Install an appropriate ink tank.If the lamp on the ink tank is flashing, ink may have runout.Replacing the ink tank is recommended.
 If printing is in progress and you want to continue printing,press the RESUME/CANCEL button with the ink tank installed.Then printing can continue. Replacing the ink tank isrecommended after the printing. The printer may bedamaged if printing is continued under the ink out condition.
 Routine Maintenance
 Note
 If multiple ink lamps are flashing, refer to RoutineMaintenance and confirm the status of each ink tank.
 Five flashes:Print Head is not installed./Print Head isdefective.
 Follow the directions given in your setup manual to install thePrint Head.If the Print Head is already installed, remove the Print Headonce and then reinstall it.If the error is still not resolved, the Print Head may bedamaged. Contact your Canon service representative.
 Six Flashes:The Inner Cover is opened.
 If the Inner Cover is open when starting printing on paper,close the Inner Cover, then press the RESUME/CANCELbutton on the printer.
 Seven Flashes:Ink tank is not installed in the correctposition.
 Some ink tanks are not installed in the correct position.(The lamps on the ink tanks flash.)More than one ink tanks of the same color are installed.(The lamps on the ink tanks flash.)
 Confirm that the ink tanks are installed in the appropriatepositions.
 Routine Maintenance
 Eight flashes:Ink absorber is almost full.
 The ink absorber is becoming full.The printer has a built-in ink absorber to hold the ink used
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during Print Head Cleaning.Press the RESUME/CANCEL button on the printer to cancelthe error so you can continue printing. Before the inkabsorber becomes completely full, contact a Canon servicerepresentative. (You will need to replace a particular part ofthe printer.)
 Nine flashes:The printer has not received a responsefrom the digital camera. The digitalcamera or digital video camcorderconnected is not compatible with thisprinter.
 Check the device connected to the printer. Printingphotos directly is possible only with a PictBridgecompliant device.A communication time out occurs if an operation takestoo long or if it takes too much time to send data. Thismay cancel printing. In such cases, disconnect andreconnect the USB cable.When printing from a PictBridge compliant device,depending on the model or brand of your device, you mayhave to select a PictBridge compliant print mode on thedevice before connecting it to the printer. You may alsohave to turn on your device or select Play mode manuallyafter connecting the device to the printer. Performnecessary operations before connecting your devicereferring to its instruction manual.If the error is still not resolved, check if you can printanother photograph.
 Ten flashes:Cannot perform duplex printing.
 The size of paper may not be compatible with automaticduplex printing. The sizes of media suitable for auto duplexprinting are A4, Letter, A5, and 5" x 7". Make sure that the sizeof the paper loaded in the printer is correct. Pressing the RESUME/CANCEL button will eject the paper and restartprinting from the front side of the next paper. The reverseside of the ejected sheet will not be printed.
 Eleven flashes:Automatic Print Head Alignment failed.
 Print Head nozzles are clogged.Press the RESUME/CANCEL button to dismiss the error,and print the nozzle check pattern to check the status ofthe Print Head.
 Routine MaintenancePaper of size other than A4 or Letter is loaded in the RearTray.Press the RESUME/CANCEL button to dismiss the error,then load a sheet of supplied paper (Paper For PrintHead Alignment) or A4/Letter-sized Canon Matte PhotoPaper MP-101 with the printing side (whiter side) facingUP in the Rear Tray.For Automatic Print Head Alignment, always load paperon the Rear Tray.The Paper Output Slot is exposed to strong light.Press the RESUME/CANCEL button to dismiss the error,and then adjust your operating environment and/or theposition of the printer so that the Paper Output Slot is notexposed directly to strong light.
 After carrying out the above measures, if the problemcontinues after aligning the Print Head again, press the RESUME/CANCEL button to dismiss the error, and thenperform Manual Print Head Alignment.
 Manual Print Head Alignment
 Thirteen flashes:Ink level cannot be detected.
 The remaining ink level cannot be correctly detected. (Thelamp on the ink tank flashes.)Replace the ink tank and close the Top Cover.Printing with an ink tank that was once empty may damagethe printer.If you want to continue printing in this condition, you need torelease the function for detecting the remaining ink level.Press and hold the RESUME/CANCEL button for at least 5seconds, and then release it.With this operation, releasing the function for detecting theremaining ink level is memorized. Please be advised thatCanon shall not be liable for any printer malfunction or
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damage caused by refilled ink tanks.Routine Maintenance
 Note
 If the function for detecting the remaining ink level isdisabled, the ink tank is displayed in gray on the printerstatus monitor (Windows) and Canon IJ Printer Utility(Macintosh).
 Routine Maintenance
 Fourteen Flashes:Ink tank cannot be recognized.
 The ink tank is not compatible with this printer. (The lamp onthe ink tank is off.)Install an appropriate ink tank.
 Routine Maintenance
 Fifteen Flashes:Ink tank cannot be recognized.
 An Ink tank error has occurred. (The lamp on the ink tank isoff.)Replace the ink tank.
 Routine Maintenance
 Sixteen Flashes:Ink has run out.
 Ink has run out. (The lamp on the ink tank flashes.)Replace the ink tank and close the Top Cover.Printing under the current condition may damage the printer.If you want to continue printing in this condition, you need torelease the function for detecting the remaining ink level.Press and hold the RESUME/CANCEL button for at least 5seconds, and then release it.With this operation, releasing the function for detecting theremaining ink level is memorized. Please be advised thatCanon shall not be liable for any malfunction or troublewhich may be caused by continuation of printing under theink out condition.
 Routine Maintenance
 Note
 If the function for detecting the remaining ink level isdisabled, the ink tank is displayed in gray on the printerstatus monitor (Windows) and Canon IJ Printer Utility(Macintosh).
 Routine Maintenance
 Nineteen Flashes:An unsupported USB hub is connected.
 If a PictBridge compliant device is connected via a USB hub,remove the hub and connect it directly to the printer.
 Page top
 Стр. 325 из 396 стр.Alarm Lamp Flashes Orange

Page 326
                        

Advanced Guide > Troubleshooting > Power Lamp Flashes Green and Alarm Lamp Flashes Orange Alternately
 Power Lamp Flashes Green and Alarm Lamp Flashes OrangeAlternately
 A printer problem has occurred.Disconnect the printer cable from the printer, turn the printer off, and then unplug the printer from thepower supply.Plug the printer back in and turn the printer back on.
 If the problem is not resolved, contact your Canon service representative.
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Advanced Guide > Troubleshooting > Cannot Install the Printer Driver
 Cannot Install the Printer Driver
 If the installation does not start even after the Setup CD-ROM is inserted
 into your computer's disc drive:
 Start the installation following the procedure below.
 1. Click Start then Computer.In Windows XP, click Start then My Computer.
 In Windows 2000, double-click the My Computer icon on the desktop.
 2. Double-click the CD-ROM icon on the displayed window.If the contents of the CD-ROM are displayed, double-click MSETUP4.EXE.
 Double-click the CD-ROM icon on your desktop to start installation.
 Note
 If the CD-ROM icon is not displayed, try the followings:Remove the CD-ROM from your computer, then insert it again.Restart your computer.
 If the icon is still not displayed, try different discs and see if they are displayed. If other discs aredisplayed, there is a problem with the Setup CD-ROM. In this case, contact your Canon servicerepresentative.
 If you are unable to proceed beyond the Printer Connection screen:
 If you are unable to proceed beyond the Printer Connection screen, make sure that the USB cable issecurely plugged into the USB port of the printer and is connected to the computer, and then follow
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the procedure below to reinstall the printer driver.
 Note
 In Windows Vista, "The printer is not detected. Check the connection." may be displayeddepending on the computer you use. In this case, wait for a while. If you still cannot proceed tothe next step, follow the procedure below to reinstall the printer driver.
 1. Click Cancel on the Printer Connection screen.
 2. Click Start Over on the Installation Failure screen.
 3. Click Back on the screen that appears next.
 4. Click Exit on the PIXMA XXX screen, then remove the CD-ROM.
 5. Turn the printer off.
 6. Restart the computer.
 7. Make sure that you have no application software running.
 8. Follow the procedure described in your setup manual to reinstall the printerdriver.
 In other cases:Follow the procedure described in your setup manual for proper installation.If the driver was not installed correctly, uninstall the printer driver, restart your computer, then reinstallthe driver.
 Uninstalling the Printer DriverIf you reinstall the printer driver, select Custom Install on the Setup CD-ROM.
 Note
 If the installer was forced to be terminated due to a Windows error, the system may be in anunstable condition and you may not be able to install the driver. Restart your computer beforereinstalling.
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Advanced Guide > Troubleshooting > Cannot Connect to Computer Properly
 Cannot Connect to Computer Properly
 Printing Speed Is Slow/Hi-Speed USB Connection Does Not Work/ "This devicecan perform faster" Message Is Displayed
 If your system environment is not fully compatible with Hi-Speed USB, the printer will operate at alower speed provided under USB 1.1. In this case, the printer operates properly but printing speedmay slow down due to communication speed.
 Check: Check the following to make sure that your system environment supportsHi-Speed USB connection.
 Does the USB port on your computer support Hi-Speed USB connection?Do the USB cable, and the USB hub if you are using one, support Hi-Speed USBconnection?Be sure to use a certified Hi-Speed USB cable. We recommend that the cable is nolonger than around 10 feet / 3 meters.Does the operating system of your computer support Hi-Speed USB connection?Obtain and install the latest update for your computer.Does the Hi-Speed USB driver operate properly?Obtain the latest version of the Hi-Speed USB driver compatible with your hardwareand reinstall it on your computer.
 ImportantFor details on Hi-Speed USB of your system environment, contact the manufacturer ofyour computer, USB cable, or USB hub.
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Advanced Guide > Troubleshooting > Print Results Not Satisfactory
 Print Results Not SatisfactoryIf the print result is not satisfactory due to white streaks, misaligned lines, or uneven colors, confirm thepaper and print quality settings first.
 Check 1: Do the page size and media type settings match the size and
 type of the loaded paper?When these settings are incorrect, you cannot obtain a proper print result.If you are printing a photograph or an illustration, incorrect paper type settings may reduce the qualityof the printout color.
 Also, if you print with an incorrect paper type setting, the printed surface may be scratched.
 In borderless printing, uneven coloring may occur depending on the combination of the paper typesetting and the loaded paper.The method to confirm the paper and print quality settings differs depending on what you do withyour printer.
 To print from a PictBridge compliantdevice
 Confirm by using your PictBridge compliant device.Printing Photographs Directly from a Compliant
 Device
 To print from a computer Confirm by using the printer driver.Printing with Easy Setup
 Check2: Make sure that the appropriate print quality is selected
 according to the media type and printing data referring to the table in
 Check 1.Select a print quality option suitable for the paper and image for printing. If you notice blurs or unevencolors, increase the print quality setting and try printing again.
 Note
 You cannot change the print quality setting from a PictBridge compliant device.
 Check 3: If the problem is not resolved, there may be other causes.See also the sections below:
 Cannot Print to End of JobPart of the Page Is Not Printed
 No Printing Results/Printing Is Blurred/Colors Are Wrong/White StreaksLines Are MisalignedPrinted Paper Curls or Has Ink BlotsPaper Is Smudged/Printed Surface Is ScratchedBack of the Paper Is SmudgedVertical Lines Are Printed on the Sides of the Printout
 Colors Are Uneven or Streaked
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Advanced Guide > Troubleshooting > Print Results Not Satisfactory > Cannot Print to End of Job
 Cannot Print to End of Job
 Check 1: Is the size of the print data extremely large?
 Click Print Options on the Page Setup sheet. Then, select the Prevent loss of print data check box inthe displayed dialog.
 Check 2: Is the space of your computer's hard disk sufficient?Delete unnecessary files to free disk space.
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Advanced Guide > Troubleshooting > Print Results Not Satisfactory > Part of the Page Is Not Printed
 Part of the Page Is Not Printed
 Check: When performing automatic duplex printing, the reason below is
 possible.When performing automatic duplex printing, the printable area at the top of the page will be 0.08inches / 2 mm narrower than the usual.For this reason, the bottom of the page may not be printed. To prevent this, select Use reducedprinting from the printer driver.
 ImportantReduced printing may affect the layout depending on your document.
 1. Open the printer properties dialog box.Opening the Printer Properties Dialog Box (Windows)
 Click Here: Printer Driver* Before clicking here to open the printer properties dialog box, quit the running applicationsoftware.
 2. Click Print Area Setup in the Page Setup sheet and select Use reduced printing.
 1. Open the Print dialog box.Opening the Page Setup and Print Dialog Box (Macintosh)
 2. Select Duplex Printing & Margin in the pop-up menu.
 3. Select Automatic Duplex Printing.
 4. Click Use reduced printing in Print Area.
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Advanced Guide > Troubleshooting > Print Results Not Satisfactory > No Printing Results/Printing Is Blurred/Colors AreWrong/White Streaks
 No Printing Results/Printing Is Blurred/Colors Are Wrong/WhiteStreaks
 Check 1: Did you confirm the paper and print quality settings?Print Results Not Satisfactory
 Check 2: Check the status of ink tanks. Replace the ink tank if the ink
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has run out.Routine Maintenance
 Check 3: Is the orange tape or protective film remaining?Make sure that all of the protective film is peeled off and the air hole is exposed, as illustrated in (A).If the orange tape is left as in (B), pull the orange tape and remove it.
 Check 4: Print the Nozzle Check Pattern and perform any necessary
 maintenance operations such as Print Head Cleaning.Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print headnozzles.Refer to Routine Maintenance for the Nozzle Check Pattern printing, Print Head Cleaning, and PrintHead Deep Cleaning.
 If the Nozzle Check Pattern is not printed correctly:Check to see if a particular color's ink tank is not empty.If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print HeadCleaning and try printing the Nozzle Check Pattern again.If the problem is not resolved after performing the Print Head Cleaning twice:Perform the Print Head Deep Cleaning.If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the printerand perform another Print Head Deep Cleaning after 24 hours.If the problem is not resolved after performing the Print Head Deep Cleaning twice:If Print Head Deep Cleaning does not resolve the problem, the Print Head may be damaged.Contact your Canon service representative.
 Check 5: When using paper with one printable surface, make sure that
 the paper is loaded with the printable side facing up.Printing on the wrong side of such paper may cause unclear prints or prints with reduced quality.Refer to the paper's instruction manual for detailed information on the printable side.
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Advanced Guide > Troubleshooting > Print Results Not Satisfactory > Lines Are Misaligned
 Lines Are Misaligned
 Check 1: Did you confirm the paper and print quality settings?Print Results Not Satisfactory
 Check 2: Perform Print Head AlignmentIf you did not align the Print Head after installation, straight lines may be printed misaligned. Be sureto align the Print Head after you install it.
 Routine Maintenance
 Note
 If the problem is not resolved after performing the Print Head Alignment, perform Print HeadAlignment manually referring to Manual Print Head Alignment .
 Check 3: Is the size of the print data extremely large?Click Print Options on the Page Setup sheet. Then, select the Prevent loss of print data check box inthe displayed dialog.
 Check 4: Is the Printing layout printing or Binding margin function being
 used?When the Printing layout printing or Binding margin function is being used, thin lines may not beprinted. Try thickening the lines in the document.
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Advanced Guide > Troubleshooting > Print Results Not Satisfactory > Printed Paper Curls or Has Ink Blots
 Printed Paper Curls or Has Ink Blots
 Check 1: Did you confirm the paper and print quality settings?Print Results Not Satisfactory
 Check 2: If the intensity is set high, reduce the Intensity setting in the
 printer driver and try printing again.If you are using plain paper to print images with high intensity, the paper may absorb too much inkand become wavy, causing paper abrasion.Confirm the intensity using the printer driver.
 Adjusting Intensity
 Check 3: Is Photo Paper being used for printing photographs?When printing data with high color saturation such as photographs or images in deep color, werecommend using Photo Paper Plus Glossy II or other Canon speciality paper.
 Loading Paper
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Advanced Guide > Troubleshooting > Print Results Not Satisfactory > Paper Is Smudged/Printed Surface Is Scratched
 Paper Is Smudged/Printed Surface Is Scratched
 Check 1: Did you confirm the paper and print quality settings?Print Results Not Satisfactory
 Check 2: Is the appropriate type of paper being used? Check the
 following:Check to see if the paper you are printing on is suitable for your printing purpose.
 Loading PaperWhen performing Borderless Printing, make sure that the paper you are using is suitable forBorderless Printing.If the paper you are using is not suitable for Borderless Printing, the print quality may bereduced at the top and bottom edges of the paper.
 Printing Area
 Check 3: Load the paper after correcting its curl.
 For Plain PaperTurn the paper over and reload it to print on the other side.
 Leaving the paper loaded on the Rear Tray for a long time may cause the paper to curl. In thiscase, load the paper with the other side facing up. It may resolve the problem.We recommend putting unused paper back into the package and keeping it on a level surface.
 For Other Paper1. With the printing side (A) facing up, cover the paper with a fresh sheet of plain paper to
 avoid staining or scratching the surface.2. Roll up the paper in the opposite direction to the paper curl as seen below.
 3. Check to see that the paper curl is within approximately 0.08 to 0.2 inches /2 to 5 mm (B) inheight.
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We recommend printing curl-corrected paper one sheet at a time.
 Note
 Depending on the media type, the paper may be smudged or may not be fed properly even if itis not curled. In such cases, follow the procedure described above to curl the paper beforeprinting. This may improve the print result.
 Check 4: If you are printing on thick paper, select the Prevent paper
 abrasion setting.Selecting the Prevent paper abrasion setting will widen the clearance between the Print Head andthe loaded paper. If you notice abrasion even with the media type set correctly to match the loadedpaper, set the printer to prevent paper abrasion by using the printer driver.
 Print speed is reduced if you are selecting the Prevent paper abrasion setting.* Deactivate the Prevent paper abrasion setting once printing is complete. If not, this setting remainsenabled for all subsequent print jobs.
 Open the printer properties dialog box, and in Custom Settings in the Maintenance sheet, select thePrevent paper abrasion check box, and then click Send.To open the printer properties dialog box, see Opening the Printer Properties Dialog Box (Windows) .
 In the Canon IJ Printer Utility, select Custom Settings in the pop-up menu, select the Prevent paperabrasion check box, and then click Send.To open the Canon IJ Printer Utility, see Opening the Canon IJ Printer Utility (Macintosh) .
 Check 5: If the intensity is set high, reduce the Intensity setting in the
 printer driver and try printing again.If you are using plain paper to print images with high intensity, the paper may absorb too much inkand become wavy, causing paper abrasion.Reduce the Intensity setting in the printer driver and try printing again.
 1. Open the printer properties dialog box.Opening the Printer Properties Dialog Box (Windows)
 Click Here: Printer Driver* Before clicking here to open the printer properties dialog box, quit the running applicationsoftware.
 2. On the Main sheet, select Manual for Color/Intensity, and then click Set.
 3. Drag the Intensity slide bar on the Color Adjustment sheet to adjust the intensity.
 1. Open the Print dialog box.Opening the Page Setup and Print Dialog Box (Macintosh)
 2. Select Color Options in the pop-up menu.
 3. Drag the Intensity slide bar to set the intensity.
 Check 6: Is printing performed beyond the recommended printing area?If you are printing beyond the recommended printing area of your printing paper, the lower edge of
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the paper may become stained with ink.Resize your original document in your application software.
 Printing Area
 Check 7: Is the Paper Feed Roller dirty?Clean the Paper Feed Roller.
 Routine Maintenance
 Note
 Cleaning the Paper Feed Roller will wear the roller, so perform this procedure only whennecessary.
 Check 8: Is inside of the printer dirty?When performing duplex printing, the inside of the printer may become stained with ink, causing theprintout to become smudged.Perform the Bottom Plate Cleaning to clean the inside of the printer.
 Cleaning Inside the Printer
 Note
 To prevent the inside of the printer from stains, set the paper size correctly.
 Check 9: Set Ink Drying Wait Time longer.Doing so gives the printed surface enough time to dry so that paper smudged and scratched areprevented.
 1. Make sure that the printer is turned on.
 2. Open the printer properties dialog box.Opening the Printer Properties Dialog Box (Windows)
 3. Click the Maintenance tab and then Custom Settings.
 4. Drag the Ink Drying Wait Time slide bar to set the wait time, and then click Send.
 5. Confirm the message and click OK.
 1. Make sure that the printer is turned on.
 2. Open the Canon IJ Printer Utility.Opening the Canon IJ Printer Utility (Macintosh)
 3. Select Custom Settings in the pop-up menu.
 4. Drag the Ink Drying Wait Time slide bar to set the wait time, and then click Send.
 5. Confirm the message and click OK.
 Check 10: Is the paper scratched by other loaded paper?Depending on the media type, the paper may be scratched by other loaded paper when feeding fromthe Rear Tray. In this case, load one sheet at a time.
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Advanced Guide > Troubleshooting > Print Results Not Satisfactory > Back of the Paper Is Smudged
 Back of the Paper Is Smudged
 Check 1: Did you confirm the paper and print quality settings?Print Results Not Satisfactory
 Check 2: Perform the Bottom Plate Cleaning to clean the inside of the
 printer.Cleaning Inside the Printer
 Note
 When performing duplex printing or too much printing, the inside may become stained with ink.
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Advanced Guide > Troubleshooting > Print Results Not Satisfactory > Vertical Lines Are Printed on the Sides of thePrintout
 Vertical Lines Are Printed on the Sides of the Printout
 Check 1: Did you confirm the paper type and print quality settings?Print Results Not Satisfactory
 Check 2: Is the size of the loaded paper correct?The margin may be smudged if the size of the loaded paper is larger than that specified in theprinter driver.
 Set the paper size correctly according to the paper you loaded.
 Print Results Not Satisfactory
 Note
 This printer performs automatic cleaning when necessary to keep printouts clean. A smallamount of ink is ejected for cleaning.Although ink is usually ejected on the ink absorber, it may be ejected on the paper if you loadpaper larger than that specified with the printer driver.
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Advanced Guide > Troubleshooting > Print Results Not Satisfactory > Colors Are Uneven or Streaked
 Colors Are Uneven or Streaked
 Check 1: Did you confirm the paper and print quality settings?Print Results Not Satisfactory
 Check 2: Print the Nozzle Check Pattern and perform any necessary
 maintenance operations such as Print Head Cleaning.Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print headnozzles.Refer to Routine Maintenance for the Nozzle Check Pattern printing, Print Head Cleaning, and PrintHead Deep Cleaning.
 If the Nozzle Check Pattern is not printed correctly:Check to see if a particular color's ink tank is not empty.If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print HeadCleaning and try printing the Nozzle Check Pattern again.If the problem is not resolved after performing the Print Head Cleaning twice:Perform the Print Head Deep Cleaning.If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the printerand perform another Print Head Deep Cleaning after 24 hours.If the problem is not resolved after performing the Print Head Deep Cleaning twice:If Print Head Deep Cleaning does not resolve the problem, the Print Head may be damaged.Contact your Canon service representative.
 Check 3: Perform Print Head Alignment.Routine Maintenance
 Note
 If the problem is not resolved after performing the Print Head Alignment, perform Print Head
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Alignment manually referring to Manual Print Head Alignment .
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Advanced Guide > Troubleshooting > Printing Does Not Start
 Printing Does Not Start
 Check 1: Make sure that the power plug is securely plugged in, then
 turn the printer on.While the Power lamp is flashing green, the printer is initializing. Wait until the Power lamp stopsflashing and remains lit green.
 Note
 When printing large data such as a photo or graphics, it may take longer to start printing. Whilethe Power lamp is flashing green, the computer is processing data and sending them to theprinter. Wait until printing starts.
 Check 2: Check the status of ink tanks. Replace the ink tank if ink has
 run out.
 Check 3: Open the Top Cover and check to see if the ink lamps are
 flashing red.If there is still sufficient ink but its ink lamp is flashing red, an ink tank may not be installed in a rightposition.
 Routine Maintenance
 Check 4: Open the Top Cover and make sure that the ink lamps light up
 red.
 If the ink lamp is not lit, press the mark on the ink tank until it clicks into place.
 Check 5: Make sure that the USB cable is securely plugged in to the
 printer and the computer, then check the following:If you are using a relay device such as a USB hub, disconnect it, connect the printer directly tothe computer, and try printing again. If printing starts normally, there is a problem with the relaydevice. Consult the reseller of the relay device for details.There could also be a problem with the USB cable. Replace the USB cable and try printingagain.
 Check 6: Restart your computer if you are printing from the computer.If there are any unnecessary print jobs, delete them.
 Deleting the Undesired Print Job
 Check 7: Make sure that the Inner Cover is closed.If the Inner Cover is opened, close the Inner Cover and press the RESUME/CANCEL button on theprinter.
 Check 8: Make sure that your printer's name is selected in the Print
 dialog box.The printer will not print properly if you are using a driver for a different printer.
 In Windows, make sure that your printer's name is selected in the Print dialog box.On a Macintosh, make sure that your printer's name is selected in Printer in the Print dialog box.
 Note
 To make the printer the one selected by default, select Set as Default Printer (Windows),Default Printer or Make Default (Macintosh).
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Check 9: Configure the printer port appropriately.Configure "USBnnn" (where "n" is a number) as the printer port.
 1. Log on as a user account with administrator privilege.
 2. Click Control Panel, then Printer under Hardware and Sound.In Windows XP, click Control Panel, Printers and Other Hardware, then Printers and Faxes.In Windows 2000, click Control Panel then Printers.
 3. Right-click the Canon XXX icon, then select Properties.
 4. Click the Ports tab to confirm the port settings.Make sure that a port named USBnnn (where "n" is a number) with Canon XXX appearing in thePrinter column is selected for Print to the following port(s).If the setting is incorrect, reinstall the printer driver or change the printer port to the correct one.
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Advanced Guide > Troubleshooting > Printing Stops Before It Is Completed
 Printing Stops Before It Is Completed
 Check 1: Is the Inner Cover opened while printing on paper?Close the Inner Cover and press the RESUME/CANCEL button on the printer.
 A page of print data being sent at the time of the error will be erased, so print that page again.
 Check 2: Has the printer been printing continuously for a long period?If the printer has been printing continuously for a long time, the Print Head may overheat. To protectthe Print Head, the printer may stop printing at a line break for a period of time and then resumeprinting.In this case, interrupt your print session at a convenient time and turn the printer off for at least 15minutes.Additionally, if the printer has been printing graphics or photos with intense colors continuously overa period of time, the printer may stop printing to protect the Print Head. In this case, printing will notresume automatically. Turn the printer off for at least 15 minutes.
 CautionThe Print Head and the surrounding area can become extremely hot inside the printer. Nevertouch the Print Head or nearby components.
 Check 3: Is the paper loaded?Make sure that paper is loaded in the Rear Tray or Cassette.Confirm the paper source, then reload paper.
 Check 4: Do the printing documents have lots of photographs or
 illustrations?Printing large data such as photos or graphics takes time for the printer and the computer toprocess, during which the printer may appear to have stopped operating.In addition, when printing data that uses a large amount of ink continuously on plain paper, theprinter may pause temporarily. In either case, wait until the process is complete.
 Note
 If you are printing a document with a large printing area or printing multiple copies of adocument, printing may pause to allow the ink to dry.
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Advanced Guide > Troubleshooting > Printer Moves But Ink Is Not Ejected
 Printer Moves But Ink Is Not Ejected
 Check 1: Are the Print Head nozzles clogged?Print the Nozzle Check Pattern to determine whether the ink ejects properly from the print headnozzles.Refer to Routine Maintenance for the Nozzle Check Pattern printing, Print Head Cleaning, and PrintHead Deep Cleaning.
 If the Nozzle Check Pattern is not printed correctly:Check to see if a particular color's ink tank is not empty.If the Nozzle Check Pattern is not printed correctly though ink is sufficient, perform the Print HeadCleaning and try printing the Nozzle Check Pattern again.If the problem is not resolved after performing the Print Head Cleaning twice:Perform the Print Head Deep Cleaning.If the problem is not resolved after performing the Print Head Deep Cleaning, turn off the printerand perform another Print Head Deep Cleaning after 24 hours.If the problem is not resolved after performing the Print Head Deep Cleaning twice:If Print Head Deep Cleaning does not resolve the problem, the Print Head may be damaged.Contact your Canon service representative.
 Check 2: Has the ink run out?Check 2: Open the Top Cover, then check the status of ink lamp.
 Routine Maintenance
 Check 3: Is the orange tape or protective film remaining?Make sure that all of the protective film is peeled off and the air hole is exposed, as illustrated in (A).If the orange tape is left as in (B), pull the orange tape and remove it.
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Advanced Guide > Troubleshooting > Printing Speed Not as Fast as Expected
 Printing Speed Not as Fast as Expected
 Check 1: Is printing performed in Quiet Mode?Print speed is reduced if you specified to print in Quiet Mode in the printer driver. For faster printing,do not print in Quiet Mode.
 Reducing the Printer Noise
 Check 2: Is the print quality set too high?Increase the printing speed setting in the printer driver. Setting to prioritize speed makes printingfaster.
 1. Open the printer properties dialog box.Opening the Printer Properties Dialog Box (Windows)
 Click Here: Printer Driver* Before clicking here to open the printer properties dialog box, quit the running applicationsoftware.
 2. On the Main sheet, select Fast for the Print Quality setting.Depending on the media type, the Fast option may not be available.
 1. Open the Print dialog box.Opening the Page Setup and Print Dialog Box (Macintosh)
 2. Select Quality & Media in the pop-up menu and then select Fast for the PrintQuality setting.Depending on the media type, the Fast option may not be available.
 Note
 Printing speed may not improve noticeably by following the instructions above, depending on yoursystem environment.
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Advanced Guide > Troubleshooting > Print Head Holder Does Not Move to the Position for Replacing
 Print Head Holder Does Not Move to the Position for Replacing
 Check 1: Is the Power lamp off?Check if the Power lamp is lit green.The Print Head Holder will not move unless the power is on. If the Power lamp is off, close the TopCover and turn the printer on.
 While the Power lamp is flashing green, the printer is initializing. Wait until the Power lamp stopsflashing and remains lit green, and then open the Top Cover again.
 Check 2: Is the Alarm lamp flashing?Close the Top Cover, confirm the number of times the Alarm lamp is flashing, take the appropriateaction to resolve the error, and then reopen it. For details on how to resolve the error, see AlarmLamp Flashes Orange.
 Check 3: Has the Top Cover been left open for 10 minutes or longer?If the Top Cover is left open for more than 10 minutes, the Print Head Holder moves to the right toprevent the Print Head from drying out. Close and reopen the Top Cover to return the Print HeadHolder to the center.
 Check 4: Has the printer been printing continuously for a long period?If the printer has been printing continuously for a long time, close the Top Cover, wait a while, thenreopen it.If the printer has been printing continuously for a long time, the Print Head Holder may not move tothe center since the Print Head may overheat.
 Note
 Opening the Top Cover while printing moves the Print Head Holder to the right. Close the TopCover, and reopen it after printing finishes.
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Advanced Guide > Troubleshooting > Paper Does Not Feed Properly
 Paper Does Not Feed Properly
 Check 1: Make sure of the following when you load paper.When loading two or more sheets of paper, align the edges of the sheets before loading.When loading two or more sheets of paper, make sure that the paper stack does not exceed thepaper support load limit.However, proper feeding of paper may not be possible at this maximum capacity depending onthe type of paper or environmental conditions (either very high or low temperature and humidity).In such cases, reduce the sheets of paper you load at a time to less than half of the papersupport load limit.Always load the paper in portrait orientation, either in the Rear Tray or the Cassette, regardlessof the printing orientation.When you load the paper on the Rear Tray, load the paper with the print side facing UP andslide the Paper Guides to align with the both sides of the paper.When loading paper in the Cassette, load the paper with the print side facing DOWN. Align theright edge of the paper stack against the right edge of the Cassette and slide the Paper Guidesagainst the left and bottom edges of the stack.
 Loading Paper
 Check 2: Check to see if the paper you are printing on is too thick or
 curled.Loading Paper
 Check 3: Make sure of the following when you load envelopes.When printing on envelopes, refer to Loading Paper, and prepare the envelopes before printing.Once you have prepared the envelopes, load them in portrait orientation. If the envelopes are placedin landscape orientation, they will not feed properly.
 Check 4: Confirm the paper source setting.* If the paper source setting is not changed since you purchased this printer, the paper source forplain paper is the Cassette.
 Setting with the printer driver:
 Switching the Paper Source to Match the Purpose
 For information on the paper source for plain paper when the Paper Source on the printer driveris set to Automatically Select:
 Setting the Paper Source for Plain Paper
 Check 5: Remove the foreign object in the Rear Tray or Cassette.
 Check 6: Make sure that the Inner Cover is closed completely.Paper does not feed properly if the Inner Cover is even slightly open.
 Overview of the Printer
 Check 7: Clean the Paper Feed Roller.Routine Maintenance
 Note
 Cleaning the Paper Feed Roller will wear the roller, so perform this procedure only whennecessary.
 Check 8: If two or more sheets of paper feed from the Cassette at once,
 clean the inside of the Cassette.For information on cleaning the inside of the Cassette, refer to Routine Maintenance.
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Check 9: Is the Rear Cover closed completely?Paper may be jammed if the Rear Cover is not closed completely. Push the Rear Cover until it isclosed completely.Refer to Overview of the Printer for the position of the Rear Cover.
 Page top
 Стр. 351 из 396 стр.Paper Does Not Feed Properly

Page 352
                        

Advanced Guide > Troubleshooting > Paper Does Not Feed from the Paper Source Specified in the Printer Driver
 Paper Does Not Feed from the Paper Source Specified in thePrinter Driver
 Check: Is the paper source setting inconsistent between the application
 program and the printer driver?Change the application software setting corresponding to the printer driver setting, or click the PrintOptions on the Page Setup sheet in the printer driver and select Disable the paper source setting ofthe application software on the Print Options screen.When the paper source setting is inconsistent between an application program and the printerdriver, the application software setting takes precedence.
 Setting the Paper Source for Plain Paper
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Advanced Guide > Troubleshooting > Paper Jams
 Paper Jams
 Note
 If you need to turn off the printer to remove jammed paper during printing, press the RESUME/CANCEL button to cancel print jobs before turning off the printer.
 If the paper is jammed in the Paper Output Slot or the Rear Tray:Remove the paper following the procedure below.
 1. Slowly pull the paper out, either from the Rear Tray or from the Paper Output Slot,whichever is easier.
 Note
 If the paper tears and a piece remains inside the printer, open the Top Cover andremove it.Be careful not to touch the components inside the printer.After removing all paper, close the Top Cover, turn the printer off, and turn it back on.If you cannot pull the paper out, turn the printer off and turn it back on. The paper may beejected automatically.
 2. Reload the paper, and press the RESUME/CANCEL button on the printer.
 If you turned off the printer in step 1, all print jobs in the queue are canceled. Reprint ifnecessary.
 Note
 When reloading the paper, confirm that you are using the correct paper and are loading itcorrectly.
 Loading PaperA5-sized paper is suited to printing documents consisting mainly of text. We do notrecommend using such paper to print documents with photos or graphics, since theprintout may curl and cause paper exit jams.
 If you cannot remove the paper or the paper tears inside the printer, or if the paper jam errorcontinues after removing the paper, contact your Canon service representative.
 If paper is jammed inside the printer at the transport unit:Remove the paper following the procedure below.
 1. Detach the Rear Cover.
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2. Pull the paper out slowly.
 Note
 Be careful not to touch the components inside the printer.If you cannot pull the paper out, turn the printer off and turn it back on. The paper may beejected automatically.
 3. Attach the Rear Cover.Push the left side of the Rear Cover until it is closed completely.
 If you were not able to remove the paper out in step 2:
 4. Remove the Cassette.
 5. Pull the paper out slowly.
 6. If any paper is sticking out of the Cassette, remove the paper, align and reloadthe paper in the Cassette.If you did not remove the jammed paper out in step 1 to 5 when automatic duplex printing,check the duplex transport section.
 If the jammed paper is not removed out when automatic duplex printing:
 Note
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When reloading the paper into the printer, confirm that you are using the correct paperand are loading it into the printer correctly.
 Loading Paper
 7. Insert the Cassette into the printer again, and press the RESUME/CANCELbutton on the printer.If you turned off the printer in step 2, all print jobs in queue are canceled. Reprint if necessary.
 If you cannot remove the paper or if the paper tears inside the printer, or if the paper jam errorcontinues after removing the paper, contact your Canon service representative.
 If the jammed paper is not removed out when automatic duplex printing:Remove the paper following the procedure below.
 1. Turn off the printer, and unplug the power cord of the printer from the powersupply.
 2. Remove the Cassette.If the paper is loaded on the Rear Tray, remove the paper from the Rear Tray and retract thePaper Support.
 3. Set the printer upright with the left side down.
 4. Slowly pull the jammed paper out so that the paper does not tear.
 Note
 Set the printer back to its original position immediately after removing the jammedpaper.
 5. Align the paper, then reload it in the Cassette.Reload paper in the Rear Tray, if necessary.
 Note
 When reloading the paper into the printer, confirm that you are using the correct paperand are loading it into the printer correctly.
 Loading Paper
 6. Insert the Cassette into the printer again.
 7. Plug the printer back in and turn the printer back on.All print jobs in queue are canceled. Reprint if necessary.
 If you cannot remove the paper or if the paper tears inside the printer, or if the paper jam errorcontinues after removing the paper, contact your Canon service representative.
 In other cases:
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Make sure of the following:
 Check 1: Are there any foreign objects in the Rear Tray or around the PaperOutput Slot?
 Check 2: Is the Rear Cover closed completely?
 Check 3: Is the paper curled?Check 3: Load the paper after correcting its curl.
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Advanced Guide > Troubleshooting > Message Appears on the Computer Screen
 Message Appears on the Computer ScreenService Error 5100 Is DisplayedError Regarding Automatic Duplex Printing Is Displayed Error Regarding Automatic Print Head Alignment Is Displayed
 Writing Error/Output Error/Communication Error
 Error Number: 300 Is Displayed
 Error Number: 1700 Is Displayed
 Ink Info Number: 1600 Is Displayed
 Ink Info Number: 1683 Is Displayed
 Ink Info Number: 1688 Is Displayed
 Error Number: 1851 Is Displayed
 Error Number: 1856 Is Displayed
 Error Number: 2001 Is Displayed
 Error Number: 2002 Is Displayed
 Error Number: 2500 Is Displayed
 Other Error Messages
 Service Error 5100 Is Displayed
 Check: Is the movement of the Print Head Holder blocked?Cancel printing from your computer and turn off the printer. Then clear the jammed paper orprotective material that is preventing the Print Head Holder from moving.
 ImportantBe careful not to touch the components inside the printer. The printer may not print outproperly if you touch it.
 Turn the printer back on.
 If the problem is not resolved, contact your Canon service representative.
 Error Regarding Automatic Duplex Printing Is Displayed
 Check: See Cannot Print Properly with Automatic Duplex Printing and take theappropriate action.
 Error Regarding Automatic Print Head Alignment Is Displayed
 Check: See Eleven flashes: in Alarm Lamp Flashes Orange and take theappropriate action.
 Writing Error/Output Error/Communication Error
 Check 1: If the Power lamp is off, make sure that the power plug is plugged in,then turn the printer on.While the Power lamp is flashing green, the printer is initializing. Wait until the Power lampstops flashing and remains lit green.
 Check 2: Make sure that the printer port is configured appropriately in the printer
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driver.* In the following instructions, " XXX" signifies your printer's name.
 1. Log on as a user account with administrator privilege.
 2. Click Control Panel, then Printer under Hardware and Sound.
 In Windows XP, click Control Panel, Printers and Other Hardware, then Printers andFaxes.In Windows 2000, click Control Panel then Printers.
 3. Right-click the Canon XXX icon, then select Properties.
 4. Click the Ports tab to confirm the port settings.
 Make sure that a port named USBnnn (where "n" is a number) with Canon XXX appearingin the Printer column is selected for Print to the following port(s).If the port setting is not correct, reinstall the printer driver or change the port settingaccording to the interface you are using.
 Check 3: Make sure that the USB cable is securely plugged in to the printer andthe computer.
 If you are using a relay device such as a USB hub, disconnect it, connect the printerdirectly to the computer, and try printing again. If printing starts normally, there is aproblem with the relay device. Consult the reseller of the relay device for details.There could also be a problem with the USB cable. Replace the USB cable and tryprinting again.
 Check 4: Make sure that the printer driver is installed correctly.Uninstall the printer driver following the procedure described in Uninstalling the Printer Driverand reinstall it following the procedure described in your setup manual.
 Check 5: Check the status of the device on your computer.Follow the procedure below to check the status of the device.
 1. Click Control Panel, Hardware and Sound, then Device Manager.
 If the User Account Control screen is displayed, follow the on-screen instructions.In Windows XP, click Control Panel, Performance and Maintenance, System, then clickDevice Manager on the Hardware sheet.In Windows 2000, click Control Panel, System, then Device Manager on the Hardwaresheet.
 2. Double-click Universal Serial Bus controllers then USB Printing Support.
 If USB Printing Support is not displayed, make sure that the printer is correctly connectedto the computer.
 Check 3: Make sure that the USB cable is securely plugged in to the printer and thecomputer.
 3. Click the General tab and make sure that there is no indication of a problem with thedevice.
 If a device error is displayed, refer to Windows help to resolve the error.
 Error Number: 300 Is Displayed
 Check 1: If the Power lamp is off, make sure that the power plug is plugged in,then turn the printer on.While the Power lamp is flashing green, the printer is initializing. Wait until the Power lampstops flashing and remains lit green.
 Check 2: Make sure that the USB cable is securely plugged in to the printer andthe computer.
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If you are using a relay device such as a USB hub, disconnect it, connect the printerdirectly to the computer, and try printing again. If printing starts normally, there is aproblem with the relay device. Consult the reseller of the relay device for details.There could also be a problem with the USB cable. Replace the USB cable and tryprinting again.
 Check 3: Make sure that your printer's name is selected in the Print dialog box.Opening the Page Setup and Print Dialog Box (Macintosh)
 Error Number: 1700 Is Displayed
 See Eight flashes: in Alarm Lamp Flashes Orange and take the appropriateaction.
 Ink Info Number: 1600 Is Displayed
 See Four flashes: in Alarm Lamp Flashes Orange and take the appropriateaction.
 Ink Info Number: 1683 Is Displayed
 See Thirteen flashes: in Alarm Lamp Flashes Orange and take the appropriateaction.
 Ink Info Number: 1688 Is Displayed
 See Sixteen Flashes: in Alarm Lamp Flashes Orange and take the appropriateaction.
 Error Number: 1851 Is Displayed
 Check: Close the Inner Cover, then press the RESUME/CANCEL button on theprinter.
 Error Number: 1856 Is Displayed
 Check: Close the Inner Cover, then press the RESUME/CANCEL button on theprinter.A page of print data being sent at the time of the error will be erased, so print that page again.
 Error Number: 2001 Is Displayed
 See Nine flashes: in Alarm Lamp Flashes Orange and take the appropriateaction.
 Error Number: 2002 Is Displayed
 See Nineteen Flashes: in Alarm Lamp Flashes Orange and take the appropriateaction.
 Error Number: 2500 Is Displayed
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See Eleven flashes: in Alarm Lamp Flashes Orange and take the appropriateaction.
 Other Error Messages
 Check: If an error message is displayed outside the printer status monitor, checkthe following:
 "Could not spool successfully due to insufficient disk space"Delete any unnecessary files to increase the amount of free space on the disk."Could not spool successfully due to insufficient memory"Quit other running applications to increase available memory.If you still cannot print, restart your computer and retry printing."Printer driver could not be found"Uninstall the printer driver according to the procedure described in Uninstalling thePrinter Driver, and then reinstall it."Could not print Application name - File name"Try printing again once the current job is complete.
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Advanced Guide > Troubleshooting > Cannot Print Properly with Automatic Duplex Printing
 Cannot Print Properly with Automatic Duplex Printing
 Check: Is the paper size or media type appropriate?Make sure that the actual size of the paper is suitable for automatic duplex printing.The sizes of media suitable for automatic duplex printing are A4, Letter, A5, and 5" x 7".Load paper of suitable size, then press the RESUME/CANCEL button on the printer.Make sure that the Page Size or Paper Size setting matches the actual size of the paper with asize suitable for automatic duplex printing.First, check the Page Size setting in the application software you are printing from.Then, check the Page Size setting on the Page Setup sheet in the printer properties dialog box(Windows) or the Paper Size on the Page Setup dialog box (Macintosh).
 NoteDuplex printing may not be available depending on the version of the application software.
 Make sure that the type of loaded paper is suitable for automatic duplex printing on the Mainsheet (Windows) or the Quality & Media sheet on the Print dialog box (Macintosh).
 To switch to manual duplex printing, follow the procedure below.
 Open the printer properties dialog box, clear the Automatic check box on the Page Setup sheet, andreprint.When performing manual duplex printing, note the following.
 If you are printing three or more pages of a document with manual duplex printing, one sideof all sheets of paper will be printed first. Turn over the paper and reload the paper in theprinter, and then the reverse side of all sheets of paper will be printed. Be careful not tochange the order of paper in the stack.The procedure for reversing the paper varies depending on the staple side and printingorientation. Follow the on-screen instructions.
 Manual duplex printing is not available.
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Advanced Guide > Troubleshooting > For Windows Users
 For Windows Users
 Printer Status Monitor Is Not Displayed
 Check: Is the printer status monitor enabled?Make sure that Enable Status Monitor is selected on the Option menu of the printer statusmonitor.
 1. Open the printer properties dialog box.
 Opening the Printer Properties Dialog Box (Windows)
 2. On the Maintenance sheet, click View Printer Status.
 3. Select Enable Status Monitor on the Option menu if it is not selected.
 The Inkjet Printer/Scanner Extended Survey Program Screen Is DisplayedIf the Inkjet Printer/Scanner Extended Survey Program is installed, the confirmation screen askingto send the printer usage information will be displayed three months and then six months after theinstallation. After that, it will be displayed every half a year for about four years.
 Read the instructions on the screen and follow the procedure below.
 If you agree to participate in the survey program:Click Agree, then follow the on-screen instructions. The printer usage information will be sentto Canon via the Internet.
 NoteWhen sending the information, the caution screen such as an Internet security screenmay be displayed.In this case, confirm the program name is "IJPLMUI.exe", then allow it.
 If you do not agree to participate in the survey program:Click Do not agree. The confirmation screen will be closed, and the survey at that time isskipped. The confirmation screen will be displayed again three months later.
 To uninstall the Inkjet Printer/Scanner Extended Survey Program:
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To uninstall the Inkjet Printer/Scanner Extended Survey Program, click Details, then clickUninstall on the detail description screen. Once the program has been uninstalled, neitherthe survey nor the transmission of the printer usage information will be performed.
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Advanced Guide > Troubleshooting > Error Message Appears on a PictBridge Compliant Device
 Error Message Appears on a PictBridge Compliant DeviceThe following are the possible errors that may occur when printing directly from a PictBridge compliantdevice and the countermeasures to clear them.
 Note
 This section describes errors that are indicated on Canon-brand PictBridge compliant devices. Theerror messages and operations may vary depending on the device you are using. For errors on non-Canon PictBridge compliant devices, check the status of the Alarm lamp and take theappropriate action to clear the error. For details, see Alarm Lamp Flashes Orange .For the errors indicated on the PictBridge compliant device and their solution, also refer to theinstruction manual of the device. For other troubles on the device, contact the manufacturer.
 Error Message On PictBridgeCompliant Device Action
 "Printer in use" If the printer is printing from the computer or warming up,wait until the job ends.When it is ready, the printer starts printing automatically.
 "No paper" Load paper, and select Continue* in the display on yourPictBridge compliant device.* To resume printing, you can also press the RESUME/CANCEL button on the printer instead of selectingContinue on the device.
 "Paper Error" If the Paper Output Tray is closed, open it. The printerresumes printing. If the Inner Cover is opened, close it andselect Stop in the display on your PictBridge compliantdevice to stop printing.
 "Paper jam" Select Stop in the display on your PictBridge compliantdevice to stop printing.Remove the jammed paper, load new paper, press the RESUME/CANCEL button on the printer, then try printingagain.
 "Printer cover open" Close the Top Cover on the printer.
 "No print head" The Print Head is defective or is not installed.See Five flashes: in Alarm Lamp Flashes Orange and takethe appropriate action.
 "Waste tank full"/"Ink absorber full" The ink absorber is nearly full.See Eight flashes: in Alarm Lamp Flashes Orange and takethe appropriate action.
 "No ink"/"Ink cassette error"
 The ink tank is not installed properly or empty.Check the number of how many the Alarm lamp flashes andtake the appropriate action to resolve the error.
 Alarm Lamp Flashes Orange
 "Ink Error" An ink tank that was once empty is installed.See Thirteen flashes: in Alarm Lamp Flashes Orange andtake the appropriate action.
 "Hardware Error" Ink tank errors have occurred.Replace the ink tank.
 Routine Maintenance
 "Printer error" An error requiring servicing may have occurred. (The Powerlamp flashes green and Alarm lamp flashes orangealternately.)
 Power Lamp Flashes Green and Alarm Lamp FlashesOrange AlternatelyDisconnect the USB cable between the printer and the
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PictBridge compliant device, turn off the printer, and unplugthe power cord of the printer from the power supply.Plug the power cord of the printer back in, turn on the printer,and then reconnect the PictBridge compliant device to theprinter.If the same error occurs, contact your Canon servicerepresentative.
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Advanced Guide > Troubleshooting > FAQs
 FAQsNo Printing Results/Printing Is Blurred/Colors Are Wrong/White StreaksPrinter Moves But Ink Is Not Ejected
 Cannot Install the Printer Driver
 Printing Does Not StartPrinting Stops Before It Is Completed
 Writing Error/Output Error/Communication ErrorPrint Results Not SatisfactoryPaper JamsPaper Does Not Feed Properly
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Advanced Guide > Troubleshooting > If You Cannot Resolve the Problem
 If You Cannot Resolve the ProblemIf you cannot resolve the problem with any of the workarounds in this chapter, please contact the seller ofthe printer or a Canon service representative.
 Canon support staff are trained to be able to provide technical support to satisfy customers.
 Caution
 If the printer emits any unusual sound, smoke, or odor, turn it off immediately. Unplug the powercord from the outlet and contact the seller or your Canon service representative. Never attempt torepair or disassemble the printer yourself.Attempts by customers to repair or take apart the printer will invalidate any warranty regardless ofwhether the warranty has expired.
 Before contacting your Canon service representative, confirm the following:Product name:* Your printer's name is located on the front cover of the setup manual.Serial number: please refer to the setup manualDetails of the problemWhat you tried to solve the problem, and what happened
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Advanced Guide > Troubleshooting > Instructions for Use (Printer Driver)
 Instructions for Use (Printer Driver) This printer driver is subject to the following restrictions. Keep the following points in mind when usingthe printer driver.
 Restrictions on the Printer Driver
 Depending on the document type to be printed, the paper feed method specified in the printer drivermay not operate correctly.If this happens, open the printer driver setup screen from the Print dialog box of the applicationsoftware, and check the setting in the Paper Source field on the Main tab.
 With some applications, the Copies setting in the Page Setup tab of the printer driver may not beenabled.In this case, use the copies setting in the Print dialog box of the application software.
 If the selected Language in the About dialog box does not match the operating system interfacelanguage, the driver screen may not be displayed properly.
 Do not change the Advanced tab items of the printer properties. If you change any of the items, youwill not be able to use the following functions correctly.Also, if Print to file is selected in the Print dialog box of the application software and with applicationsthat prohibit EMF spooling, such as Adobe Photoshop LE and MS Photo Editor, the followingfunctions will not operate.
 Preview before printing on the Main tab Prevent loss of print data in the Print Options dialog box Page Layout Printing, Poster Printing, Booklet Printing, Duplex Printing (manually), SpecifyMargin..., Print from Last Page, Collate, and Stamp/Background... on the Page Setup tab
 Since the resolution in the preview display differs from the printing resolution, text and lines in thepreview display may appear different from the actual print result.
 With some applications, the printing is divided into multiple print jobs.To cancel printing, delete all divided print jobs.
 If image data is not printed correctly, display the Print Options dialog box from the Page Setup taband change the setting of Disable ICM required from the application software. This may solve theproblem.
 Software windows may not appear correctly on Windows Vista when fonts are set to Larger scale. Ifyou want to display the windows with Larger scale fonts, set the desktop theme to Windows Classicas follows:
 1. Select Control Panel from the Start menu. 2. Select Appearance and Personalization -> Personalization -> Theme.
 The Theme Settings dialog box opens. 3. At the Theme Settings dialog box, click the Themes tab, and select Windows Classic from
 Theme. 4. Click OK.
 Desktop changes to Windows Classic display.
 Points to Note with Applications
 There are following restrictions in Microsoft Word (Microsoft Corporation). If Microsoft Word has the same printing functions as the printer driver, use Word to specify them. When selecting Scaled Printing, Fit-to-Page Printing, or Page Layout Printing from the Page Layoutlist on the Page Setup tab, the selected printing function may not be effective, depending on theversion of Word.If this happens, follow the procedure below.
 1. Open Word's Print dialog box. 2. Open the printer driver setup window, specify Page Layout on the Page Setup tab, and click
 OK. 3. Without starting printing, close the Print dialog box. 4. Open Word's Print dialog box again. 5. Open the printer driver setup window again and click OK. 6. Start printing.
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Illustrator/Adobe Systems Inc.If Bitmap Printing takes effect, printing may take time or some data may not be printed. Print afterclearing the Bitmap Printing check box in the Print dialog box.
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Advanced Guide > Appendix
 AppendixPrinting Area
 Deleting the Undesired Print JobUpdating the Printer Driver
 Uninstalling the On-Screen ManualsTransporting the PrinterOpening the Printer Properties Dialog Box (Windows)Opening the Page Setup and Print Dialog Box (Macintosh)
 Opening the Canon IJ Printer Utility (Macintosh)Connecting the Printer to the Network
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Advanced Guide > Appendix > Printing Area
 Printing AreaTo ensure the best print quality, the printer allows a margin along each edge of media. The actualprintable area will be the area inside these margins.
 Recommended printing area : Canon recommends that you print within this area.
 Printable area : The area where it is possible to print.However, printing in this area can affect the print quality or the paper feed precision.
 NoteBorderless Printing
 By selecting Borderless Printing option, you can make prints with no margins.When performing Borderless Printing, slight cropping may occur at the edges since the printedimage is enlarged to fill the whole page.For Borderless Printing, use the following paper.
 Glossy Photo Paper "Everyday Use" GP-501Photo Paper Glossy GP-502Photo Paper Plus Semi-Gloss SG-201Photo Paper Pro Platinum PT-101Photo Paper Plus Glossy II PP-201Photo Paper Pro II PR-201Matte Photo Paper MP-101
 Performing Borderless Printing on any other type of paper may substantially reduce printingquality and/or result in printouts with altered color hues.Borderless Printing on plain paper may result in printouts with reduced quality. Use them onlyfor test printing. You can perform Borderless Printing on plain paper only when printing fromyour computer.Depending on the type of paper, Borderless Printing may reduce the print quality at the top andbottom edges of the paper or cause these parts to become smudged.When performing Automatic Duplex Printing, the printable area will be 0.08 inches / 2 mmsmaller at the top margin.
 Letter, LegalEnvelopesOther Sizes than Letter, Legal, Envelopes
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Advanced Guide > Appendix > Printing Area > Other Sizes than Letter, Legal, Envelopes
 Other Sizes than Letter, Legal, Envelopes
 Size Printable Area (width x height)A5 5.56 x 7.95 inches / 141.2 x 202.0 mmA4 8.00 x 11.38 inches / 203.2 x 289.0 mm
 B5 6.90 x 9.80 inches / 175.2 x 249.0 mm
 4" x 6" / 10 x 15 cm 3.73 x 5.69 inches / 94.8 x 144.4 mm
 4" x 8" / 10 x 20 cm 3.73 x 7.69 inches / 94.8 x 195.2 mm
 5" x 7" / 13 x 18 cm 4.73 x 6.69 inches / 120.2 x 169.8 mm
 8" x 10" / 20 x 25 cm 7.73 x 9.69 inches / 196.4 x 246.0 mm
 Wide 3.73 x 6.80 inches / 94.8 x 172.6 mm
 Recommended printing area
 Printable area
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Advanced Guide > Appendix > Printing Area > Letter, Legal
 Letter, Legal
 Size Printable Area (width x height)
 Letter 8.00 x 10.69 inches / 203.2 x 271.4 mm
 Legal 8.00 x 13.69 inches / 203.2 x 347.6 mm
 Recommended printing area
 Printable area
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Advanced Guide > Appendix > Printing Area > Envelopes
 Envelopes
 Size Recommended Printing Area (width x height)
 European DL* 4.06 x 7.50 inches / 103.2 x 190.5 mm
 US Comm. Env. #10* 3.86 x 8.34 inches / 98.0 x 211.8 mm
 Recommended printing area
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Advanced Guide > Appendix > Deleting the Undesired Print Job
 Deleting the Undesired Print Job If the printer does not start printing, the print job data cancelled or failed may be remaining.Delete the undesired print job by using the Canon IJ Status Monitor.
 1. Display the Canon IJ Status Monitor Click the Status Monitor button displayed on the Task Bar.The Canon IJ Status Monitor appears.
 2. Display the print jobs Click Display Print Queue....The Print Queue window opens.
 3. Delete the print jobs Select Cancel All Documents from the Printer menu.When the confirmation message appears, click Yes. The print job is deleted.
 Important Users who have not been granted access permission for printer management cannot delete theprint job of another user.
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Advanced Guide > Appendix > Updating the Printer Driver
 Updating the Printer DriverObtaining the Latest Printer Driver
 Uninstalling the Printer DriverBefore Installing the Printer Driver
 Installing the Printer Driver
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Advanced Guide > Appendix > Updating the Printer Driver > Obtaining the Latest Printer Driver
 Obtaining the Latest Printer Driver By updating the printer driver to the latest version of the printer driver, unresolved problems may besolved. You can check the version of the printer driver by clicking the About... button on the Maintenance tab.
 Access our web site through the Internet and download the latest printer driver for your model.
 Important You can download the printer driver for free, but any Internet access charges incurred are yourresponsibility. Before installing the latest printer driver, delete the previously installed version.For information on how to delete the printer driver, refer to Uninstalling the Printer Driver .
 Related Topics Before Installing the Printer Driver
 Installing the Printer Driver
 Page top
 Стр. 377 из 396 стр.Obtaining the Latest Printer Driver

Page 378
                        

Advanced Guide > Appendix > Updating the Printer Driver > Uninstalling the Printer Driver
 Uninstalling the Printer Driver The printer driver you no longer use can be deleted.When deleting the printer driver, first exit all programs that are running.
 The procedure to delete the unnecessary printer driver is as follows:
 If there is an uninstaller
 1. Start the uninstaller In Windows Vista or Windows XP, select the Start menu -> All Programs -> "Your model name" ->Printer Driver Uninstaller. In Windows 2000, select the Start menu -> Programs -> "Your model name" -> Printer DriverUninstaller.
 The Printer Driver Uninstaller dialog box is displayed.
 Important In Windows Vista, a confirmation/warning dialog box may appear when installing, uninstallingor starting software.This dialog box appears when administrative rights are required to perform a task.If you are logged on to an administrator account, click Continue or Allow to continue.Some applications require an administrator account to continue. If you are logged on to astandard account, switch to an administrator account, and restart the operation from thebeginning.
 2. Execute the uninstaller Click Execute. When the confirmation message appears, click Yes.When all the files have been deleted, click Complete. The deletion of the Printer Driver is completed.
 If there is no uninstaller If there is no uninstaller in the Start menu of Windows Vista, follow these steps:
 1. Select the printer to be deleted Select the Start menu -> Control Panel -> Hardware and Sound -> Printers.Click the model to delete, then press the Alt key on your keyboard. On the File menu, click Delete.
 2. Delete the printer If the User Account Control dialog box appears, click Continue. Then when the confirmationmessage appears, click Yes.The icon is deleted.
 3. Select the printer driver to be deleted Press the Alt key. On the File menu, select Run as administrator, and then click Sever Properties....If the User Account Control dialog box appears, click Continue. Click the Drivers tab. In the Installed printer drivers list, click the printer to delete.
 4. Delete the printer driver When you click Remove..., Remove Driver And Package dialog box is displayed.Select Remove driver and driver package, and then click OK.In the confirmation dialog box, click Yes.
 When data collection is completed in the Remove Driver Package dialog box, click Delete.
 5. Click OK.
 Стр. 378 из 396 стр.Uninstalling the Printer Driver

Page 379
                        

The deletion of the printer driver is complete.
 Important You may not be able to delete the printer driver properly from the Installed printer drivers list.If this happens, restart your computer, and try again.
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Advanced Guide > Appendix > Updating the Printer Driver > Before Installing the Printer Driver
 Before Installing the Printer Driver This section describes the items that you should check before installing the Printer Driver. You shouldalso refer to this section if the Printer Driver cannot be installed.
 Check the printer status
 Properly connect the personal computer and the printer. For details on connection instructions, referto the "Install the Software" in the manual: Getting Started.
 Turn off the printer.
 Check the Personal Computer Settings
 Terminate all running applications.
 In Windows Vista, log on as a user who has the administrator rights.In Windows XP, log on as the computer administrator.In Windows 2000, log on as a member of the Administrators group.
 Note
 If an old version of the Printer Driver is already installed, first delete (uninstall) that version. Forinstructions on deleting the Printer Driver, see Uninstalling the Printer Driver .
 Related Topics Obtaining the Latest Printer Driver
 Installing the Printer Driver
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Advanced Guide > Appendix > Updating the Printer Driver > Installing the Printer Driver
 Installing the Printer Driver You can access our web site through the Internet and download the latest Printer Driver for your model.
 The procedure for installing the downloaded Printer Driver is as follows:
 1. Turn off the printer
 Important If you turn on the computer while the printer is on, the Windows Plug and Play function isexecuted automatically, and the Found New Hardware window (Windows Vista) or Found NewHardware Wizard window (Windows XP, Windows 2000) is displayed. In this case, clickCancel.
 2. Start the installer Double-click the icon of the downloaded file.The installation program starts.
 Important In Windows Vista, a confirmation/warning dialog box may appear when installing, uninstallingor starting software.This dialog box appears when administrative rights are required to perform a task.If you are logged on to an administrator account, click Continue or Allow to continue.Some applications require an administrator account to continue. If you are logged on to astandard account, switch to an administrator account, and restart the operation from thebeginning.
 3. Install the driver At the Welcome window, click Next.Read the contents of the License Agreement window. After checking the contents, click Yes.Installation of the Printer Driver begins. After the Installation Complete window is displayed, check that the printer and the computer areconnected through a cable. To select the connection port for your printer manually, check the Select printer port check box, andclick Manual selection. At the Select printer port window, select the connection destination, and thenclick OK.
 4. Complete the installation Click Complete.Turn on the printer, and wait awhile until the connection is recognized.
 This procedure installs the Printer Driver. Depending on the environment you are using, a message prompting you to restart the computer may bedisplayed. To complete the installation properly, restart the computer.
 Important You can download the printer driver for free, but any Internet access charges incurred are yourresponsibility.
 Related Topics Obtaining the Latest Printer Driver
 Before Installing the Printer Driver
 Page top
 Стр. 381 из 396 стр.Installing the Printer Driver

Page 382
                        

Advanced Guide > Appendix > Uninstalling the On-Screen Manuals
 Uninstalling the On-Screen ManualsFollow the procedure below to uninstall all of the installed on-screen manuals from your computer.
 All of the installed on-screen manuals will be deleted at the same time.
 1. Click Start > All Programs (Programs in Windows 2000) > Canon XXX Manual(where "XXX" is your printer's name) > Uninstall.
 2. Click OK when the confirmation message appears.
 Note
 When the message prompting you to restart your computer is displayed, click OK to restart yourcomputer.
 On-screen manuals other than printer driver's help are uninstalled at a time.
 1. Select Applications on the Go menu.
 2. Double-click the Canon Utilities folder, and then the IJ Manual folder.
 3. Drag the folder of your printer's name into the trash.
 4. Drag the XXX On-screen Manual icon (where "XXX" is your printer's name) on yourdesktop into the trash.
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Advanced Guide > Appendix > Transporting the Printer
 Transporting the PrinterWhen relocating the printer, pack the printer using the original packing materials.If you do not have the original packing materials, pack the printer carefully using protective material andplace it inside a sturdy box.
 Caution
 Do not transport or store the printer slanted, vertically, or upside-down, as the ink may leak anddamage the printer.
 1. Turn the printer off.
 2. Confirm that the Power lamp is off and unplug the printer.
 ImportantDo not unplug the printer while the Power lamp is lit or flashing green, as it may causemalfunction or damage to the printer, making the printer unable to print.
 3. Retract the Paper Support and the Output Tray Extension, then close the PaperOutput Tray.
 4. Disconnect the printer cable from the computer and from the printer, and thendisconnect the power plug from the printer.
 5. Use adhesive tape to secure all the covers on the printer to keep them from openingduring transportation. Then pack the printer in the plastic bag.
 6. Attach the protective material to the printer when packing the printer.
 ImportantPack the printer with the Print Head and ink tanks left installed in the printer.
 NoteClearly label the box as "FRAGILE" or "HANDLE WITH CARE".
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Advanced Guide > Appendix > Opening the Printer Properties Dialog Box (Windows)
 Opening the Printer Properties Dialog Box (Windows)The printer driver setup window can be displayed through the application software in use or the Startmenu of the Windows.
 Open the Printer Properties Dialog Box through the Application SoftwareFollow the procedure below to configure print settings when printing.
 1. Select the command you perform printing on the application software in use.
 In general, select Print on the File menu to open the Print dialog box.
 2. Select your model name and click Preferences (or Properties).
 The printer properties dialog box opens.
 Note
 Opening the printer properties dialog box through Properties displays such tabsregarding the Windows functions as the Ports (or Advanced) tab. Those tabs do notappear when opening through Printing Preferences or application software. About tabsregarding Windows functions, refer to the user's manual for the Windows.
 Open the Printer Properties Dialog Box through the Start MenuFollow the procedure below to perform maintenance operations such as print head cleaning, or toconfigure print settings that are common for all application software.
 1. Select items from the Start menu as shown below.
 In Windows Vista, select the Start menu > Control Panel > Hardware and Sound > Printers.In Windows XP, select the Start menu > Control Panel > Printers and Other Hardware >Printers and Faxes.In Windows 2000, select the Start menu > Settings > Printers.
 2. Right-click your model name icon and then select Printing Preferences from the displayedmenu.
 The printer properties dialog box opens.
 ImportantDepending on application software you use, command names or menu names may varyand there may be more steps. For details, refer to the user's manual of your applicationsoftware.
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Advanced Guide > Appendix > Opening the Page Setup and Print Dialog Box (Macintosh)
 Opening the Page Setup and Print Dialog Box (Macintosh)You can open the Page Setup dialog box and the Print dialog box from the application program you areusing.
 Opening the Page Setup Dialog BoxOpen the Page Setup dialog box to specify page (paper) settings before printing.
 1. Select Page Setup... on the File menu in your application program.
 The Page Setup dialog box opens.
 Opening the Print Dialog BoxOpen the Print dialog box to specify print settings before printing.
 1. Select Print... on the File menu in your application program.
 The Print dialog box opens.
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Advanced Guide > Appendix > Opening the Canon IJ Printer Utility (Macintosh)
 Opening the Canon IJ Printer Utility (Macintosh)To open the Canon IJ Printer Utility, follow the procedure below.
 In Mac OS X v.10.5.x
 1. Select System Preferences on the Apple menu.
 2. Click Print & Fax.
 3. Select your printer's name in the Printers and click Open Print Queue....
 The job list of your printer is displayed.
 4. Click Utility.
 The Printer List opens.
 5. Select your printer's name in the Product list and click Maintenance.
 The Canon IJ Printer Utility starts up.
 In Mac OS X v.10.4.x or Mac OS X v 10.3.9
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1. Select Applications on the Go menu.
 2. Double-click the Utilities folder, and then double-click the Printer Setup Utility icon.
 The Printer List opens.
 3. Select your printer's name in the Name list and click Utility.
 4. Select your printer's name in the Product list and click Maintenance.
 The Canon IJ Printer Utility starts up.
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Advanced Guide > Appendix > Connecting the Printer to the Network
 Connecting the Printer to the Network If multiple computers are being used in the network environment, you can share the printer connected toone computer with other computers.The Windows versions of the computers connected to the network do not necessarily have to be thesame.
 Settings on Print ServerDescribes the procedure for setting up a computer directly connected to a printer with a USB cable.
 Settings on Client PC
 Describes the procedure for setting up those computers that will use this printer through thenetwork.When you execute print, the data is sent through the print server system to the printer.
 Important In case an error occurred when a document is printed by the client system to a shared printer, theerror message of Canon IJ Status Monitor will be displayed both on the client system and the printserver system. For regular printing, Canon IJ Status Monitor will be displayed only on the clientsystem.
 Note
 Install the printer driver from the Setup CD-ROM that accompanies the printer on the print serversystem and each of the client systems according to the OS of each system.
 Related Topic Restrictions on Network Printing
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Advanced Guide > Appendix > Connecting the Printer to the Network > Settings on Print Server
 Settings on Print Server To use a printer in a network, set printer sharing on the print server system.
 The procedure for setting up the print server systems is as follows:
 1. Install the printer driver on the print server system For installation instructions, see the user's manual.
 2. Select items from the Start menu as shown below: In Windows Vista, select the Start menu -> Control Panel -> Hardware and Sound -> Printers. In Windows XP, select the Start menu -> Control Panel -> Printers and Other Hardware ->Printers and Faxes. In Windows 2000, select the Start menu -> Settings -> Printers.
 The Printers window (Windows Vista, Windows 2000) or Printers and Faxes window (Windows XP)is displayed.
 3. Click the icon for the model name of printer to be shared In Windows Vista, press the Alt key on your keyboard and then select Run as administrator ->Sharing... from the displayed File menu. In Windows XP or Windows 2000, select Sharing... from the File menu.
 Note
 Windows XP may display a message recommending the user to use the Network SetupWizard to set up sharing.When this message appears, choose not to use the wizard and then set up sharing.
 4. Set sharing Select Share this printer (Windows Vista, Windows XP) or Shared as (Windows 2000) on theSharing tab to set a shared name as desired, and click OK.
 Important In Windows Vista, a confirmation/warning dialog box may appear when installing, uninstalling,or starting software.This dialog box appears when administrative rights are required to perform a task.If you are logged on to an administrator account, click Continue or Allow to continue. Some applications require an administrator account to continue. If you are logged on to astandard account, switch to an administrator account, and restart the operation from thebeginning.
 This completes the setup on the print server system. Next, set up the client systems.
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Advanced Guide > Appendix > Connecting the Printer to the Network > Settings on Client PC
 Settings on Client PC After setting up the print server system, set up the client system.
 The procedure for setting up the client systems is as follows:
 In Windows Vista
 1. Install the printer driver on the client systems Select Custom Install for the installation method.For details on connection instructions, refer to the "Install the Software" in the manual: GettingStarted.
 Note
 During the installation, a screen prompting you to turn the printer on appears. Click ManualSelection and then select an appropriate port to complete your installation.
 2. Start the wizard Select the Start menu -> Network -> Add a printer.The Add Printer window appears.
 3. Add a printer Select Add a network, wireless or Bluetooth printer, and click the icon for the printer that you haveconfigured on the print server system to be shared, and then click Next.
 Note
 If the icon for the printer is not displayed, check that the printer is actually connected to the printserver. It may take some time for the icon for the printer to appear.
 4. Complete the setup Take the appropriate action as described on the screen and then click Finish.The icon for the shared printer will be created in the Printers window. This completes the setup on the client systems. You can now share the printer in the network.
 In Windows XP/Windows 2000
 1. Install the printer driver on the client systems Select Custom Install for the installation method.For details on connection instructions, refer to the "Install the Software" in the manual: GettingStarted.
 Note
 During the installation, a screen prompting you to turn the printer on appears. Click ManualSelection and then select an appropriate port to complete your installation.
 2. Start the wizard In Windows XP, select the Start menu -> Control Panel -> Printers and Other Hardware ->Printers and Faxes -> Add a printer. In Windows 2000, select the Start menu -> Settings -> Printers -> Add a printer.
 When Welcome to the Add Printer Wizard screen appears, click Next.
 3. Add a printer
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Select A network printer, or a printer attached to another computer (Windows XP) or Network printer(Windows 2000), then click Next.
 On the Specify a Printer window (Windows XP) or Locate Your Printer window (Windows 2000), clickNext and then search for the print server system.
 Click the icon for the printer that you have configured on the print server system to be shared, andthen click Next.
 Note
 If the icon for the printer is not displayed, check that the printer is actually connected to the printserver.
 4. Complete the setup Take the appropriate action as described on the screen and then click Finish.The icon for the shared printer will be created in the Printers and Faxes window (Windows XP) orPrinters window (Windows 2000). This completes the setup on the client systems. You can now share the printer in the network.
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Advanced Guide > Appendix > Connecting the Printer to the Network > Restrictions on Network Printing
 Restrictions on Network Printing These are restrictions that apply if you are using a printer in a network environment. Check therestrictions for the environment you are using.
 If you are sharing a printer in a network
 A print completion message may be displayed. To disable the message display, follow theprocedure below.
 In Windows Vista:
 Press the Alt key from the Printers window on the client system. Open Run as administrator ->Server Properties... from the displayed File menu. Uncheck Show informational notifications for network printers on the Advanced tab, and thenrestart the computer. In Windows XP or Windows 2000: Open Server Properties from the File menu of the Printer and Faxes window (Windows XP) or thePrinters window (Windows 2000) on the print server system. Uncheck Notify when remote documents are printed on the Advanced tab, and then restart thecomputer.
 The bi-directional communication function is disabled so that the correct printer status may not berecognized. If a client user opens the printer driver properties and then clicks OK with the Enable bidirectionalsupport check box on the Ports tab unchecked, the bi-directional function of the printer server systemmay also be disabled.In this case, check Enable bidirectional support check box on both the print server system and theclient system.
 When you print from a client system, you cannot use Canon IJ Preview.
 If the functions on the Maintenance tab cannot be set properly from a client system, they may begrayed out. In this case, change the settings from the print server. When you change the settings of the print server, you should delete the icon of the shared printerfrom the client system, and then specify the shared settings again in the client system.
 If the same printer driver is installed in the print server system and the client system asthe local printer
 The net crawl function may automatically create a network printer icon on the client system.
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Advanced Guide > Using Easy-PhotoPrint EX
 Using Easy-PhotoPrint EX
 --- Transforming Your Photos into Creative Works of Art ---Easy-PhotoPrint EX allows you to create albums, calendars and stickers easily using photos taken withdigital cameras.You can also print borderless photos easily.
 Start Easy-PhotoPrint EX
 Click Here: Easy-PhotoPrint EX
 Note
 See the section below for details on how to use Easy-PhotoPrint EX.Printing with the Bundled Application Software
 Create a Personalized Photo Album
 Creating a personalized photo album is an easy task if you use Easy-PhotoPrint EX!All you need to do is select which photos to use, select a layout, then load paper into your printer andprint. After you bind the printed sheets, you'll have the one and only album of your memories!
 You can change the layout and background, and attachcomments to photos.
 You can also select the size and orientation. You can arrange a photo across the left and rightpages.
 CHECK!
 Select a theme (background design) to create a single-themed album.
 Decorate Items with Text and Frames
 You can add text and frames to photos. Attach a description of the photo in an album, and add a frame toenhance the photo's atmosphere.
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CHECK!
 Select Album to add text and frames. You cannot decorate photos with Photo Print.
 Create a Calendar Using Your Favorite Photos
 Create calendars easily with Easy-PhotoPrint EX. Create your own calendar using your favorite photos!It'll be exciting to turn the calendar pages.
 You can use all kinds of photos. You can also create 2-month, 6-month and 12-monthcalendars.
 Create Stickers
 Create stickers easily with Easy-PhotoPrint EX!
 Create stickers of your favorite photos and share them with your friends!
 CHECK!
 You can add text to photos.
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Advanced Guide > About Solution Menu
 About Solution Menu
 Quick Shortcut!! Solution Menu
 Solution Menu is a menu window that provides quick access from your desktop to Canon applications,manuals, and online product information.
 ImportantThe number and types of buttons displayed in the window may vary depending on your printer andregion.
 Starting Solution Menu
 Click Here: Solution Menu
 To start from desktop, see below.Double-click the Solution Menu icon on the desktop. Alternatively, from the Start menu, select (All)Programs > Canon Utilities > Solution Menu > Solution Menu.From the next time, Solution Menu starts when Windows starts.If the Start Solution Menu when Windows starts checkbox at the bottom left of the window is not selected,Solution Menu does not start when Windows starts.
 ImportantSolution Menu will start automatically when you install it using the Setup CD-ROM thataccompanies the printer.
 Changing the Window Size
 Click (window size: large) or (window size: small) on the title bar to change the window size(large or small).Solution Menu opens with the last used window size next time it is started.
 When screen size is small
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Starting an Application
 1. Point to a button on the window to display the description of each application.
 2. By clicking each button, the introduced application starts.Follow the same steps to view the manuals or online product information.
 ImportantInternet connection is required to access the online information. Internet connection fees apply.
 Exiting Solution Menu
 Click (Close) on the title bar.
 Restriction on Use of Solution MenuThis software is subject to the following restriction. Keep this point in mind when using it.
 All icons of the installed applications that support Solution Menu are displayed in the window. Afterthe installation, you cannot rearrange the icons or delete only the icons.
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